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Introduction
This User Guide provides information on the 
iChemLabs product, ChemDoodle.

About ChemDoodle
ChemDoodle, in short, can create images of 
molecules. But it is much more than that. 
ChemDoodle can efficiently generate 
chemical documents and figures for use in 
publications, produces non-molecular objects 
such as spectra and TLC plates, is integrated 
with databases, can manipulate a large 
number of chemical files and formats, and in 
general, streamlines a lot of the tasks that one 
is confronted with when trying to do or 
explain chemistry in a digital medium. 
ChemDoodle isn't just another program for 
drawing molecules, it's a brand new 
application for interacting with chemical data 
and creating chemical art!

ChemDoodle is designed to be intuitive and 
easy to learn. ChemDoodle is used by a wide 
range of individuals, from high school 
students to accomplished professors and we 
have done our best to provide the most 
intuitive controls for such a diverse group 
while remaining thorough and providing 
superior quality.

ChemDoodle is integrated with the following 
iChemLabs Products:

• ChemDoodle Web Components

• ChemDoodle Mobile

About this Guide
This User Guide contains information for the 
ChemDoodle application for the Windows, 
Mac OS X and Linux operating systems. It 

assumes you are familiar with the basics of 
your operating system. If you are not, please 
refer to your system manual before using 
ChemDoodle.

Some tasks described in this guide require the 
use of third-party applications such as 
Microsoft Office Word or iWork Pages. If you 
are not familiar with these third-party 
applications, please consult the associated 
user guide provided with that product.

The chapters in this guide are organized by 
task. They are intended to help you 
familiarize yourself with the ChemDoodle 
application and to begin using it as quickly 
and efficiently as possible.

Most images are taken from the Mac OS X 
version of ChemDoodle and will be 
representative of all operating systems. If an 
operating system specific issue is discussed, 
any images are taken from the operating 
system under investigation.

Additional Information
Additional sources of ChemDoodle 
information include:

• ChemDoodle Support Pages.                                 
http://www.chemdoodle.com/support

• ChemDoodle Videos.                                 
http://www.chemdoodle.com/videos

• ChemDoodle Web Components.                             
http://web.chemdoodle.com

• ChemDoodle Mobile.                             
http://mobile.chemdoodle.com

• iChemLabs Customer Support.                             
http://www.ichemlabs.com/contact-us

• iChemLabs Website.                             
http://www.ichemlabs.com
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Installation and System 
Requirements
Microsoft Windows Requirements
• Windows XP, Vista or 7+.

• Oracle Java 1.6 or more recent.

• A minimum of 1GB of memory.

Macintosh OS X Requirements
• Mac OS X 10.6 (Snow Leopard) or 10.7 

(Lion) or 10.8 (Mountain Lion).

• Oracle Java 1.6 or more recent (installed by 
default on 10.6; for 10.7+, will be 
automatically installed when ChemDoodle 
is opened and you accept to install Java).

• A minimum of 1GB of memory.

Linux Requirements
• Any version of Linux, although we test with 

and Ubuntu (recommended), Mint, Fedora, 
Debian and OpenSUSE Linux.

• Any GUI, although we recommend and test 
with GNOME.

• Oracle Java 1.6 or more recent (OpenJDK, 
GNU Java, IcedTea or any non-official 
distributions are not supported).

• A minimum of 1GB of memory.

Installing Java
ChemDoodle requires the official Oracle 
(formerly Sun Microsystems) Java 
distribution to run. Java is free and can be 
easily installed from: http://www.java.com

Most contemporary Windows systems will 
have Java installed by default.

Mac OS X 10.6 will have Java installed by 
default. Mac OS X 10.7+ will prompt you to 
install Java when you first run a Java 

application. Accept that prompt to install 
Java.

ChemDoodle does NOT support OpenJDK, 
IcedTea, GNU Java, or any other non-Oracle 
version of Java. With unsupported Java 
distributions, ChemDoodle will run slowly, 
have broken functions and may not even run 
at all.

Installation
Installation, activation and uninstallation 
instructions are can be found on the 
ChemDoodle website.

Table 1: Websites for Installation Instructions

Operating 
System

Webpage

Windows http://
www.chemdoodle.com/
windows-installation-
instructions

Mac OS X http://
www.chemdoodle.com/osx-
installation-instructions

Linux http://
www.chemdoodle.com/
linux-installation-
instructions

Installing for Multiple Users 
on a Single Computer
ChemDoodle will allow several users to use 
ChemDoodle on the same computer. All 
preferences and settings files are saved 
relative to the user’s account, so that each 
user may save their own preferences. Note 
that even though ChemDoodle only needs to 
be installed once on the computer, each user 
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will still have to individually activate 
ChemDoodle for his/her user account, so he/
she will need access to an activation code. 
Instructions for installing ChemDoodle for 
multiple users is operating system dependent 
and is described in the following subsections.

Windows
During the installation, keep the install folder 
in C:\Program Files\. All users will be able to 
execute ChemDoodle from within this folder.

There will be periodic updates to 
ChemDoodle. For Windows Vista and later, 
ChemDoodle requires administrator 
privileges to update, so you will need to 
update ChemDoodle as administrator on the 
computer if none of the users have 
administrator privileges. This only needs to 
be done once for the computer, and all users 
will be using the update.

Mac OS X
During the installation, drag the ChemDoodle 
folder to the /Applications folder as 
instructed. All users will be able to execute 
ChemDoodle from within this folder.

There will be periodic updates to 
ChemDoodle. Only superusers will be able to 
update ChemDoodle, so you will need to 
update ChemDoodle as superuser on the 
computer if none of the users are superusers. 
This only needs to be done once for the 
computer, and all users will be using the 
update.

Linux
Run the Linux BIN in a folder that all users 
have rights to execute binaries from. After the 
installation, verify that all users that will be 
using ChemDoodle have the necessary 
permissions to do so.

There will be periodic updates to 
ChemDoodle. You should restrict write 

privileges to the ChemDoodle installation 
folder if you do not want users to update 
ChemDoodle by themselves. This may be 
necessary, for instance, if you do not want 
one user to update the application while 
another user is finishing some work and does 
not yet want to learn the changes the update 
will bring. If you restrict write permissions, 
you will need to update ChemDoodle as root 
on the computer when all users are ready. 
This only needs to be done once for the 
computer, and all users will be using the 
update.

Folder Contents
There are two folders that the ChemDoodle 
application uses, the main ChemDoodle 
installation folder and the 
ChemDoodleSettings folder located in the 
operating system’s standard Documents 
folder.

The contents of the main ChemDoodle 
installation folder are:

1. ChemDoodle application - 
ChemDoodle.exe on Windows, 
ChemDoodle.app on Mac OS X, and the 
ChemDoodle shell script on Linux

2. config directory - This folder contains 
various configuration files, such as 
proxy.config, for setting ChemDoodle to 
use your proxy. It also contains the site 
license configuration file for site licenses.

3. docs directory - This folder contains 
documentation such as this user guide.

4. external directory - This folder contains 
required packages that ChemDoodle 
needs to start up and run properly. Any 
licenses associated with these packages  
are also provided.
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5. resources directory - This folder contains 
native application icon images and other 
resources such as the auto-updater and the 
ChemDoodle Web Components library.

6. ChemDoodle.jar - The executable java 
jar of ChemDoodle. Do not remove this 
file! This jar is not present in the Mac OS 
X distribution of ChemDoodle.

7. ChemDoodle.vmoptions - This file is 
only present in the Windows distribution 
of ChemDoodle. It contains parameters 
for the Java virtual machine.

WARNING: Do not remove or alter any of 
the contents of the ChemDoodle installation 
folder or unexpected behavior may occur. 
To move the application, you must move 
the entire ChemDoodle folder.

Standard Operating System 
Documents Folder
The standard operating system Documents 
folder varies depending on the operating 
system:

• Windows XP - C:\Documents and Settings\
[username]\My Documents

• Windows Vista/7 - C:\Users\[username]
\My Documents

• Mac OS X - /Users/[username]/Documents

• Linux - /Users/[username]/Documents

Free Trials
Trials may be initiated by clicking the Free 
Trial button on the activation screen when 
ChemDoodle is opened. Trials will remain 
active for 14 days. After a trial expires, there 
is no option to try it again.

Trial Restrictions
• Documents show a watermark at the top 

and will render a background texture.

• The Save..., Save as Image... and 
Convert... functions are disabled.

• Only images and ChemDoodle data can be 
pasted from ChemDoodle.

• All copied and printed content will contain 
a watermark.

• Templates cannot be saved.

• Certain ChemDoodle Web Components 
functions are disabled (such as PDB file 
optimization).

Unrestricted Trials
If your trial has expired and you still require 
the use of ChemDoodle, or if you would like 
to try ChemDoodle without the trial 
restrictions, you may purchase an unrestricted 
14 day trial on the ChemDoodle website.

Student Version Restrictions
The student version of ChemDoodle has 
several restrictions:

• No iChemLabs account is provided.

• Round-trip editing is not available.

• Images output from ChemDoodle will not 
contain chemical metadata.

• Formatted documents and publishing style 
sheets are not available.

• Import/Export of style sheets is disabled.

• Only ChemDoodle Documents can be 
saved.

• No conversion utility.
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• The only chemical data format you can 
copy is the ChemDoodle format.

Activation
Activation is performed when one uses a 
purchased activation code to associate a 
license with the ChemDoodle application for 
a given user account.

Activation can be performed in two ways. 
The first is by using the activation code in the 
activation screen when ChemDoodle has not 
been activated or a trial started. The second 
way is to use the Activate ChemDoodle 
menu item in the Purchase menu while a trial 
is active.

The activation code may be manually typed 
into the activation form, but it is easier to just 
copy and paste the entire code from the 
receipt into the form. Once activated with a 
purchased license, all restrictions from the 
trial are removed.

Activation requires an active internet 
connection. Our server is sent the activation 
code which is validated and gives permission 
to create the license file. This method 
prevents piracy and allows us to minimize the 
cost of ChemDoodle. There are no exceptions 
to this activation procedure.

Connection Issues
Activation is an important part of the setup 
procedure, and there are a few issues, usually 
in corporate environments, that may occur.

Firewall Issues
If your firewall blocks internet connections 
from Java applications, then ChemDoodle 
will not be allowed to connect to the internet. 
An administrator should set up a special 
exception to allow ChemDoodle to connect to 
the internet, at least for activation.

Proxy Issues
If you use a proxy to access the internet, 
ChemDoodle will use the default system 
proxy information to connect to the internet. 
If that fails, then you will need to manually 
define the proxy settings in the proxy.config 
file that is located in the config folder in the 
ChemDoodle installation folder.

Usage Restrictions
There are no restrictions on how to use 
ChemDoodle as long as the user abides by the 
license he/she accepts when activating 
ChemDoodle.

There are no restrictions on your created 
chemical drawings generated from activated 
copies of ChemDoodle. You may use your 
created chemical drawings for whatever 
purpose you choose.

Using ChemDoodle to output the glassware 
graphics for the sole purpose of publishing, 
selling, or distributing them individually or as 
a set is forbidden.

Attributions
Attribution of graphics and output to 
ChemDoodle are welcome, but are not 
necessary in any form.
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Chapter 1: 
Introducing 
ChemDoodle
Overview
This section introduces the new user to the 
ChemDoodle graphical user interface. It 
covers the following topics:

• Identifying the parts of the ChemDoodle 
interface.

• Creating, opening and saving documents.

• Introducing the menus and toolbars.

Figure 1.1: ChemDoodle on Windows (7)

The ChemDoodle Graphical 
User Interface
Although the Windows, Mac OS X and Linux 
versions of the ChemDoodle graphical user 
interface (GUI) differ slightly, the main 
elements of the GUI are consistent across 
platforms. The Windows version of 
ChemDoodle is shown in Figure 1.1. The 
Mac OS X version of ChemDoodle is shown 
in Figure 1.2. The Linux version of 
ChemDoodle is shown in Figure 1.3.
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Figure 1.2: ChemDoodle on Mac OS X (10.6)

Figure 1.3: ChemDoodle on Linux (Ubuntu 10.04)
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Using the Graphical User 
Interface
ChemDoodle’s functions are accessed 
through interaction with several types of 
components:

• Doodle Board - The main drawing window.

• Menus - Core application functions.

• Toolbars - Quickly access functions and 
modify how mouse gestures interact with 
the Doodle Board.

• Widgets - Mini applications within 
ChemDoodle that perform powerful and 
complementary tasks.

Figure 1.4: The Doodle Board

These components are identified in Figures 
1.1-1.3 and are discussed in the following 
sections. Widgets are explained in Chapter 2.

Doodle Board
The Doodle Board is the main drawing 
window and contains all of the documents 
you create and edit. You may use mouse 
gestures to interact with the Doodle Board 
and to draw your figures. Figure 1.4 displays 
the main components of the Doodle Board.
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Ruler Guides
There are two rulers aligned with the 
currently displayed document on the Doodle 
Board. The ruler to the left of the document 
allows for vertical measurements and the 
ruler to the top of the document allows for 
horizontal measurements.

When the document rendering scale is 
changed, the ruler scale will also change to 
match the new dimensions. When the 
scrollbars are used to focus on a different area 
of the document, the rulers will also scroll to 
match the new location.

The ruler displays full ticks at each inch, half-
ticks at each half-inch, and quarter-ticks every 
eighth of an inch. Several colored ticks and 
areas may also be present on the rules for 
visual feedback. These feedback tips can be 
disabled in the Preferences window under the 
General tab.

• Margin Areas - Margins are highlighted in 
a yellow color.

• Mouse Pointer Ticks - Mouse pointer 
locations are ticked on the rules with a red 
color.

• Selection Dimension Area - Marks the 
bounds of the currently selected content. 
This is denoted by an amber area. This area 
corresponds to the internal coordinates of 
the content and not the visual bounds. For 
example, it will denote the bounding box 
given the atom coordinates, but will ignore 
the dimensions of the labels for those 
atoms.

Scrollbars
Scrollbars will appear to the right and bottom 
of the document if the height and width, 
respectively, of the document are too large to 
fit on the Doodle Board. You can click and 
drag the scroll bars to change which area of 

the document is displayed on the Doodle 
Board. You can also use the mouse scroll 
gesture to change the perspective. Horizontal 
mouse scrolling is only supported on Mac OS 
X.

Tab Tray
The Doodle Board stores all drawing content 
and organizes them into documents that can 
be saved as files or images. Each document 
has a corresponding tab, located at the bottom 
of the Doodle Board in the tab tray. When a 
tab is pressed, the corresponding document 
will be selected and viewed. This allows you 
to manage a large number of files at once, 
without having to manage a large number of 
windows.

The number of tabs present in the tab tray will 
change depending on how many documents 
are open. If only a single document is present, 
then only one tab is displayed and will be 
selected. Selected tabs are colored a light 
blue, as is shown in Figure 1.5.

Figure 1.5: A single tab.

When multiple documents are open, multiple 
tabs will be displayed in the tab tray. The tab 
corresponding to the currently selected 
document will be selected and displayed over 
other tabs as is shown in Figure 1.6.

Figure 1.6: Multiple tabs.

If there are more tabs than can fit in the tab 
tray, then only the most recently viewed tabs 
that fit in the tab tray will be displayed. A 
number and two right-oriented chevrons are 
displayed to the right of the last tab to notify 
you that some tabs are not displayed as is 
shown in Figure 1.7.
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Figure 1.7: There is 1 non-displayed tab.

Click on the chevrons and number to open a 
popup menu that lists the undisplayed tabs as 
is shown in Figure 1.8. Click on a choice to 
select that document.

Figure 1.8: List non-displayed tabs.

There are also tab specific functions that can 
be accessed by right-clicking on any given 
tab:

• Close - Close the current tab. This option is 
only enabled if multiple tabs are present.

• Close Others - Close the other tabs, but 
leave the current one open. This option is 
only enabled if multiple tabs are present.

• New Document - Create a new document 
and tab.

• Restore - If the corresponding document 
was created by opening a file, then this 
function will be enabled, allowing you to 
undo all of your changes and reload the file.

The name of the file is displayed on the tab. If 
the name is too long, it may be cropped and 
appended with “...”. You may also see a '*' 
and/or '^' displayed before a file name in a 
tab. The '*' is a reminder that the file has been 
changed since the last save, and the '^' marks 
it as an online file.

Documents
The document represents a virtual sheet of 
paper. Each document embodies one page of 
the structures, objects and figures that you 

create. The document is fully customizable 
and also contains a definition of the styles of 
the content within it. You can create new 
blank documents, or read one from a file that 
ChemDoodle recognizes.

Note: A visual specification is a definition 
about how some object is rendered. For 
example, a bond line width is a visual 
specification for a bond. In this document, 
such a concept may be referred to as a 
visual specification, a style or a document 
setting. They all mean the same thing.

Creating a Document
You can create a new, blank document using 
the default ChemDoodle document settings, 
or use a Chemical Document Settings file to 
create a new formatted document.

To create a new blank document using the 
default style sheet, select the New menu item 
in the File menu.

To create a new blank document using a 
predefined style sheet, select New Formatted 
Document... in the File menu.

ChemDoodle provides built-in Chemical 
Document Settings files. For example, the 
ACS Document 1996 style is configured to 
create documents that are set with the bond 
lengths, bond width, spacing, and fonts used 
in the 2-column format of all American 
Chemical Society journals. Currently, 
ChemDoodle provides the following style 
sheets:

• ACS Document 1996

• Adv. Synth. Catal Document

• J. Chin. Chem. Soc. Document

• J. Het. Chem. Document

• J. Mol. Mod. Document (1 Column)

• J. Mol. Mod. Document (2 Column)
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• Phytomedicine Document

• RSC Document (1 Column)

• RSC Document (2 Column)

• Science of Synthesis Document

• SYNTHESIS, SYNLETT Document

• Verlag Helv. Chim. Acta Document

• Wiley Document

These style sheets are presented when you 
create a new formatted document as is shown 
in Figure 1.9.

Figure 1.9: Creating a New Formatted Document.

The style sheets are organized into 3 sections. 
The first contains just the default style sheet, 
the second contains all the built-in style 
sheets and the last contains custom style 
sheets. Select the style sheet that you prefer, 
and choose to set any custom dimensions, and 
then click the Ok button to create your new 
formatted document.

If you would like to modify the document 
dimensions of the formatted document, then 
select the Use Custom Dimensions checkbox 
and edit the Page Size and Margins fields.

Opening a Document
To open a document, select the Open... menu 
item from the File menu, locate the file you 
would like to open with the file chooser that 
appears and click the Open button.

ChemDoodle can read many file formats, and 
the default file type the file chooser searches 
for is a ChemDoodle Document. To allow 
other file types, click on the format drop 
down selection at the bottom of the file 
chooser and select the file type you would 
like to open, or select the All Files type.

NOTE: Selecting All Files will allow you to 
select any file, including files that 
ChemDoodle cannot read. If such a file is 
chosen, you will see a file read error 
displayed. Otherwise, ChemDoodle will try 
to determine the type of file chosen by 
analyzing the file extension and file content 
to open it accordingly.

To open a recently opened document, enter 
the Open Recent submenu in the File menu 
and select the document you would like to 
open. Only the 10 most recently opened files 
are remembered.

File Chooser Previews
The file choosers that you use to open your 
files will closely resemble the standard file 
choosers that you use in all of your other 
applications. However, we have added some 
enhancements when using ChemDoodle. One 
addition is chemical file type previews.

On all operating systems, you will see a 
preview of chemical files that you select in 
file choosers. On Windows, Mac OS X and 
Linux, the file chooser will show a preview of 
the entire document on the right as shown in 
Figures 1.10, 1.11, and 1.12. On Windows 
and Linux, these previews are interactive, if 
you hover your mouse over the preview, that 
area will zoom in for a closer inspection. On 
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Mac OS X, a tray is added to the bottom of 
the file chooser to list the individual 
molecules present in the file as shown in 
Figure 1.12.

Figure 1.10: The file chooser on Windows 
showing the file preview.

Figure 1.11: The file chooser on Linux showing 
the file preview.

Figure 1.12: The file chooser on Mac OS X 
showing the file preview and preview tray.

You can disable file chooser previews in the 
Preferences window, under the General tab 
in the Filechooser Settings section.

Changing Document Size
To change the size of the current document, 
perform the following steps:

1. Choose the Resize Document... menu 
item in the Edit menu.

2. Use the form to select a preset document 
size or manually type in the desired 
document dimensions.

3. Click the Ok button to resize the 
document.

Discard Recent Changes to a 
Document
To retrieve the last saved version of a file 
without using Undo functions, select the 
Restore menu item in the File menu. All 
changes made to the file since it was last 
saved are discarded and the saved version of 
the file will appear.
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Saving Documents
To save your document as a file, select the 
Save or Save As... menu items from the File 
menu. Save will automatically save the 
document to the file it is associated to, while 
Save As... will allow you to save that file to a 
new location or override other files. If there is 
no file associated with a document, the Save 
function will work identically to the Save 
As... function.

After selecting a save function, a file chooser 
will appear. Select the location you would 
like to have the document saved in and type 
in a name for the file if you do not like the 
default name. You do not need to type in an 
extension as ChemDoodle will do this for 
you.

After you are satisfied with a location and 
name, select the file type of the document to 
be saved. By default, a ChemDoodle 
Document is chosen, but you can choose 
from a large selection of file types that 
ChemDoodle can interpret.

NOTE: Only the ChemDoodle Document 
can store your document with 100% 
accuracy. Other file types are for other 
purposes and may not define the same 
objects and properties in ChemDoodle. 
Keep this in mind while saving files. If you 
forget, a small warning will popup when 
saving to a file type other than a 
ChemDoodle Document. These warnings 
can be disabled in the Preferences window 
under the Saving tab.

After selecting the file type to be used, press 
the Save button to save your document as a 
file.

Autosaving
ChemDoodle will automatically save unsaved 
content for you at regular intervals. If your 
computer shuts off unexpectedly, the next 

time ChemDoodle opens, all autosaved 
content will be displayed.

You can turn off autosaving in the 
Preferences window under the Saving tab. 
You can also specify the autosave interval in 
the same section. The default autosave 
interval is 5 minutes.

Reversing Actions
ChemDoodle keeps track of the actions you 
perform. You can reverse actions one at a 
time by selecting the Undo menu item in the 
Edit menu then restore them with the Redo 
menu item in the Edit menu. Once you close 
your document, the undo queue is reset.

More advanced undo/redo functionality is 
associated with the History widget.

Mouse Cursors
The mouse pointer is context sensitive and 
will change when hovered over the document 
to display visual feedback about the current 
mouse gestures that can be performed. The 
different mouse cursors are described in Table 
3.

Table 3: Mouse Cursors

Cursor Means that...

Clicking and dragging perform 
obvious functions.

This is the lasso cursor. Clicking 
and dragging will generate an 
outline following the drag path. 
All content within the drag path 
will be selected.

This pinpoints the exact location 
that your click will hit. This 
enhances accuracy when using 
the rectangular marquee or when 
placing shapes.
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Cursor Means that...

This signifies that a single object 
may be selected.

This means that content can be 
grabbed. Individual objects or 
selected content can be grabbed.

This means that content has been 
grabbed and dragging gestures 
will perform appropriate actions.

This cursor only appears when 
rotating structures in 3D. It 
means that content can be 
grabbed.

This cursor only appears when 
rotating structures in 3D. It 
means that content has been 
grabbed and drag gestures will 
perform appropriate actions.

This cursor signifies that resize 
actions can be performed by 
clicking and dragging. This 
cursor will also appear when 
translating the rotation anchor.

This cursor signifies that rotation 
actions can be performed by 
clicking and dragging.

Selected Content
Content that is selected will be bordered by a 
dashed amber line. Selected content can be 
used in functions and sent to other 
components. A crawling ants effect is on by 
default to help the user keep track of selected 
content. The crawling ants effect can be 
disabled in the Preferences window under the 
General tab.

For instructions on selecting content and 
editing selected content, read Chapter 5.
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The Workspace
The ChemDoodle workspace consists of the 
application window and all interface elements 
contained within. You may freely place 
toolbars, select widgets, change the document 
scale, select view options, etc., and the next 
time you open ChemDoodle, your choices 
will have been remembered. ChemDoodle 
also provides several functions for managing 
your workspace, so you have control over 
how the application behaves.

Resizing the Workspace
A minimum screen resolution of 1280 by 800 
pixels is recommended to neatly fit all of the 
components in ChemDoodle on the screen. 
Slightly smaller resolutions are still 
acceptable when shrinking the document 
scale. For much smaller resolutions, the 
workspace will display scrollbars to access 
the entire ChemDoodle interface.

On devices that just fit the ChemDoodle 
window, ChemDoodle will expand to fit the 
entire screen. On larger resolution devices, 
ChemDoodle will open to take only as much 
room as necessary. At any time, you may un-
expand the application or resize it to your 
preference. Upon resizing, the widgets will be 
replaced to the right of the workspace, and the 
Doodle Board will be centered.

The workspace will keep track of the size and 
location of ChemDoodle when it was last 
closed.

Resetting to the Default Workspace
To reset to the default workspace that was 
presented when ChemDoodle was first 
opened, select the Default Workspace menu 
item in the Window menu.

Reverting to the Last Saved 
Workspace
To revert to the last saved workspace, select 
the Revert Workspace menu item in the 
Window menu.

Saving the Current Workspace
To save the current workspace, which will 
override the revert workspace, perform the 
following steps:

1. Organize the workspace to your 
preference.

2. In the Window menu, select the Save 
Workspace menu item.

The current workspace is now saved and can 
be reverted to.

Note: ChemDoodle will automatically save 
your current workspace upon close, so 
make sure to revert the workspace to your 
saved workspace before you close, if 
necessary. Otherwise, ChemDoodle will 
open up to look exactly like it was when it 
was closed.
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Menus
Menus are located on the top of the 
ChemDoodle application. On Mac OS X, the 
ChemDoodle menu bar is displayed in the 
screen menu bar, as would be expected of 
Mac OS X applications.

For menu item keyboard shortcuts, consult 
the KeyboardShortcuts.pdf document in the 
docs folder in the ChemDoodle installation 
folder.

There are 9 menus in the menu bar (10 on 
Mac OS X), not including the Purchase 
menu that is present during the free trial:

• ChemDoodle - This is a Mac OS X specific 
menu bar and contains access to several 
Mac OS X specific tasks as well as the 
About, Preferences and Quit menu items.

• File - This menu handles all input and 
output of data, as well as file specific 
functions such as Annotations.... You also 
have access to your iChemLabs account 
through this menu and the Quit menu item 
is located here on non-Mac OS X platforms.

• Edit - Standard global document functions 
are located here including Cut, Copy and 
Paste.

• View - Functions for changing how 
documents are shown are located here as 
well as access to the elemental and 
chemical data provided with ChemDoodle. 
The dynamic periodic table is also 
accessible through this menu.

• Content - Contains all non-chemical 
functions for editing content in the current 
document.

• Structure - Contains all functions related to 
editing and analyzing molecules.

• Reaction - Contains all functions related to 
editing and analyzing reactions.

• Spectrum - Contains all functions related to 
editing and analyzing spectra.

• Window - Manage your workspace and the 
entire ChemDoodle application window.

• Purchase - This menu is only present 
during the free trial and provides functions 
for purchasing and activating licenses for 
ChemDoodle.

• Help - This menu contains several functions 
to access this user guide, list references, 
contact customer service and other common 
help items.

ChemDoodle Menu (Mac OS X Only)
• About ChemDoodle - Display information 

about ChemDoodle, your activation code 
and your license expiration, if any.

• Preferences... - Open the Preferences 
window to edit ChemDoodle preferences.

• Services - Standard Mac OS X submenu 
that will likely be empty.

• Hide ChemDoodle - Hide the ChemDoodle 
application.

• Hide Others - Hide other applications.

• Show All - Show all hidden applications.

• Quit ChemDoodle - Quit the ChemDoodle 
application.

File Menu
• New - Add a new blank document to the 

Doodle Board.

• New Formatted Document... - Add a new 
blank formatted document to the Doodle 
Board.
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• Open - Open a recognized chemical file 
that you locate with a file chooser.

• Open Recent> - The 10 most recently 
opened chemical files are listed here. Click 
a file to open it.

• Insert Image... - Add a recognized image 
file to the current document that you locate 
with a file chooser.

• Close - Close the current document. This 
function is only enabled if two or more 
documents are present.

• Close Others - Close all but the current 
document. This function is only enabled if 
two or more documents are present.

• Restore - Restores a file from its last save. 
This function will only be enabled for files 
that have been previously saved or were 
opened from a preexisting file.

• Annotations... - Associate annotations with 
the current document or view previously set 
annotations.

• Save - Saves the current file with the 
present save settings determined when 
opening the file or by previously saving it. 
This action will act exactly like the Save 
As... function if the document is not yet 
associated with a save location.

• Save As... - Save the current document as a 
file type of your choice in a new file (or 
override one) that you will locate with a file 
chooser.

• Save As Image... - Save the current 
document as an image that you will place 
with a file chooser. Several bitmap and 
vector image types are supported.

• Save Selection As Image... - Save the 
currently selected objects as an image that 
you will place with a file chooser. Several 
bitmap and vector image types are 
supported. This menu item is disabled if no 
objects are selected.

• Convert... - Displays a window to convert 
chemical files to different chemical file 
types that ChemDoodle interprets. Nothing 
is loaded to the Doodle Board, as output is 
written directly to a new file that is created.

• Generate Web Component... - Generate a 
ChemDoodle Web Component. An entire 
window will appear for you to define and 
edit the ChemDoodle Web Component, as 
well as preview and generate the Javascript 
for it. More information on this feature is 
covered in Appendix F.

• Sync with Online Account... - Login to 
your iChemLabs Account to access special 
online features in ChemDoodle.

• Open Online File> - Your online files will 
be listed in this submenu. Click on a file to 
open it on the Doodle Board.

• Save As Online File... - Save your file 
online. This is useful for using 
ChemDoodle efficiently on several 
computers or for interacting with 
iChemLabs cloud services. This feature also 
allows you to transfer structures drawn on 
your desktop to ChemDoodle Mobile on 
your phone.

• Refresh - Revalidate the menus and re-sync 
your information with your online account. 
This should be done when you transfer a 
new file into your account from a source 
other than ChemDoodle desktop.
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• Logout - Logout from your iChemLabs 
account.

• Page Setup... - Display the operating 
system specific window for selecting initial 
print settings.

• Print Preview - View the current document 
in its entirety on the screen, ignoring 
extraneous graphics such as errors and 
visual aids.

• Print... - Print the current document.

• Exit - Exits ChemDoodle. This menu item 
is in the ChemDoodle menu on Mac OS X, 
listed as Quit ChemDoodle.

Edit Menu
• Undo - Undo the last action.

• Redo - Redo the last undone action.

• Cut - Copy the selected objects to the 
system clipboard in addition to removing 
them from the document.

• Copy - Copy the selected objects to the 
system clipboard.

• Copy As> - Contains convenience functions 
for quickly placing specific data on the 
system clipboard as text and as a chemical 
to be transferred to a range of 3rd party 
applications that use that data type. This 
submenu is only enabled if content is 
selected.

• Daylight SMILES - Place a SMILES 
string for the currently selected content 
on the system clipboard as text and as a 
chemical.

• IUPAC InChI - Place an InChI string 
for the currently selected content on the 

system clipboard as text and as a 
chemical.

• ChemDoodle JSON - Place 
ChemDoodle JSON for the currently 
selected content on the system clipboard 
as text.

• MDL MOLFile - Place a complete 
molfile for the currently selected content 
on the system clipboard as text and as a 
chemical.

• Tripos SLN - Place a SLN string for the 
currently selected content on the system 
clipboard as text and as a chemical.

• Paste - Paste the system clipboard data of 
highest priority into the document.

• Paste and Match Style - Paste the system 
clipboard data of highest priority into the 
document and match the style to the current 
style sheet.

• Paste Text as Chemical> - Pastes the 
current text on the clipboard, interpreted as 
chemical data, as any of the options 
provided in the submenu.

• Beilstein ROSDAL - Paste text as 
ROSDAL.

• ChemDoodle JSON - Paste text as 
ChemDoodle JSON.

• Daylight SMILES - Paste text as 
SMILES.

• IUPAC InChI - Paste text as InChI.

• Tripos SLN - Paste text as SLN.

• XYZ-Like Data - Paste text as a 
chemical, interpreted from a text blob 
where XYZ-like data is parseable.
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• Guess Chemical Format - Paste text as 
chemical, where the format is guessed 
from the content.

• Paste Special... - Lists all data that 
ChemDoodle can interpret from the system 
clipboard. You may then choose the data of 
choice to be pasted into the document. This 
function is useful, for instance, when you 
would like to paste SMILES string text 
instead of a structure into the document. A 
structure has higher priority than text.

• Clear - Remove all content from the current 
document.

• Resize Document... - Resize the current 
document. You may also change the page 
margins in the Preferences window under 
the Visuals tab under the Page tab.

• Conform Document... - Conform all 
objects in the current document to a 
selected style sheet. This function will also 
change all fonts and scale all objects if you 
choose to do so.

• Purge Clipboard - This function clears the 
system clipboard.

• Purge History - This function clears the 
undo/redo history, which will reset the 
History widget. This may be convenient if 
the action list gets so long that it becomes 
unmanageable and causes memory issues, 
or if you would like to prevent yourself 
from undoing past a certain action.

• Preferences... - Open the Preferences 
window to edit ChemDoodle preferences. 
This menu item is in the ChemDoodle 
menu on Mac OS X.

View Menu
• Hide Warnings - Hide all the warnings in 

the document.

• Drawing Aids> - Display various guides to 
help when drawing figures.

• Atoms> - Display guides associated to 
atoms.

• Show Circular Guidelines - 
Display circular guides around 
atoms with radii equal to the current 
bond length document setting.

• Show Orthogonal Guidelines - 
Display vertical and horizontal 
guidelines that intersect through the 
atom for aiding in alignment tasks.

• Bonds> - Display guides associated to 
bonds.

• Show Parallel Guidelines - Display 
a line that goes through the bond to 
extrapolate where they point to.

• Rings> - Display guides associated to 
rings.

• Color in Rings - Color in Euler 
facet rings with a color code that 
depends on the size of the ring.

• Molecules> - Display guides associated 
to molecules.

• Show Molecule Bounds - Draw 
rectangular bounding guides around 
molecules to show their visual 
bounds.

• Show Orthogonal Guidelines - 
Display vertical and horizontal 
guidelines that intersect through the 
center of the molecule for aiding in 
alignment tasks.
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• Background> - Display guides 
associated to the page.

• Show Crosshair - Displays a 
crosshair.

• Show Grid Guidelines> - Displays 
grids.

• Every Quarter-Inch - Displays 
a grid with quarter-inch spacing.

• Every Half-Inch - Displays a 
grid with half-inch spacing.

• Every Inch - Displays a grid 
with inch spacing.

• Show Margin Guidelines - 
Displays a rectangular region that 
specifies the printable area of the 
page.

• Unique IDs> - Associates ID attributes to 
objects.

• On Atoms> - Associate IDs to atoms.

• Incremental - Associate 
incremental IDs to atoms. The atoms 
are numbered in chronological order 
from when they were created.

• Morgan Indices - Associate 
Morgan indices to atoms.

• On Bonds - Associate incremental IDs 
to bonds. The bonds are numbered in 
chronological order from when they 
were created.

• Elemental Data - View the entire elemental 
database packaged in ChemDoodle that is 
used for all calculations and 
cheminformatics functions. The data is 
displayed in a dynamic table.

• Ionization Energies - View ionization 
energies of the elements in a dynamic table. 
This data is part of ChemDoodle’s 
elemental database.

• Isotopes - View isotope data for the 
elements in a dynamic table. This data is 
part of ChemDoodle’s elemental database.

• Interactive Periodic Table - View an 
interactive periodic table that can be 
customized and printed. You may also use 
its dynamic features to create nice 
demonstrations.

• Actual Size - Negate any zoom effects.

• Current Selection - Center the current 
selection on the Doodle Board. This 
function is useful if the document 
perspective is zoomed in and it is difficult 
to locate selected content.

• Zoom Out - Zoom out and decrease the 
document scale, you may also use the drop 
down selection provided in the Files + 
Formatting toolbar.

• Zoom In - Zoom in and increase the 
document scale, you may also use the drop 
down selection provided in the Files + 
Formatting toolbar.

Content Menu
• Select> - Contains various tools for 

selecting content.

• All - Select all content in the current 
document.

• Inverse - Select all content in the 
current document that isn’t currently 
selected while deselecting all content in 
the current document that is currently 
selected.
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• Next Molecule - Select the next 
molecule in the document. This function 
will traverse chronologically through 
the molecules in the current document 
based on the time they were drawn. If a 
molecule isn’t currently selected, it will 
first select the last molecule drawn.

• Next Shape - Select the next shape in 
the document. This function will 
traverse chronologically through the 
shapes in the current document based on 
the time they were drawn. If a shape 
isn’t currently selected, it will first 
select the last shape drawn.

• SMARTS... - A textfield will appear. 
Type in the desired SMARTS pattern 
here and then click the Accept button. 
Any content in the current document 
that matches the SMARTS pattern will 
be selected.

• Deselect - Deselect all content that is 
currently selected. This function is only 
enabled if content is currently selected.

• Reselect - Reselect the last content that was 
selected. This function is only enabled if no 
content is currently selected. This function 
may not work as expected when content is 
removed. For instance, if you selected 
content and then deleted it, then pressing 
reselect will have no action because the 
content to be reselected no longer exists.

• Center> - Contains various functions for 
centering content.

• All on Page - Center all content on the 
page.

• Selection on Page - Center only the 
currently selected content on the page.

• Selection Horizontally - Horizontally 
center only the currently selected 
content.

• Selection Vertically - Vertically center 
only the currently selected content.

• Flip> - Contains functions for flipping 
selected content.

• Horizontally - Flip the currently 
selected content horizontally over its 
midpoint.

• Vertically - Flip the currently selected 
content vertically over its midpoint.

• Rotate> - Contains various functions for 
rotating selected content.

• 90° CW - Rotate selected content 
clockwise by 90 degrees.

• 90° CCW - Rotate selected content 
counterclockwise by 90 degrees.

• 180° - Rotate selected content by 180 
degrees.

• Arbitrary... - Rotate selected content by 
an arbitrary angle that you input.

• Scale... - Scale the currently selected 
objects. You will be presented with a 
window to set various options to define how 
the content will be scaled. You can even 
choose to scale all molecules individually, 
to set them all to a common bond length for 
instance.

• Align Bond> - Contains functions for 
aligning a single selected bond, rotating the 
molecule it is contained in. This function is 
enabled when only a single bond is selected.

• Up - Align bond up.

• Right - Align bond right.
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• Down - Align bond down.

• Left - Align bond left.

• Flip Bond Orientation - Flip the 
orientation of the bond. Non-symmetrical 
bonds will face the other direction.

• Align> - Contains functions for aligning 
selected content.

• Left Edges - Align all selected content 
by the left edges of their visual bounds.

• Horizontal Centers - Align all selected 
content by the horizontal centers of their 
visual bounds.

• Right Edges - Align all selected content 
by the right edges of their visual 
bounds.

• Top Edges - Align all selected content 
by the top edges of their visual bounds.

• Vertical Centers - Align all selected 
content by the vertical centers of their 
visual bounds.

• Bottom Edges-Align all selected 
content by the bottom edges of their 
visual bounds.

• Distribute> - Contains functions for 
distributing selected content.

• Horizontally on Page - Distribute 
selected content horizontally on the 
page such that they are evenly 
distributed based on their visual bounds 
and fit within the page margins.

• Vertically on Page - Distribute selected 
content vertically on the page such that 
they are evenly distributed based on 
their visual bounds and fit within the 
page margins.

• Horizontally by Buffer Space... - 
Distribute selected content horizontally 
on the page such that they are evenly 
distributed based on their visual bounds 
by a value that you input.

• Vertically by Buffer Space... - 
Distribute selected content vertically on 
the page such that they are evenly 
distributed based on their visual bounds 
by a value that you input.

• Grid All on Page... - Grid all content on the 
page. A window will appear to ask for row 
and column information.

• Stack All on Page - Stack all content on the 
page. Stacking will place all content within 
the page margins based on their visual 
bounds. Stacking proceeds by placing 
content from left to right, and then top to 
bottom, on the page using a small buffer 
space.

• Group - Group the currently selected 
content into a single shape. Single items in 
grouped content can not be edited and 
transformations will affect the entire group 
as a whole. Groups can also be grouped into 
larger groups.

• Ungroup - Ungroup grouped content. 
Ungrouping is not recursive, so if the group 
being ungrouped contains a group, then that 
inner group will remain grouped.

• Join - If two atoms are selected, then they 
will be joined into a single atom, and their 
bonds will all point to the new joined atom. 
If those atoms were part of two discrete 
molecules, then one molecule is translated 
to the other. If two bonds are selected, then 
they will be joined together, and all bonds 
connected to the joined bonds will connect 
to the new joined bond. Two bonds within 
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the same molecule cannot be joined. One 
molecule will be translated and rotated to 
the other to aesthetically display the new 
joined molecule. This function is disabled 
in all other cases.

• Flatten - This function will change all z-
coordinates of selected atoms to be 0, 
thereby flattening 3D structures.

• Add Frame> - Contains various functions 
for surrounding selected content with 
shapes based on their visual bounds.

• Square Brackets - Surround selected 
content with square brackets based on 
the content’s visual bounds.

• Parenthesis - Surround selected content 
with parenthesis based on the content’s 
visual bounds.

• Curly Brackets - Surround selected 
content with curly brackets based on the 
content’s visual bounds.

• Chevrons - Surround selected content 
with chevrons based on the content’s 
visual bounds.

• Rectangle - Surround selected content 
with a rectangle based on the content’s 
visual bounds.

• Measure> - Contains various functions for 
measuring selected content.

• Diagonal - Place one ruler object 
diagonally over selected content based 
on its visual bounds to measure its 
diagonal. You can change the units of 
the ruler object.

• Width and Height - Place two ruler 
objects, one vertically to the left and one 
horizontally below selected content 
based on its visual bounds to measure 

its width and height. You can change the 
units of the ruler object.

• Conform to Document Settings - Conform 
all currently selected objects to the current 
chemical document settings, including 
scaling and changing fonts.

Structure Menu
• Add/Remove Hydrogens> - Contains 

functions for adding Hydrogens to 
structures. Settings for defining how 
Hydrogens will be added to structures can 
be set in the Preferences window under the 
Visuals tab under the Atoms tab.

• All - Add Hydrogens to all structures in 
the current document.

• From Selection - Add Hydrogens only 
to the currently selected structures.

• Add Attribute... - Add an attribute to the 
selected object. This will only be enabled if 
a single atom or bond is selected.

• Place Formal Charges - Will place formal 
charges on atoms based on their valency.

• Calculate Covalent Bonds - This function 
will deduce covalent bonds in structures 
based on atomic 3D distances and the 
covalent radii present in ChemDoodle’s 
elemental database. This function is 
dependent on the Ångström/Bond Length 
document setting present in the Preferences 
window under the Visuals tab. Only single 
bond orders will be placed. This function is 
very useful for working with files that may 
not contain explicit topology, such as PDB 
or XYZ files.

• Remove Selected Bonds - This function 
will remove all selected bonds, leaving the 
constituent atoms.
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• Saturate - This function will change the 
bond orders of all selected bonds to the 
single bond order.

• Kekulize - This function will convert a 
delocalized substructure (defined with 
resonance bonds) or a single bond skeleton 
to a Kekulé structure with the most 
delocalized area.

• Delocalize - Converts a Kekulé structure to 
the delocalized equivalent.

• Graph Reduction> - Contains several 
functions for reducing the underlying graph 
data structures that represent the selected 
structures. This is ideal for extracting 
information about small molecule building 
blocks for drug discovery purposes.

• Reduce 0° (Lone) - This function will 
remove all 0 degree nodes, so all lone 
atoms will be removed.

• Reduce 1° (Terminals) - This function 
will remove all 1 degree nodes, so all 
terminal atoms will be removed.

• Repeatedly Reduce 1° - This function 
will repeatedly remove all 1 degree 
nodes until none remain, so all isolated 
chains will be removed.

• Reduce 1° + 0° - This function will 
remove all 0 and 1 degree nodes, so all 
lone and terminal atoms will be 
removed.

• Reduce 2° (Chains) - This function will 
remove all 2 degree nodes, so all inner 
chain atoms will be removed.

• Reduce 2° + 1° + 0° - This function will 
remove all 0, 1 and 2 degree nodes, so 
all lone, terminal and chain (including 
non-isolated chains) atoms will be 
removed.

• Expand Labels - Will expand all complex 
atom labels to their all-atom equivalents.

• Rings> - Contains several functions for 
defining ring sets in selected structures. If a 
highly overlapping figure results, just stack 
the content for a cleaner layout.

• Explode Smallest Set of Smallest 
Rings - Explode out the smallest set of 
smallest rings (SSSR) for selected 
structures. The SSSR is the standard for 
defining ring sets in flat 2D structures.

• Explode Euler Facet Rings - Explode 
out the Euler facet rings for selected 
structures. The Euler facet ring set is 
better than the SSSR at defining 
essential rings in 2D depictions of 3D 
structures.

• Explode Hanser (All) Rings - Explode 
every last graph cycle in selected 
structures.

• Stereochemistry> - Contains several 
functions for deducing the stereochemistry 
of selected structures.

• Assign R/S (CIP) - Finds and assigns 
CIP stereochemistry to chiral centers.

• Assign E/Z (CIP) - Finds and assigns 
CIP stereochemistry to stereochemical 
double bonds.

• Assign cis/trans - Finds and assigns cis/
trans stereochemistry to appropriate 
double bonds.

• Chemical Suppliers> - Contains functions 
to search for chemical suppliers for drawn 
structures.
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• Substructure Match - Find chemical 
suppliers for the selected structure by 
substructure search.

• Exact Match - Find chemical suppliers 
for the selected structure by exact 
match.

• Clean> - Contains various functions for 
optimizing and beautifying selected 
structures.

• 2D Optimization - The CCG depiction 
algorithm is performed on your selected 
structures to clean them in 2D.

• Distance Geometry Embedding - 
Distance geometry is used on the bond 
distance matrix of the selected 
structures to embed them in 3D. This is 
great for highly connected structures 
like buckyballs and will produce 
suitable 3D coordinates. It will not work 
very well on less connected structures 
like chains.

• Descriptors> - Contains various functions 
that will display the named descriptor for 
the first of the selected molecules. Details 
about these algorithms are described in 
Chapter 6.

• Last Chosen - This menu item is a 
placeholder that will remember the last 
chosen descriptor for easy repeat access.

• Constitutional> - Contains any 
constitutional descriptors; descriptors 
that are defined by the chemical makeup  
of the molecule.

• Atom Count - Calculates the atom 
count.

• Bond Count - Calculates the bond 
count.

• Degree of Unsaturation - 
Calculates the degree of 
unsaturation.

• Element Counts - Calculates the 
element counts.

• Euler Facet Ring Count - Counts 
the total number of Euler facet rings 
present in a molecule.

• Exhaustive Ring Count - Counts 
every last graph cycle in a molecule.

• Frèrejacque Number - Calculates 
the Frèrejacque number. This is also 
the SSSR number.

• Hydrogen Bond Acceptor Count - 
Calculates the Hydrogen bond 
acceptor count.

• Hydrogen Bond Donor Count - 
Calculates the Hydrogen bond donor 
count.

• Rotatable Bond Count - Counts the 
number of rotatable bonds.

• Total Electron Count - Counts the 
total number of electrons present in 
the molecule.

• Lightest Isotopic Mass - Calculates 
the molecular mass based on the 
lightest isotope for each element, 
regardless of abundance.

• McGowans Characteristic Volume  
- Calculates McGowan’s 
characteristic volume.

• Molecular Mass - Calculates the 
molecular mass based on 
ChemDoodle’s elemental database.
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• Molecular Mass - Calculates the 
molecular mass based on 
ChemDoodle’s elemental database.

• Volume as a Sum of Atomic and 
Bond Contributions - Calculates 
the ABC volume.

• Empirical Formula - Generates the 
empirical formula of the first 
selected structure.

• Molecular Formula - Generates the 
molecular formula of the first 
selected structure.

• Topological> - Contains any 
topological descriptors; descriptors that 
are defined by the bond connectivity of 
the molecule.

• Centric Index - Calculates the 
Centric index.

• Diameter - Calculates the longest 
topological path in a molecule.

• Hosoya Index - Calculates the 
Hosoya index.

• Molecular Topological Index - 
Calculates the Molecular 
Topological index.

• Platt Index - Calculates the Platt 
index.

• Ring Complexity - Calculates the 
Ring Complexity.

• Szeged Index - Calculates the 
Szeged index.

• Wiener Index - Calculates the 
Wiener index.

• Zagreb Indexes - Calculates 
various Zegreb indexes.

• Balaban Index - Calculates the 
Balaban index.

• Bertz Complexity Index - 
Calculates the Bertz Complexity 
index.

• Branching Index - Calculates the 
Branching index.

• Chi Molecular Connectivity 
Indexes> - Calculates various Chi 
Molecular Connectivity Indices.

• Fraction Molecular Framework - 
Calculates the Fraction Molecular 
Framework ratio.

• Harary Index - Calculates the 
Harary index.

• Kappa Shape Indices> - Calculates 
various Kappa Shape Indices.

• Superpendentic Index - Calculates 
the Superpendentic index.

• Adjacency Matrix - Generates the 
bond connectivity matrix.

• Bond Distance Matrix - Generates 
the bond distance matrix.

• Bond Electron Matrix - Generates 
the bond electron matrix.

• Detour Matrix - Generates the 
detour matrix.

• Incidence Matrix - Generates the 
incidence matrix.

• Laplacian Matrix - Generates the 
Laplacian matrix.

• Physicochemical> - Contains any 
physicochemical descriptors; descriptors 
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that are defined by physics or chemistry 
of the molecule.

• Average Molecular Polarizability> 
- Calculates the average molecular 
polarizability given several 
algorithms.

• Critical Pressure - Calculates the 
critical pressure of a molecule.

• Critical Temperature - Calculates 
the critical temperature of a 
molecule.

• Critical Volume - Calculates the 
critical volume of a molecule.

• Enthalpy of Formation (ideal gas 
at 298K) - Calculates the enthalpy 
of formation of a molecule at the 
stated conditions.

• Enthalpy of Fusion - Calculates the 
enthalpy of fusion of a molecule.

• Enthalpy of Vaporization (at Tb) - 
Calculates the enthalpy of 
vaporization of a molecule at the 
stated conditions.

• Gibbs Energy of Formation (ideal 
gas, unit fugacity, at 298K) - 
Calculates the Gibbs energy of 
formations of a molecule at the 
stated conditions.

• Heat Capacity (ideal gas, at 298K) 
- Calculates the heat capacity of a 
molecule at the stated conditions.

• Lipophilicity, logP> - Calculates 
logP given several algorithms.

• Liquid Viscocity (at 298K) - 
Calculates the liquid viscocity of a 
molecule at the stated conditions.

• Molar Refractivity> - Calculates 
the molar refractivity of a molecule 
given several algorithms.

• Normal Boiling Point - Calculates 
the normal boiling point of a 
molecule.

• Normal Freezing Point - Calculates 
the normal freezing point of a 
molecule.

• Topological Polar Surface Area - 
Calculates topological polar surface 
area (TPSA).

• ADME Filters> - Contains descriptors 
that assess bioactivity.

• Bioavailability Score - Calculates 
the Bioavailability score.

• Egan Violations Count - Calculates 
the number of violations to Egan’s 
rules.

• Lipinski’s Rule of 5 Violations 
Count - Calculates the number of 
violations to Lipinski’s rule of 5.

• Veber Violations Count - 
Calculates the number of violations 
to Veber’s rules.

• Generate Line Notation> - Contains 
functions for generating line notations of 
selected structures.

• SMILES - Generates simplified 
molecular input line entry specification 
(SMILES).

• SLN - Generates Sybyl Line Notation 
(SLN).

• InChI - Generates the international 
chemical identifier (InChI).
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• ROSDAL - Generates the 
representation of organic structure 
descriptions arranged linearly 
(ROSDAL).

• Parse IUPAC Name... - A text field will 
appear. Type or paste in a correct IUPAC 
name and the structure will be generated 
and inserted into the current document.

• Abbreviations> - Contains functions for 
maintaining ChemDoodle’s abbreviations 
database.

• Add New... - Pops up a window to add 
a new abbreviation to ChemDoodle’s 
abbreviations database.

• Manage Recognized... - Pops up a 
window to add, edit and delete 
abbreviations from ChemDoodle’s 
abbreviations database.

• Manage My Templates... - Contains 
functions for maintaining ChemDoodle’s 
templates database.

Reaction Menu
• Clean - Clean the selected reaction. The 

reaction must first be defined using the 
Build Implied Reaction or Edit 
Reaction... functions. This function will 
align and distribute the reaction as well as 
beautify the reaction arrow. Settings to 
control how reactions are cleaned can be set 
in the Preferences window, under the 
Visuals tab, under the Reaction tab.

• Build Implied Reaction - When an arrow 
and structures are selected, this function 
will become enabled. All selected structures  
with midpoints to the left of the arrow 
midpoint become reactants while all 
selected structures with midpoints to the 

right of the arrow midpoint become 
products.

• Edit Reaction... - Will open up a window 
showing all the structures in the current 
document. Click and drag structures from 
the document tray to the reactant and 
product trays to explicitly define the 
reaction. This function is enabled when an 
arrow is selected.

• Dissolve Reactions - Will dissociate any 
selected reaction data structures.

Spectrum Menu
• View XY Data - View the XY plot data of 

the first selected spectrum. You can copy 
and paste this data into other programs, like 
Excel.

• Edit Perspective... - Will open up a 
window showing several tools for editing 
the spectrum view and axis. Once closed, 
the spectrum in the document will update.

• Expand Perspective - Will expand the 
spectrum perspective to view the entire 
domain and range of the plot. This function 
is enabled when a spectrum is selected.

• Generate> - Contains various functions for 
generating and simulating spectra.

• 1H NMR - Generate a proton nuclear 
magnetic resonance spectrum of the first  
selected structure.

• 13C NMR - Generate a carbon-13 
nuclear magnetic resonance spectrum of 
the first selected structure.

• Mass Parent Peak - Generate a mass 
parent peak from the mass spectrum of 
the first selected structure. This will 
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show the magnitude of the parent ion 
and the isotopic distribution.

Window Menu
• Minimize - Iconify the main ChemDoodle 

window to the dock or system tray. 
ChemDoodle’s menu bar will remain 
focused on Mac OS X.

• Zoom - Expand the ChemDoodle window 
to fill the entire screen without overlapping 
any docks or system trays.

• Select Tab Right - This function is enabled 
if there are one or more tabs present in the 
tab tray. This function will select the tab to 
the right of the currently selected tab. If the 
currently selected tab it the right-most tab, 
then the first tab is selected.

• Select Tab Left - This function is enabled if 
there are one or more tabs present in the tab 
tray. This function will select the tab to the 
left of the currently selected tab. If the 
currently selected tab it the left-most tab, 
then the last tab is selected.

• Save Document Settings... - Set the 
currently defined document settings as the 
default document settings.

• Default Workspace - Return the 
configuration of windows within the main 
ChemDoodle window to the default layout.

• Revert Workspace - Revert the 
ChemDoodle workspace to the last saved 
workspace.

• Save Workspace - Save the current 
configuration of the windows within the 
main ChemDoodle window. This also saves 
file chooser paths and other workspace 
settings. This function is automatically 
performed when ChemDoodle is closed.

Purchase Menu
This menu is only present during the free 
trial, and is removed when ChemDoodle is 
activated with a purchased activation code.

• Activate ChemDoodle - Displays the 
activation form to input a purchased 
activation code and generate the license for 
the ChemDoodle application.

• Buy an Activation Code - Opens the 
default internet browser to the purchase 
page of the ChemDoodle website.

Help Menu
• About ChemDoodle - Display information 

about ChemDoodle, your activation code 
and your license expiration, if any. This 
menu item is in the ChemDoodle menu on 
Mac OS X.

• ChemDoodle User Guide - View this user 
guide in the program most appropriate for 
opening PDF files.

• ChemDoodle Keyboard Shortcuts - View 
a cheat sheet for all keyboard shortcuts and 
actions available in ChemDoodle in the 
program most appropriate for opening PDF 
files.

• References - View an organized list of 
references for the data and algorithms used 
in ChemDoodle. You can use this list to 
assess ChemDoodle’s quality.

• View User License - View the user license 
that you accepted when you activated 
ChemDoodle.

• Deactivate ChemDoodle - ChemDoodle 
can only be used on the number of 
computers determined in your license. To 
switch from one computer to another, use 
this function first. This function is also 
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useful if you need to reinstall your 
operating system.

• Contact Customer Service - Open the 
iChemLabs customer support form and pre-
populate fields. This is the preferred way to 
contact iChemLabs customer service.

• iChemLabs Newsfeed - View the 
iChemLabs newsfeed RSS.

• Check for Updates - Check for updates to 
ChemDoodle. If any are found, you will see 
the changes listed and you will be requested 
to update ChemDoodle. If allowed, 
ChemDoodle will automatically update 
itself. There is no need to redownload or 
reinstall ChemDoodle for updates.
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Toolbars
Toolbars are located at the top-left of the 
ChemDoodle window. They contain buttons 
for changing how mouse gestures affect 
documents, such as placing bonds or placing 
a rectangle. There are also buttons for quickly 
accessing menu items.

Toolbars can be moved at any time. They will 
automatically lock to the borders of the main 
ChemDoodle window and to their original 
position. To save the current placement of 
toolbars so they will remain in that position 
when you next open ChemDoodle, select the 
Save Workspace menu item in the Window 
menu. The placement of toolbars will also be 
saved when the ChemDoodle application is 
closed.

There are 8 toolbars:

• Files + Formatting - Contains buttons for 
saving files, transferring content and 
formatting fonts and scale.

• Content - Contains functions for 
manipulating content including the selection 
tools.

• Strokes - Contains 3 drop down selections 
for defining bond stroke brush styles.

• Labels - Contains preset labels that can be 
used on atoms as well as the Atom Label 
tool which will allow you to type whatever 
content you would like in atom labels.

• Rings - Contains buttons for drawing 
common ring types.

• Bonds - Contains buttons for accessing all 
bond types in ChemDoodle.

• Arrows - Contains 3 drop down selections 
for defining arrows and buttons for drawing 

the defined arrow with several preset arc 
angles.

• Orbitals - Contains various orbital graphics 
for standalone figures or for attaching to 
structures.

• Shapes - Contains any remaining buttons, 
including shapes, carbon chains, brackets, 
pens, glassware clipart, text, etc.

Additionally, there are also text formatting 
toolbars that will appear when convenient, 
such as when editing text areas.

Group Buttons
In some cases, similar buttons are grouped 
into a single unified group button. These 
group buttons are decorated with a small 
highlighted triangle at the bottom-right of the 
button. Clicking on the button will select it 
and perform the displayed function as one 
would expect.

To change to a different function of the group 
button, click down and hold the button for 
one second or click down and drag slightly to 
expand the group button as is shown in Figure 
1.13. Once expanded, just drag the mouse 
pointer over the function you would like to 
use and release the mouse. The function the 
mouse was over when it was released will 
become selected and will now display as the 
main function of the group button.

Figure 1.13: An expanded group button.
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Files + Formatting Toolbar
Figure 1.14: Files+Formatting Toolbar

➡Create a new blank document

➡Create a new blank formatted 
document

➡Open a file

➡Save a file

➡Print document

➡Print preview

➡Cut

➡Copy

➡Paste

➡Font family (font functions affect 
selected content only)

➡Font size

➡Bold font

➡Italicize font

➡Quick Colors button

➡Color button and                       
color selection button

➡Document scale

➡Zoom In

➡Zoom Out

Content Toolbar
Figure 1.15: Content Toolbar

➡Lasso selection tool

➡Rectangular Marquee selection 
tool

➡Lasso only Shapes selection tool

➡Rotate in 3D tool

➡Eraser tool

➡Clear tool

➡Add/Remove Hydrogens

➡Clean Structure

➡Clean Reaction

➡Conform to Document Settings

➡Fragmentation Tools

➡Undo

➡Redo
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Strokes Toolbar
Figure 1.16: Strokes Toolbar

➡Stroke Style

➡Stroke Width

➡Texture Magnitude

Labels Toolbar
Figure 1.17: Labels Toolbar

The labels toolbar contains the element 
labels: H, C, N, O, F, P, S, Cl, Br and I. It also 

contains the superatom labels: Ac, Bz, Ph, 
Me, Et, R and M. Clicking on any of these 
labels will change the cursor to that label and 
then clicking on an atom will change that 
atom’s label to the selected label.

The middle of the toolbar contains the Set 

Atom Label tool . The atom label tool, 
when selected, will allow you to click on any 
atom and open a text field. Type in anything 
you want into the text field and then click on 
the page or press the return key to close the 
text field, setting the selected atom’s label to 
the contents of the text field.

Rings Toolbar
Figure 1.18: Rings Toolbar

Clicking on any ring will change the drawing 
mode to place rings.

Rings include, from top-left to bottom-right:

• cyclopropane ring

• cyclobutane ring

• cyclopentane ring

• cyclohexane ring

• cycloheptane ring
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• cyclooctane ring

• cyclobutadiene ring

• cyclopentadiene ring

• benzene ring

• cycloheptatriene ring

• cyclohexane chair conformer 1

• cyclohexane chair conformer 2

Bonds Toolbar
Figure 1.19: Bonds Toolbar

Just click any bond type and the drawing 
mode will change to place bond orders of that 
type. Clicking on a bond will change that 
bond’s current bond type to the selected bond 
type.

The single bond order will add to other bond 
orders by default. So clicking on a single 
bond will change it to a double bond, clicking  
on a double bond will change it to a triple 
bond, etc. Clicking on a sextuple bond will 
change it to a single bond. Clicking on 
decorated bond orders (protruding, 
ambiguous double, etc.) will convert it to a 
non-decorated (single, double, etc.) bond 
before incrementing it. To stop single bond 

orders from adding to bonds, you can set the 
single bond behavior to instead override other 
bond orders in the Preferences window under 
the General tab.

Bond types include, from top-left to bottom-
right:

• Zero Order/Hydrogen/Ionic bond

• Half bond

• Zigzag bond

• Wavy bond

• Single bond

• Bold Dashed bond

• Bold Single bond

• Bold Hollow bond

• Resonance bond

• Recessed bond

• Protruding bond

• Double bond

• Double Dashed bond

• Bold and Thin Double bond

• Ambiguous Double bond

• Triple bond

• Quadruple bond

• Quintuple bond

• Sextuple bond

• Two Electron bond

• Covalent bond (coordinate covalent by 
default, can be changed to a polar covalent 
bond)

• Any Order bond
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• Unknown Order bond

Arrows Toolbar
Figure 1.20: Arrows Toolbar

The top row of contains three drop down 
selections. The first defines the style of the 
start arrow, the second defines the style of the 
connector between arrows and the third 
defines the style of the end arrow. The first 
five buttons beneath the drop down selections 
allow you to place the arrow in the document 
and will preset a given angle. The preset 
angles include (from left to right): 270°, 180°, 
120°, 90° and 0°. At any time, you can 
change the arc angle of a placed arc to any 
arbitrary angle of your choice.

The last button is the special arrow presets 
button. This group button contains presets for 
common non-standard arrow types, such as 
retrosynthetic arrows. The arc angles of these 

arrows cannot be changed. 

Orbitals Toolbar
Figure 1.21: Orbitals Toolbar

The orbitals toolbar contains two rows of 
orbital types that can be placed into figures 
and attached to structures. From top-left to 
bottom-right are Atomic s, Atomic px|y|z, 
Atomic dxz|yz|xy|x2-y2, Atomic dz2, Atomic fxz2|

xy2|x(x2-3y2)|y(3x2-y2), Atomic fz3, Hybrid sp3, 
Hybrid sp lobe, Bonding σ and Bonding π.

Each button is a group button containing 
different shading an fill options for that 
orbital shape.

Shapes Toolbar
Figure 1.22: Shapes Toolbar

The shapes toolbar contains many group 
buttons and other functions for changing the 
current drawing mode to place both chemical 
and non-chemical objects.

The tools include, from top-left to bottom-
right:

• Lines - Straight, dotted, wavy and zigzag.

• Arcs - 90°, 120°, 180° and 270°.

• Ovals - Plain, dotted, shadowed and 

shaded.

• Rectangles - Plain, dotted, shadowed, 
shaded, plain rounded, dotted rounded, 
shadowed rounded and shaded rounded.
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• Brackets - Square (pair), parenthesis (pair), 
curly (pair), chevrons (pair), dynamic 
brackets, square, parenthesis, curly, 
chevron.                   

• Chemical Attributes - increment charge, 
add radical, positive dipole, single electron, 
radical cation, decrement charge, remove 
radical, negative dipole, electron pair, 
radical anion and electron pair (bar).

• Carbon Chains - 120° Carbon chains, 
Fisher Projection chains and Random 
Carbon chains.                               

• Sequence Tool -  Draw an amino acid 
sequence.

• Polylines - Pen, pen-poly tool and polyline.                      

• Rulers -  Place a measurement ruler.

• Text Areas -  Place a text area with a 
background and border that can be resized 

to any dimension and is associated with text 
formatting tools.

• Glassware Templates -  Opens the 
laboratory glassware templates window to 
build diagrams with glassware clipart.
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Interface Options
In addition to being a very powerful 
application for your chemical data, 
ChemDoodle is also very customizable so 
you can fit its behavior to your preference. 
ChemDoodle provides many options for 
changing the way it looks, how it works, and 
the visual effects that you will see.

To access the interface options, select the 
Preferences... menu item in the Edit menu 
(in the ChemDoodle menu on Mac OS X). 
The first tab, General, will contain the 
interface options.

Drawing Controls

Drawing Mode
There are two drawing modes, Quick and 
Control. Quick mode will do a complete 
multistep-action in a mousedown-drag-
mouseup procedure, while Control mode will 
complete a multistep-action in a click-move-
click procedure. The default is Quick mode.

Optimize Zone Size
The Optimize Zone is a special component in 
ChemDoodle to help you place bonds in the 
optimal position around atoms. It is the blue 
circle that appears when placing bonds and 
other molecule fragments. To use the 
Optimize Zone, just place the mouse pointer 
in the blue circle. The bond or fragment being 
placed will automatically be oriented in the 
most optimal position. You can change the 
size of the optimize zone to be Small, 
Medium or Large. It is Medium by default.

Hover Distance
The hover distance controls how close the 
mouse pointer must be to an object for it to be 
considered hovered. The default is 10 pixels, 
but you can make this shorter or longer 
depending on your preference.

Snap to Grid
By default, coordinates for all objects can be 
placed anywhere. However, you can set a 5 
pixel or 10 pixel grid for objects to snap to.

Single Bond Behavior
By default, Single bonds will increment bond 
orders. So using the Single bond tool, if you 
click on a Single bond it will become a 
Double bond and so forth. However, you can 
change this behavior to instead override bond 
orders so any bonds clicked on with the 
Single bond tool become Single bonds.

Label Behavior
Label tools can either edit the atom clicked on 
or add a new bond connected to the atom 
clicked on with the new atom having that 
label. By default, atom label tools will modify  
the selected atom.

Auto-connect Rings and Templates
This option is enabled by default and will 
have the atoms placed by ring and template 
tools automatically merge with any 
overlapping atoms present in the document.

Fix Bond Lengths
This options is enabled by default and fixes 
the bond lengths of the drawing tools. You 
can quickly reverse this setting when drawing 
by holding down the shift key.

Fix Bond Angles
This options is enabled by default and fixes 
the bond angles of the drawing tools. You can 
quickly reverse this setting when drawing by 
holding down the alt key.

Require Starting Atom
Many chemical sketchers have the bond as 
the smallest building block. ChemDoodle 
uses atoms as the smallest building blocks, 
and all drawing functions require a starting 
atom. You can disable this requirement and 
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allow new bonds to be placed with a single 
mouse click.

Rotate Atom Text with Structures
By default, text will not rotate when you 
rotate structures. This way text is always 
horizontally readable. You can enable this 
setting to have atom text rotate when you 
rotate structures.

Bonds are Focusable
If you are working with only atoms or you 
don’t want to touch bonds, enabling this 
setting will make editing easier. When 
enabled, bonds cannot be hovered or selected.

3D Rotation Mode
When using the structure perspective tool, 
mouse movements will correspond to X and 
Y axis movements during 3D rotation. You 
can change this to correspond to a quaternion 
rotation if you are more familiar with that 
behavior.

Appearance

Recently Opened Files
Recently opened files can be displayed at the 
bottom of the File menu, or in a submenu in 
the File menu. By default they are displayed 
in a submenu, but you may wish to switch 
this option for quicker access if you have a 
tall screen.

Interface Font
If you prefer a different font from the 
standard sans-serif font that ChemDoodle 
uses, you can change it in the Preferences 
window under the General tab in the 
Appearance section. This is also helpful if 
you need to switch to a different font that 
supports characters for another language.

Interface Color
If you prefer a color other than the default 
light green color, you can choose to change 
this in the Preferences window under the 

General tab in the Appearance section. 
Light, pale color choices are easiest on the 
eyes and are least distracting.

Decorations

Show Unfixed Drawing Measurements
When enabled, statistics are rendered to show 
you lengths and angles if they are not fixed.

Show Transform Measurements
When enabled, statistics are rendered to show 
you how your lasso functions are altering 
your figures.

View Crawling Ants Effect When 
Lassoing
When enabled, the lasso outline will exhibit a 
crawling ants effect so you can easily see it.

View Shimmer Effect on Button Hover
When enabled, buttons will display a 
shimmer effect when you hover the mouse 
cursor over them. This makes it easy to detect 
which button you are pressing.

View Mouse Position on Rules
When enabled, the mouse position will be 
ticked on the document’s rulers in red.

View Selection Bounds on Rulers
When enabled, the lasso selection will be 
highlighted on the document’s rulers in 
amber.

Filechooser Settings

Unified Filechooser Memory
By selecting this option, all filechoosers, 
regardless of function will remember the last 
location of any of the file choosers. 
Otherwise, they will each retain their own 
memory.

Include Previews in Filechooser
You may wish to disable this to hide file 
chooser previews.
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Chapter 2: Widgets
Overview
Widgets could be individual applications on 
their own, but with ChemDoodle, they 
provide added functionality and benefit from 
ChemDoodle's useful capabilities.

This section introduces the new user to 
widgets within ChemDoodle. It covers the 
following topics:

• Identifying the widgets.

• Using the widgets.

• Thorough guides for the widgets. 

Widget Windows
Each widget has its own unique interface 
contained within a widget window. A widget 
window is a simple, movable and resizable 
window that contains the widget interface and 
other buttons for maximizing and minimizing 
the widget as is shown in Figure 2.1 and 
Figure 2.2. Widget window decorations will 
be slightly different between Windows/Linux 
and Mac OS X.

The top bar contains two buttons, one for 
minimizing the widget to the ChemDoodle 
desktop tray and one for maximizing the 
widget to fit the entire ChemDoodle 
application window. You can also use the drag 
anchors to resize widgets.

To move widgets, just click and drag the top 
bar. Widgets will automatically lock to the 
borders of the ChemDoodle application and 
to their origins.

The entire widget interface is presented in the 
rest of the widget window below the title, 
which is displayed below the top bar.

Figure 2.1: Widget Window on Windows/Linux

Figure 2.2: Widget Window on Mac OS X 

Widget Expansion
Some widgets are initially in a collapsed 
state. Each collapsed widget will have some 
gesture to expand it. For example, the 
MolGrabber widget is initially collapsed. 
Just type a search term in the text field and 
press the return key to expand it as showing 
in Figures 2.3-2.4. Every collapsable widget 
will also have a collapse button to collapse it.

Figure 2.3: A collapsed widget
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Figure 2.4: An expanded widget

Widget List
There are currently 12 widgets provided in 
ChemDoodle:

• Elemental Analysis - Calculates molecular 
masses, elemental analysis and isotopic 
distributions for structures.

• History - Provides full access to the undo/
redo queue.

• Line Notation Pad - Generates and parses 
line notations and will also correct your 
input.

• MolGrabber - Search databases for 
chemical structures.

• Multiplet Tool - Simulate multiplets.

• NMR SignalSeek - Simulate nuclear 
magnetic resonance and associate peaks to 
nuclei as well as provide more thorough 
information about the spectrum and 
simulation.

• Properties - Calculates molecular 
descriptors.

• Search - Search your computer and 
attached storage devices for chemical 
structures.

• Statistics - Displays document and drawing 
statistics.

• Symbols - Quick access to chemically 
relevant symbols and the full unicode range.

• Templates - Organizes chemical structure 
templates for your use.

• TLC Canvas - Draw thin layer 
chromatography plates.

Widget Dock
The Statistics and History widgets are shown 
at all times. Only one other widget is shown 
in addition to these two at any given time. 
You can switch the widget that is shown by 
clicking on the widget icon of the widget you 
would like to be shown in the widget dock. 
The widget dock is located at the bottom-right 
of the ChemDoodle window and appears as 
shown in Figure 2.5.

Figure 2.5: The widget dock

If you hover over any of the icons, that icon 
will be enlarged, and the title of the widget 
will appear to the left of the widget dock as 
shown in Figure 2.6.
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Figure 2.6: Hovering an icon in the widget dock

Just click on the hovered widget icon to select  
and show the corresponding widget.

You can also move the widget dock along the 
bottom of the application desktop, by pressing 
the mouse down and dragging on the (< >) 
symbol displayed at the bottom right of the 
dock.

Widget Icons
In addition to selecting widgets, these icons 
may also perform additional functions. For 
instance, if you drag a structure onto the Line 
Notation Pad widget icon, that structure will 
be loaded into the widget. Information on 
these additional functions are provided in the 
next sections.

Table 4: Widget Buttons

Button Widget

Elemental Analysis

Line Notation Pad

MolGrabber

Multiplet Tool

Button Widget

NMR SignalSeek

Properties

Search

Symbols

Templates

TLC Canvas
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Elemental Analysis Widget
Purpose
The Elemental Analysis widget calculates 
several data that are useful to chemists. It 
calculates formulas and masses, performs 
elemental analysis, and simulates isotopic 
distributions.

Interface
The interface consists of 4 sections. From top 
to bottom, the first section displays the 
molecular formula, molecular mass and 
monoisotopic mass. The second section 
shows the elemental analysis, with each 
element shown with its percent composition. 
The third section lists the isotopic 
distribution, with mass values and intensities. 
The fourth section shows an interactive 
spectrum of the isotopic distribution.

Figure 2.7: Elemental Analysis Widget

History Widget
Purpose
The History widget is an advanced undo/redo 
tool and provides access to the complete log 
of all actions performed since the document 
was created or opened. Click on a given 
action to jump back and forth to the document 
state when that action was performed.

Interface
The interface consists of a single list in a 
scrolling pane as shown in Figure 2.8. The 
current state of the document is signified with 
a green highlight over the left side of the 
latest action. Any actions performed earlier 
are undecorated and listed above the current 
state, while any actions that have been 
undone are highlighted in an amber color and 
are listed below the current state. By clicking 
on any actions above the current state, the 
document will revert back to that action, 
undoing all actions between the current state 
and the action clicked. By clicking on any 
actions below the current state, the document 
will redo all actions between the current state 
and the action clicked. Therefore, the History 
widget allows you to easily revert and restore 
any actions performed during the edit history 
of the document.

Figure 2.8: History Widget
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Line Notation Pad Widget
Purpose
The Line Notation Pad widget can interpret 
and generate SMILES, SLN, InChI and 
ROSDAL chemical line notation formats as 
well as convert between them with ease. The 
interface for the Line Notation Pad widget is 
shown in Figure 2.9.

Figure 2.9: Line Notation Pad Widget

Interface
The interface, from top to bottom, consists of 
a Format drop down selection for choosing 
the format, a String text field for inputting 
and outputting the line notation, a vertical 
row of buttons for performing various 
functions, the main structure panel and the 
input analysis list. Initially, the interface is 
collapsed. Drag a structure onto the Line 
Notation Pad widget button or type in a line 
notation in the String text field and press the 
return key to expand it.

Using the Format drop down selection, you 
can choose any of the line notations available 

to set the current line notation format. If 
content is present in the text field, then that 
content will be converted into the new format.

The String text field will display the 
generated line notation when a structure is 
dropped on the main structure panel or the 
Line Notation Pad widget button. You may 
also explicitly type your line notation in this 
component and then press the return key or 
the View in 2D button to interpret it and 
display the corresponding structure in the 
main structure panel.

The buttons perform functions as described in 
Table 5.

Table 5: Line Notation Pad Widget Buttons

Button Function

The View in 2D button will 
interpret the current string in the 
String text field using the format 
in the Format drop down 
selection and display the 
structure in the main structure 
panel as well as provide feedback 
in the input analysis list.

The Add to the Doodle Board 
button will place the current 
structure in the main structure 
panel onto the current document. 
Alternatively, you can click on 
the main structure panel and drag 
onto the document to place it.
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Button Function

The Choose Start Point button 
will allow you to click on an 
atom in the main structure panel 
to denote it as the start point for 
the generation of the line 
notation. Note that if the line 
notation format is canonical or if 
such an option is set, then setting 
the starting point will have no 
effect.

The Copy to System Clipboard 
as Text will copy the current text 
in the String text field onto the 
system clipboard as plain text. 
For MIME type specific 
clipboard contents, set the 
appropriate options in the 
Advanced tab of the Preferences 
window, then copy from the 
Doodle Board.

The Clear button will clear the 
current contents and collapse the 
widget.

Beside the buttons in the main structure panel 
which will display the structure associated 
with the line notation in the String text field. 
You can generate a line notation for a 
structure on the Doodle Board by selecting 
the structure and then by clicking and 
dragging that structure onto the main 
structure panel of this widget. Structures from 
the main drawing panel can also be dragged 
onto the Doodle Board.

The last component of the interface is a 
scrollable list. Any errors or warnings 
perceived when interpreting the line notation 
will be listed here. Use these suggestions to 
help correct malformed strings. 

MolGrabber Widget
Purpose
MolGrabber is a web application for 
obtaining pre-drawn molecular structures and 
properties from online databases. The 
interface is shown in Figure 2.10. Currently, 
MolGrabber interfaces with the following 
databases:

• ChemExper - http://www.chemexper.com/

• ChemSpider - http://www.chemspider.com/

• PubChem - http://
pubchem.ncbi.nlm.nih.gov/

NOTE: Because MolGrabber connects to 
online databases, it requires an active 
internet connection for use.

Figure 2.10: MolGrabber Widget

Interface
The interface, from top to bottom, consists of 
a Search text field for inputting a search 
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term, a Source drop down selection for 
choosing the database to search through 
followed by a second drop down selection to 
restrict the search, a progress spinner to the 
right of those three components to notify you 
that a search is currently being performed, a 
main structure panel with a button column to 
the left of it for performing various functions, 
a scrollable list to hold all search results and, 
at the bottom, statistics about the search result 
with traversal buttons for navigating through 
large numbers of results. 

Initially, the interface is collapsed. Type a 
search term in the Search text field and press 
the return key to expand it. This can be any 
search term that the associated database can 
handle. After pressing the return key, the 
progress spinner will activate to notify you 
that it is performing the search. After the 
search completes, the progress spinner will 
deactivate, the results will populate the result 
list and the first result will appear in the main 
structure panel.

The Source drop down selection can be used 
to select which database to search. The 
second drop down selection will restrict your 
search to a specific data field type supported 
by the database. Just choose a specific field 
and the search will only match results in that 
field for the input search term.

The buttons perform functions as described in 
Table 6.

Table 6: MolGrabber Widget Buttons

Button Function

The Search button will begin the 
search query using the search 
term input into the Search text 
field and restrict it to matching 
the field selected in the Source 
drop down selections.

The Add to the Doodle Board 
button will place the current 
structure in the main structure 
panel onto the current document. 
Alternatively, you can click on 
the main structure panel and drag 
onto the document to place it.

The Show/Hide Hydrogens 
button will add and remove 
Hydrogens from the structure in 
the main structure panel based on 
the coordinates for Hydrogens 
provided by the database. Some 
databases may not provide 
Hydrogen coordinates and 
therefore this function will have 
no effect.

The Show Associated Data 
button will display all associated 
database data for the structure 
displayed in the main structure 
panel.

The Clear button will clear the 
current contents and collapse the 
widget.

To the right of the buttons is the main 
structure panel that will display the structure 
for the selected result. After obtaining the 
structures you would like to include in your 
figures, all you have to do is drag and drop 
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the structure from the main structure panel 
onto the Doodle Board.

Below the buttons is the search result list. 
This list will display a maximum of 20 results 
and follows the following format for each 
entry:

Name (Molecular Formula) [Molecular Mass amu]

Click on any of the results to display them in 
the main structure panel.

Below the search results is a label to inform 
you of which search results are presented in 
the current result set along with traversal 
buttons to navigate through large numbers of 
results. Just press the left and right arrows to 
view the previous 20 and next 20 results 
respectively. If there are no previous or no 
next results, then the corresponding arrow 
will be disabled.

NOTE: ChemSpider does not currently 
support pagination of results, so be careful 
with generic queries as they may return 
many, many results and may take a long 
time to complete.

Directing to the Online Database
After a molecule has been loaded, clicking on 
the Show Associated Data button will list 
associated data from that database. The top 
item will be the specific database id as a 
hyperlink. The link will open up your default 
browser to the selected database’s page for 
the current result.

Database Notes
ChemDoodle only provides an interface to the 
databases supported in the MolGrabber 
widget. You should inform yourself about the 
copyrights, disclaimers and warranty 
information provided by these databases 
before using them.

ChemExper Disclaimer

http://www.chemexper.com/?main=ccd/
disclaimer.html

***** USE AT YOUR OWN RISK *****

ChemExper sprl compiles chemical 
information from many sources.

THIS DATA IS PROVIDED "AS IS" AND 
IN NO EVENT SHALL CHEMEXPER BE 
LIABLE FOR ANY DAMAGES, 
INCLUDING, WITH OUT LIMITATION, 
DAMAGES RESULTING FROM LOST 
DATA OR LOST PROFITS OR REVENUE, 
THE COSTS OF RECOVERING SUCH 
DATA, CLAIMS BY THIRD PARTIES OR 
FOR OTHER SIMILAR COSTS, OR ANY 
SPECIAL, INCIDENTAL, OR 
CONSEQUENTIAL DAMAGES, ARISING 
OUT OF THE USE OF THE DATA.

The accuracy or reliability of the data is not 
guaranteed or warranted in any way and the 
Providers disclaim liability of any kind 
whatsoever, including, without limitation, 
liability for quality, performance, 
merchantability and fitness for a particular 
purpose arising out of the use, or inability to 
use the data. 

ChemSpider Disclaimer

http://www.chemspider.com/Disclaimer.aspx

General

The ChemSpider website is maintained by 
The Royal Society of Chemistry on behalf of 
its wholly owned subsidiary RSC Worldwide 
Ltd. RSC Worldwide Ltd does not warrant or 
assume any legal liability or responsibility for 
the accuracy, completeness, or usefulness of 
any documents, data, software, apparatus, 
product, process, or other information on the 
ChemSpider website. You should not rely on 
any information on the website for any 
assessment of the risks of any specific 
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experiment, procedure or process that you 
wish to carry out; you should always carry 
out your own risk assessment for such 
purposes. The information on this website 
may not be correct or appropriate for local 
regulations, legal codes, practices or policies. 
The information may be out of date. RSC 
Worldwide Ltd takes no responsibility for any 
injury, loss, or damage caused in any manner 
whatsoever by the use of the information on 
this website.

Some ChemSpider webpages link to pages on 
other websites, for the convenience of users. 
RSC Worldwide Ltd is not responsible for the 
availability of content on these webpages. 
Nor does it endorse or warrant the services, 
products or information offered on these other 
pages, unless explicitly stated.

For site security purposes software programs 
and algorithms are used to monitor traffic and 
to identify unauthorized attempts to upload or 
change information or otherwise cause 
damage to the ChemSpider service. In the 
event of unauthorized activities utilizing 
information on the ChemSpider website 
information from these sources may be used 
to help identify an individual for prosecution.

Data

The data on the ChemSpider website are 
sourced from a number of contributors and 
collaborators. The majority of data were 
originally sourced from the NCBI-PubChem 
website and are made available under the 
explicit statements and disclaimers provided 
by National Center for Biotechnology 
Information (NCBI). NCBI places no 
restrictions on the use or distribution of the 
data contained within their database. RSC 
Worldwide Ltd has abided by the assumptions 
of NCBI. These are as follows: "While some 
submitters of the original data (or the country 

of origin of such data) may claim patent, 
copyright, or other intellectual property rights 
in all or a portion of the data (that has been 
submitted), NCBI is not in a position to 
assess the validity of such claims and, 
therefore, cannot provide comment or 
unrestricted permission concerning the use, 
copying, or distribution of the information 
contained in the molecular databases." In this 
regard should any contributors to the NCBI-
PubChem database wish to have their data 
removed from the ChemSpider website please 
send a detailed request to 
info@chemspider.com.

Data on ChemSpider, including structures and 
spectra, are sourced also from individuals. In 
depositing these data to the ChemSpider 
website, these individuals undertake that they 
have the rights to do so, and that the rights do 
not reside with any third party.

PubChem User Requirements

http://eutils.ncbi.nlm.nih.gov/entrez/query/
static/eutils_help.html

Do not overload NCBI’s systems. Users 
intending to send numerous queries and/or 
retrieve large numbers of records from Entrez 
should comply with the following:

• Run retrieval scripts on weekends or 
between 9 pm and 5 am Eastern Time 
weekdays for any series of more than 100 
requests.

• Make no more than one request every 3 
seconds.

• NCBI’s Disclaimer and Copyright notice 
must be evident to users of your service.  
NLM does not claim the copyright on the 
abstracts in PubMed; however, journal 
publishers or authors may. NLM provides 
no legal advice concerning distribution of 
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copyrighted materials, consult your legal 
counsel.

Multiplet Tool Widget
Purpose
The Multiplet Tool widget is a comprehensive 
tool for generating multiplet trees, simulating 
signals and producing their figures. It is 
perfectly suited for simulating nuclear 
magnetic resonance (NMR) or electron 
paramagnetic resonance (EPR, a.k.a. ESR) 
signals. The interface is shown in Figure 2.11.

Figure 2.11: Multiplet Tool Widget

Interface
The interface, from top to bottom, consists of 
the main multiplet panel and a row of buttons 
for performing various functions.

Use the buttons to set up the simulation and 
layout of the multiplet. The buttons perform 
functions as described in Table 9.

Table 9: Multiplet Tool Widget Buttons

Button Function

The Add to the Doodle Board 
button will place the current 
multiplet from the main multiplet 
panel into the current document.
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Button Function

The Input Parameters button 
pops up a window for you to 
define parameters for the 
simulation including the number 
of neighboring nuclei, their spin 
and coupling magnitude.

The Real-Time Sliders button 
provides a window with sliders 
for each parameter. Changing the 
sliders will affect the simulation 
in real time.

The Settings button will display 
a window to define how the 
simulation is performed and how 
the multiplet figure is laid out 
and displayed.

Once you have completed your simulation, 
just drag and drop the multiplet from the main 
multiplet panel onto the Doodle Board.

Simulating Multiplets
To simulate multiplets, define the parameters 
in the Input Parameters window that 
appears after clicking the Input Parameters 
button and then click the Calculate button as 
shown in Figure 2.12. Press the reset button 
in this window to reset all parameters.

Figure 2.12: Multiplet Input Parameters

To tweak the input parameters to analyze their 
affect on the simulation, just use the Real-
Time Sliders button and change the values 
slowly in the window that appears as shown 
in Figure 2.13. When you are satisfied with 
the simulation, press the Done button. The 
Reset button will reset the parameters to their 
initial values before the window was opened.

Figure 2.13: Real-Time Sliders

Setting up the Multiplet Figure
To define how the simulation is performed 
and how the multiplet figure is displayed, 
click on the Settings button to show the 
Multiplet Settings window as shown in 
Figure 2.14.

Figure 2.14: Multiplet Settings

Editing Multiplets from the Doodle 
Board
To edit a multiplet from the Doodle Board, 
just select it and then drag and drop it onto 
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the Multiplet Tool widget button or onto the 
main multiplet panel. A copy will be made 
and can be edited using the Multiplet Tool 
widget. Just add this new edited multiplet to 
the Doodle Board and delete the old one.

Memory and Runtime Issues
A nucleus of any spin may be used, including 
hypothetical spins, however more complex 
simulations require more memory and 
processor power leading to longer runtimes. 
Some extremely complex simulations may 
cause memory issues. 

NMR SignalSeek Widget
Purpose
The NMR SignalSeek widget simulates 1H 
and 13C nuclear magnetic resonance and also 
associates peaks with nuclei. Full information 
about each simulation is provided for in-depth 
analysis. The interface is shown in Figure 
2.15.

Figure 2.15: NMR SignalSeek Widget

Interface
The interface, from left to right, consists of 
the main structure panel and a row of buttons 
for performing various functions, followed by  
a set of panels for displaying the simulated 
NMR spectra with 13C displayed on top and 
1H displayed on the bottom.

The main structure panel displays the 
structure being analyzed and is interactive. 
The spectra are also interactive and display 
the simulation results. Use the buttons to set 
up the simulation and copy content to the 
Doodle Board. The buttons perform 
functions as described in Table 10.

Table 10: NMR SignalSeek Widget Buttons

Button Function

The Add to the Doodle Board 
button will place both the 
simulated 1H and 13C spectra 
onto the current document.
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Button Function

The Settings button will display 
a window to define how the 
simulation is performed.

Simulating NMR
To simulate NMR spectra for a structure, drag 
and drop that structure from the Doodle 
Board onto the NMR SignalSeek widget 
button or the main structure panel. The 1H 
and 13C NMR spectra are instantly generated 
and displayed.

All variables for the simulation can be 
customized. To define the variables, click on 
the Settings button to display a window 
containing the parameters, as show in Figure 
2.16. When you are finished, click the 
Simulate button to recalculate the spectra. 
Adjust these parameters to match an 
experimental spectrum for correlated figures 
on the Doodle Board. Settings include:

• TMS - Display or hide the reference peak.

• Roof Effects - Simulate roof effects.

• Line Shape - Lorentzian or Gaussian.

• Pulse Frequency - The spectrum 
resolution. The value is appropriate for 1H 
NMR. 13C NMR will be simulated to a 
resolution of a quarter of this value to 
remain consistent with experimental 
spectrometers.

• Line Width - Control the line width.

• Dilution - Affect the solvent/solute 
intensity ratio.

• Temperature - Change the simulation 
temperature.

• Solvent - Choose a solvent. Splitting is 
fully calculated with the appropriate spin of 

the nuclei (Deuterium has a spin of 1 and 
you will see this splitting correctly in the 
solvent peaks).

Figure 2.16: NMR Simulation Settings

Analyzing the Results
The spectra are completely interactive. You 
can easily change the view of the spectrum by 
clicking and dragging to zoom in on the x-
axis. Double clicking on the spectrum will 
revert it to the full view. Scrolling will change 
the scale of the y-axis.

Peaks and nuclei are hoverable. Hovering 
over a peak will highlight the corresponding 
nuclei and vice versa. The chemical shift of 
the nuclei is displayed above the structure in 
the main structure panel.

Clicking on a highlighted peak or nuclei set 
will display further data from the simulation, 
including the shift prediction, splitting nuclei 
and j-constant predictions as shown in Figure 
2.17. Use this to gain further information 
about multiplets.

Figure 2.17: In-depth Simulation Information
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Lastly, the widget is initially small to 
conserve space. But with all widgets, you can 
resize or maximize them if you would like 
more interaction space.

How NMR is Simulated
The simulations in the NMR SignalSeek 
widget are based on empirical algorithms, 
with a database of incremental constants 
compiled from publications and some 
unpublished work. These references are listed 
by clicking the References menu item in the 
Help menu. Further information on the 
algorithms used to simulate NMR is provided 
in Appendix E. 

Properties Widget
Purpose
The Properties widget calculates and 
displays descriptors for molecules. There are 
two unique interfaces displayed by the 
Properties widget depending on the situation. 
If and only if a single molecule is being 
drawn, a table will be displayed. Otherwise, a 
drop-down tree will be presented to show data 
for each of the selected molecules. The 
Properties widget will automatically update 
to reflect any changes if allowed to. The 
interface displayed when a single molecule is 
being edited is shown in Figure 2.18, and the 
interface displayed when molecules are 
selected is shown in Figure 2.19.

Figure 2.18: Properties Widget Interface with a 
Single Molecule is being Drawn

Figure 2.19: Properties Widget Interface when 
Molecules are Selected
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Interface
The interface consists of a checkbox and 
button at the top that control when the widget 
updates and the data component at the bottom 
which displays a table or drop-down tree 
depending on the situation.

The table is non-interactive and only displays 
the most important information. For the rest 
of the descriptors, select the molecule to 
display the organized tree. To use the tree, 
just click the arrow to the left of each item, or 
double click on the item to expand it.

When the Auto-update checkbox is selected, 
the Properties widget will refresh 
automatically when any content is changed. 
Deselect the checkbox to improve drawing 
performance when handling large molecules. 
When the Auto-update checkbox is 
deselected, the Update button will be enabled 
to manually control when the widget 
refreshes.

Currently, the Properties widget calculates 
the following properties for each molecule:

• Molecular Formula

• Counts

• Atoms

• Bonds

• Rings

• Frèrejacque Number

• All Rings

• Hydrogen Bond Acceptors

• Hydrogen Bond Donors

• Degree of Unsaturation

• Lipinski’s Rule of 5 Violations

• Wiener Index

• Calculations

• Molar Refractivity

• Topological Polar Surface Area

• XlogP v2.0

• Mass

• Molecular

• Monoisotopic

• Elemental Composition

To copy content from the Properties widget, 
just right-click on any item and choose the 
Copy menu item.

It may take a lot of clicks to access 
information through the Properties widget. 
For quicker access to all molecular 
descriptors, use the Descriptors submenu of 
the Structure menu.
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Search Widget
Purpose
The Search widget allows you to search your 
hard drive and any attached storage devices 
for chemical structures. The Search widget 
recognizes all formats that ChemDoodle 
understands, so you will be able to find the 
old files you thought you lost a long time ago 
and edit them in ChemDoodle. The interface 
is shown in Figure 2.20.

Figure 2.20: Search Widget

Interface
The interface, from top to bottom, consists of 
a Folder button to select the root directory of 
the search, Match and Multiple options to 
define how the search is performed, a small 
drop panel to drop the structures to be 
searched for and to notify you that a search is 
currently being performed, a column of 
buttons for various functions with a main 
structure panel to the right of them, a list of 

search results and then labels to notify you of 
search progress.

The top section will allow you to select a root 
folder for the search. Just click on the Folder 
button and use the file chooser that appears to 
select a folder. Try to be as exclusive as 
possible when choosing a root folder, as 
searching your entire hard drive can take a 
very long time and may cause memory issues.  
The Match and Multiple options will affect 
how the search is performed. Setting Match 
to Entire will guarantee that all results are 
exact matches of the query structures, while 
selecting Substructure will match any 
structures where the query structures are 
matched exactly or contained within larger 
structures. Setting Multiple to AND will 
ensure that all query structures are matched in 
a file for that file to be considered a result, 
while selecting OR will allow any matched 
query structure to qualify the file as a result.

Initially, the interface is collapsed. Drag and 
drop a structure or group of structures from 
the Doodle Board onto the small drop panel 
or onto the Search widget button to expand it 
and set the query structure content.

The buttons perform functions as described in 
Table 7.

Table 7: Search Widget Buttons

Button Function

The Search button will begin the 
search query using the query 
structure(s) dropped on Search 
widget button and the search 
options set.

The Settings button will allow 
you to control search parameters 
and improve performance.
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Button Function

The Open button will open the 
currently selected result on the 
Doodle Board.

The Add to the Doodle Board 
button will place the current 
structure in the main structure 
panel onto the current document. 
Alternatively, you can click on 
the main structure panel and drag 
onto the document to place it.

The Clear button will clear the 
current contents and collapse the 
widget.

While the search is being performed, a 
pulsing stop sign will become visible on top 
of the small drop panel to notify you of search 
progress. Clicking on the stop sign will 
terminate the search. At the bottom of the 
interface are two labels. The first label names 
the file currently being searched, and will 
display Finished! when completed. The 
second label displays statistics about the files 
searched since the search was initialized in 
the following format:

Files Matched/Chemical Files Searched/Total Files Searched

Be careful with the search! Searching large 
numbers of files may cause ChemDoodle to 
run out of memory, causing slow response in 
ChemDoodle. Choose the root search folder 
and the search settings described in the next 
section with care.

Once the search is completed, all matched 
files will be listed in the results list. Click on 
any result to view all the structures in that 
file, one at a time, in the main structure panel. 
All hits are highlighted in red. If a file 
contains multiple structures, clicking the grey 

arrows that appear to the left and right of the 
structure will allow you to browse through 
them. The total number of structures in the 
file is noted at the bottom left of the main 
structure panel. Once you have found the 
structure you were looking for, just drag and 
drop the structure from the main structure 
panel onto the Doodle Board. You can also 
use the Open button to open the entire file on 
the Doodle Board.

Search Settings
Search parameters can be defined by clicking 
on the Settings button. A window with the 
options will appear as shown in Figure 2.21.

Figure 2.21: Search Settings for the Search 
Widget

There are currently 3 options:

1. Search File Size Restriction - This value 
determins the maximum file size that the 
Search widget will include in its search, 
avoiding memory issues.

2. Maximum Number of Search Results - 
This value will control the maximum 
number of search results. The search will 
continue until all the files in the selected 
root search folder are visited or when this 
maximum result value is reached. Keeping 
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it low and providing smaller root search 
folders will avoid runtime and memory 
issues.

3. Exclude PDB Files - Many times, PDB 
files are very large and contain molecular 
dynamics trajectories or Monte Carlo 
distributions. To avoid all of these files, 
which will cause runtime and memory 
issues, keep this option selected. If you 
need to search through PDB files, turn this 
option off. 

Statistics Widget
Purpose
The Statistics widget will display information 
about the current document and hovered or 
selected items. Use it to help with drawing 
and placement tasks.

Interface
The interface is separated into three sections 
as shown in Figure 2.22. The top section 
displays information about the document, the 
middle section displays information about the 
content, and the final section displays specific 
information about hovered or selected 
objects.

Figure 2.22: Statistics Widget
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Symbols Widget
Purpose
The Symbols widget is a complement to the 
Labels toolbar. This widget contains an 
abbreviation library, a periodic table of 
elements, arrows, greek letters and many 
other symbols. A few selected tabs are shown 
in Figures 2.24-2.26.

Interface
The content in the Symbols widget is small 
and may be difficult to read. As can be seen in 
Figure 2.23, hovering over any symbol will 
show a larger preview at the top left hand 
corner of the widget. Hovering for a few 
seconds will also display a tooltip description.

Figure 2.23: Symbol Preview

When abbreviations or elements are chosen, 
you may modify atoms as described in the 
labels section. Other symbols, such as arrows 
may not be used directly as atom labels. 
However, you can open up an atom label text 
field, and then input the symbol. If you are 
modifying any text component, clicked 
symbols will be inserted into the component's 
content.

Figure 2.24: Abbreviations Tab

Figure 2.25: Arrows Tab

Figure 2.26: Elements Tab
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If you set an atom's label to one that is not 
recognized or parsed by ChemDoodle, an 
unrecognized warning will appear. You may 
dismiss this warning or edit the current list of 
abbreviations to allow unrecognized tokens 
by selecting the Add New... menu item in the 
Structure menu in the Abbreviations 
submenu.

Figure 2.27: The Unicode Character Selector

All possible symbols available are accessible 
in the Symbols widget, even if they are not 
displayed immediately in the tab sets. Just 
click the Unicode Character Selection 
button at the bottom of the widget to view the 
unicode character selector shown in Figure 
2.27. Using hex, you can traverse the entire 
Unicode range and easily insert any desired 
symbols into text components. Note that not 
all fonts will have character glyphs assigned 
to each hex value. In these cases, a blank 
space or empty rectangle will appear in your 
text component and in the unsupported 
symbol button.

NOTE: Some programs use the Symbol 
font to display symbols. This is an archaic 

solution and the standard is to now use 
unicode characters, which ChemDoodle 
fully supports. ChemDoodle will try to 
recognize and correct such cases when 
reading in files from other programs.
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Templates Widget
Purpose
The Templates widget organizes your 
templates and allows you to easily use them. 
The interface is shown in Figure 2.28.

Figure 2.28: Templates Widget

Interface
The interface, from top to bottom, consists of 
a main structure panel, a drop down selection 
for selecting a template group and a scrollable 
list for selecting a template.

The main structure panel displays the selected 
template. An atom can be set to be the 
substitution point by clicking on it. The 
substitution point is the atom that will be 
overlapped with the atom the template is 
connected to.

The template group drop down selection will 
allow you to select a group of templates to 
browse. After selecting a template group, the 
template list will populate with templates 
from that group. Just click on a template to 
display it in the main structure panel for use.

Using Templates
Drawing with templates and creating 
templates is discussed in detail in Chapter 3.
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TLC Canvas Widget
Purpose
The TLC Canvas widget provides a tool for 
creating graphics of thin layer 
chromatography (TLC) plates. The interface 
is shown in Figure 2.29.

Figure 2.29: TLC Canvas Widget

Interface
The interface, from left to right, consists of a 
column of buttons for spot types, the main 
TLC panel for drawing the TLC plate and a 
column of buttons for performing various 
functions.

The top button in the spot type column sets 
the color of spots. Beneath the color button 
are 6 different shapes of spots:

• Compact Spot - a small dot

• Expanded Spot - a circle

• Trailing Spot - a small dot with a trail

• Widened Spot - an oval aligned 
horizontally

• Crescent Spot - a crescent shape with bowl 
facing downwards

• Custom Spot - a splatter shape that can be 
changed

Click on any of the spot types to set the 
drawing mode to place the spot.

Each spot button is a group button. Expand 
the group button for more spot styles. For 
each spot there are three spot styles:

• Solid Style - Solid throughout

• Empty Style - Just a line border

• Diffuse Style - Gradient from the center to 
the edges

The main TLC panel contains the TLC plate 
being drawn. You can edit it using the 
controls to the right. When finished editing 
the TLC plate, use the Add to Doodle Board 
button to place it on the Doodle Board.

The right-most button column contains 
function buttons to control how to edit the 
TLC plate. The buttons perform functions as 
described in Table 8.

Table 8: TLC Plate Widget Buttons

Button Function

The Add to the Doodle Board 
button will place the current TLC 
plate in the main TLC panel onto 
the current document.

The TLC Settings button will 
popup a window to edit the 
visual specifications of the TLC 
plate.

69



Button Function

The Move button allows you to 
translate spots along their lanes 
and allows you to move the 
origin and solvent front.

The Resize Spots button will 
display the anchor points for all 
spots and allow you to click and 
drag them to alter spot shapes.

The Delete button will all you to 
remove spots by clicking on them 
and allow you to delete lanes by 
clicking on the lane tick at the 
origin.

The Clear button removes all 
spots, leaves a single lane, and 
resets the origin and solvent 
front.

Drawing TLC Plates
There are 13 buttons associated with the TLC 
Canvas. The controls on the left are the 
simplest. The top button is the color of the 
spots, just click it to choose a different color. 
The rest of the buttons in that column 
correspond to spot shapes. These are the 
compact, expanded, trailing, widened, 
crescent and custom spots, in that order. Just 
click on a spot button, then hover over the 
TLC plate for a preview and Rf calculation. 
Once you are satisfied with a location, click 
to place the spot. You can create new lanes by 
placing spots in between the existing lanes. 

These spot buttons are group buttons and 
more spot styles will appear when hovered. 
All of the spots can be initialized with a solid, 
hollow or gradient style. The gradient styled 
spots most closely represent actual spots.

Using the Move button, you hover over spots 
to highlight them, and then click and drag to 
move them along their lanes. Rf values are 
displayed while you move spots. You may 
also click and drag the origin and solvent 
front to move them, preserving Rf values.

When spots are hovered, you can right click 
on them to open a popup menu with the 
following functions:

• Duplicate Spot - Will produce a duplicate 
spot of the hovered spot, underneath the 
hovered spot in the same lane.

• Remove Spot - Will delete the spot.

• Format Spot - Opens the Format Spot 
window.

The Format Spot window will provide several 
options for precisely defining its color, style, 
display settings and position as shown in 
Figure 2.30.

Figure 2.30: Format Spot Window

To resize and reshape spots on the TLC plate, 
use the Resize Spots button. Just hover over 
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the control points that appear, and then click 
and drag to move them. All spots except the 
custom spot are defined by 4 control points. 
You may move all four to create different 
shapes. The custom spot is unique and is 
defined by 8 control points. You may use 
custom spots to create much more 
complicated shapes.

To remove spots and lanes, use the Delete 
button. Hover over spots to highlight them, 
then click to remove them. You may delete a 
lane by clicking its lane tick at the origin. 
Deleting a lane will also delete its contained 
spots. To clear and reset the entire TLC plate, 
click the Clear button.

Editing TLC Plates from the Doodle 
Board
To edit a TLC plate from the Doodle Board, 
just select it and then drag and drop it onto 
the TLC Canvas widget button or onto the 
main TLC panel. A copy will be made and 
can be edited using the TLC Canvas widget. 
Just add this new edited TLC plate to the 
Doodle Board and delete the old one.
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Chapter 3: Basic 
Structures
Overview
You can draw any structure imaginable with 
ChemDoodle. However, with all of the 
drawing tools available, drawing basic 
structures may seem overwhelming to the 
new user.

This section introduces the new user to the 
basic structure drawing tools within 
ChemDoodle. It covers the following topics:

• Recognizing the structure drawing tools.

• Drawing atoms.

• Setting atom labels.

• Drawing bonds.

• Changing bond orders.

• Drawing chains.

• Drawing rings.

• Drawing templates.

• Adding attributes to structures, such as 
charges, radicals and symbols.

• Setting mass number values to isotopes.

• Placing orbitals on structures.

KeyBoard Shortcuts
There are many keyboard shortcuts to help 
you draw structures quickly and efficiently. 
The full list of keyboard shortcuts is given in 
the KeyboardShortcuts.pdf file located in the 
docs folder in the main ChemDoodle 
installation folder.

Atoms
Atoms are the basic building blocks in 
chemistry and are the basic building blocks in 
ChemDoodle. Before any other chemical 
objects can be drawn, an atom must be 
present as the starting point.

Placing Carbon Atoms
When you first use ChemDoodle, you will 
notice a gray dot following your mouse 
pointer on the Doodle Board as shown in 
Figure 3.1.

Figure 3.1: Trailing Carbon Atom

To set a carbon atom at the current location of 
the mouse pointer, just click the mouse. This 
will set the carbon atom and structures can be 
grown from it.

At any time while drawing chemical 
structures, if there is no hovered atom to grow 
from, a carbon atom will trail your mouse to 
be placed and grow a new structure.

NOTE: More advanced users may find it 
inconvenient to always require a starting 
atom to draw structures. You can turn off 
this restriction in the Preferences window 
under the General tab, by check the 
Require Starting Atom checkbox. Clicks 
with the bond tools will then immediately 
place those bonds and ring, templates and 
chains will not require a starting atom.

Placing Other Elements
To place atoms with element symbols other 
than carbon, use the Labels toolbar or the 
Elements panel in the Symbols widget. Just 
click on the desired element symbol, and the 
mouse cursor will change to be that symbol 
with a small arrow at the bottom-left. Once 
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you have located where to place the atom 
using the bottom-left arrow of the new mouse 
cursor, just click to place it.

If you click while an atom is hovered, then 
that atom’s label will change to the currently 
selected element symbol.

Placing Atoms with Non-elemental 
Labels
To place atoms with any text you desire, click 

on the Set Atom Label tool  located in 
the Labels toolbar. Then click on the Doodle 
Board in the desired location to place the 
new atom and to open up an atom label text 
field. Type in the desired atom label text into 
the text field and then click elsewhere on the 
Doodle Board or press the return key to close 
the text field and set the atom.

If you click while an atom is hovered, then a 
text field will appear for that atom’s label for 
you to edit.

Hovering Atoms
With most tools in ChemDoodle, atoms can 
be hovered. Exceptions include the shape 
tools, such as when drawing rectangles. 
Hovering an atom is very simple, just get 
your mouse close enough to an atom so that it 
is surrounded by an amber circle as shown in 
Figure 3.2.

Figure 3.2: A Hovered Atom

The atom is then defined as being hovered 
and further actions pertaining to it can be 
performed.

By default, most carbon atoms have their 
labels hidden to create skeleton figures. To 
modify when carbon labels are displayed, 
please refer to the Carbon Labels section in 
Chapter 6.

Selecting Atoms
To select atoms, first hover them and then 
press the mouse down. The amber circle will 
turn into a blue circle as shown in Figure 3.3.

Figure 3.3: A Selected Atom

The blue circle is actually a special 
component called the Optimize Zone, which 
will be discussed in the Bonds section.

To deselect atoms, just release the mouse.

Changing Atom Labels to other 
Elements
To change an atom’s label to another element 
symbol, use the Labels toolbar or the 
Elements panel in the Symbols widget. Just 
click on the desired element symbol, and the 
mouse cursor will change to be that symbol 
with a small arrow at the bottom-left. Once 
you have hovered the atom with the label to 
be changed, just click to set the new label.

Additionally, when an atom is hovered, you 
can press any of the letter keys on the 
keyboard to cycle through the element 
symbols that begin with that letter.

73



Changing Atom Labels to Non-
elemental Text
To change an atom’s label to any text you 

desire, click on the Set Atom Label tool  
located in the Labels toolbar. Then hover the 
atom with the label to be changed and click to 
open up its atom label text field. Type in the 
desired atom label text into the text field and 
then click elsewhere on the Doodle Board or 
press the return key to close the text field and 
set the new label.

Additionally, you can hover the atom in any 
mode and then press the space key to open 
the atom’s label text field.

Repeating the last Typed Atom Label 
for other Atoms
When writing a complex atom label, you may 
want to repeatedly use that label for other 
atoms. After typing the label, just hover the 
other atoms with labels to be changed and 
press the enter key. The hovered atom’s label 
will be set to the last typed label.

You can also define the label text to be used 
by the enter key by opening up a previously 
typed atom label text box and then closing it.

Moving an Atom
To move an atom, first select one of the 
selection tools discussed in Chapter 5. Make 
sure that no content is currently selected by 
emptying the lasso. Perform the following 
steps:

1. Hover the atom to be moved.

2. Press the mouse down to select the atom.

3. Drag the mouse to move the atom.

4. Release the mouse to finish the move 
action.

If the atom is a terminal atom in a molecule, 
then the above instructions will move the 

atom and bond with fixed angles and lengths 
as described in the Bonds section.

If the atom is part of a molecule and not a 
terminal atom, the the above instructions will 
move that entire molecule. Just hold down the 
shift key while performing the above 
instructions to move the atom by itself.

Deleting an Atom
To delete an atom, hover it and then press the 
delete or backspace key. All attached bonds 
will also be removed, leaving the adjacent 
atoms.

Chemical Labels
The last section described how to use the 
atom label tool to assign any arbitrary text to 
an atom. This text is chemically interpreted; a 
label of CH3 will be interpreted as one carbon 
atom with three hydrogen atoms attached to 
it. Much more advanced labels can be written 
and parsed. More information on chemical 
interpretation, and expanding these labels, is 
described in Chapter 6.

In addition to chemical interpretation, the 
label will automatically be formatted for 
display; the CH3 label will display as CH3. 
Stacking will also be applied, so as bond 
overlap with labels is kept to a minimum. 
ChemDoodle’s intuition may not always be 
what you intended though, and you may want 
to format more advanced labels, such as for 
rendering isopropyl groups (iPr and iPr) or 
adding indexes to carbon chain groups (R10). 
In these cases, you can override 
ChemDoodle’s chemical interpretation and 
apply your own formatting.

Atom Label Tool
When opening an atom label field, a format 
toolbar will appear above it containing 
several controls. The only enabled button will 
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be the Interpret Chemically button, which is 
selected by default as shown in Figure 3.4.

Figure 3.4: Only one button is enabled by default.

Without further editing, closing this label will 
assign an ethyl group to the atom and the text 
will be automatically formatted as CH2CH3.

Atom Label Token Stacking
When labels are chemically interpreted, they 
will be split up into tokens that describe each 
discrete unit. For instance, NH will be split 
into (N)(H) and CCH2COOH will be split 
into (C)(CH2)(COOH). More about this is 
covered in Chapter 6. ChemDoodle will 
automatically stack tokens in atom labels 
such that they overlap with surrounding 
bonds as little as possible as shown in Figure 
3.5.

Figure 3.5: Atom label tokens are stacked to 
overlap with bonds as little as possible.

By default, if not on a terminal atom, and 
stacking will help reduce clutter, the second 
token and all subsequent tokens will be 
stacked to the next line. There are two visual 
specifications for more precise control over 
this behavior:

• Stack Lone/Terminal - In the Preferences 
window, in the Visuals tab in the Atoms 
section under the Labels subsection, you 
can set this checkbox to determine if lone 
and terminal labels will also stack labels.

• Token Stacking - In the Preferences 
window, in the Visuals tab in the Atoms 
section under the Labels subsection, you 
can set multi-choice option to declare 
whether token stacking occurs for all 
individual tokens, for only the second token 
or never for any token.

In addition to the token behavior settings, you 
also have full control of the spacing between 
tokens. All of these settings are present in the 
Preferences window, in the Visuals tab in the 
Atoms section under the Labels subsection.

Formatting Atom Labels
If a different format is desired, just deselect 
the Interpret Chemically button and the 
formatting options will be enabled as shown 
in Figure 3.6. 

Figure 3.6: Applying a custom format to an atom 
label.

Use the controls in the toolbar that appears 
above the atom label field to explicitly format 
the atom label. Table 11 lists how to change 
the following attributes.

Table 11: How to change these formatting 
attributes

Attribute Control

Bold Select the text to be bold 
and press the Bold button.

Italics Select the text to be 
italicized and press the 
Italic button.

Underline Select the text to be 
underlined and press the 
Underline button.
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Attribute Control

Strikethrough Select the text to display 
the strikethrough and 
press the Strikethrough 
button.

Superscript Select the text to be 
superscript and press the 
Superscript button.

Subscript Select the text to be 
subscript and press the 
Subscript button.

Alignment The entire label will be 
aligned to the selection of 
the Align Left, Align 
Center or Align Right 
buttons.

Color Select the text to be 
colored and press the 
Choose Color button. 
Then select the color.

Font Family Select the text to change 
the font family of and then 
use the font chooser in the 
Format toolbar to select 
the font family.

Font Size Select the text to change 
the font size of and then 
use the size chooser in the 
Format toolbar to select 
the font size.

Note: When disabling chemical 
interpretation, the label will lose all 
chemical significance, and will not be 
expandable or suitable for any chemical 
algorithms.

Atom Label Orientation
By default, atom label tokens will orient 
themselves in the direction of least overlap 
with the rest of the structure. Some times, it 
may be necessary to force the label to flush in 
a specific direction. To do so, perform the 
following steps:

1. Hover the atom with label to orient.

2. Right-click on the atom and expand the 
Label Flush submenu.

3. Choose the direction to orient the label. 
Choose Auto if you want ChemDoodle to 
automatically determine the best 
orientation.

Bonds
Bonds are the second most important building 
blocks in chemistry. Bonds in ChemDoodle 
are graphical connectors between atoms. 
There are many options for bond types and 
for defining how they look.

Placing a Single Bond
To place a single bond, click the Single Bond 

tool  in the Bonds toolbar which should 
be selected by default when ChemDoodle is 
opened.

Then hover over an atom and press the mouse 
down. A preview of the new bond and atom 
will be drawn as shown in Figure 3.7.

Figure 3.7: New Bond Placement Preview

Drag the mouse and use the techniques 
discussed in the following subsections to 
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place the bond in the preferred orientation. 
Then release the mouse to set the bond.

Placing Bonds other than Single 
Bonds
To place bond types other than Single bonds, 
just click on the desired bond type in the 
Bonds toolbar. Then follow the instructions 
for placing a Single bond.

Optimize Zone
The Optimize Zone is a special component in 
ChemDoodle to help you place bonds in the 
optimal position around atoms. It is the blue 
circle that appears when placing bonds and 
other molecule fragments. To use the 
Optimize Zone, just place the mouse pointer 
in the blue circle. The bond or fragment being 
placed will automatically be oriented in the 
most optimal position.

The Optimize Zone size can be changed in 
the Preferences window under the General 
tab.

Placing Bonds with Fixed Lengths and 
Angles
By default, fixed widths and fixed angles are 
enforced when drawing structures. To place a 
bond within these restraints, hover over an 
atom and press the mouse down with a bond 
tool. You will see the Optimize Zone appear. 
Drag the mouse pointer out of the Optimize 
Zone. The new bond placement will now 
orient towards the mouse pointer.

The default fixed length is defined by the 
Bond Length visual specification in the 
Preferences window under the Visuals tab 
under the Bonds tab. Angles are fixed every 
30° starting at 0°.

You can set whether fixed lengths and/or 
fixed angles are on by default in the 
Preferences window under the General tab.

Placing Bonds at Non-fixed Lengths
When placing bonds outside of the Optimize 
Zone, fixed lengths will be enforced. To 
break from fixed lengths, hold down the shift 
key while placing the bond.

You may turn off fixed lengths in the 
Preferences window under the General tab. 
In this case, the shift key will then enforce 
fixed lengths.

Placing Bonds at Non-fixed Angles
When placing bonds outside of the Optimize 
Zone, fixed angles will be enforced. To break 
from fixed angles, hold down the alt key 
while placing the bond.

You may turn off fixed angles in the 
Preferences window under the General tab. 
In this case, the alt key will then enforce 
fixed angles.

Placing Bonds at Non-fixed Lengths 
and Non-fixed Angles
When placing bonds outside of the Optimize 
Zone, fixed angles and fixed lengths will be 
enforced. To break from fixed lengths and 
fixed angles at the same time, hold down both 
the shift and alt key while placing the bond.

You may turn off fixed lengths and fixed 
angles in the Preferences window under the 
General tab. In this case, holding the shift 
and alt keys will then enforce fixed lengths 
and angles.

Connecting two Atoms with a New 
Bond
If two atoms are already present in the 
document and you want to connect them with 
a bond, just initiate drawing a new bond from 
one atom and without releasing the mouse, 
drag over the second atom until it is 
highlighted with a red circle. Then release the 
mouse and the new bond will be formed.
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Hovering Bonds
With some tools in ChemDoodle, bonds can 
be hovered. Hovering a bond is very simple, 
just get your mouse close enough to the 
center of the bond so that it is encapsulated by 
a pair of amber semicircles as shown in 
Figure 3.8.

Figure 3.8: A Hovered Bond

The bond is then defined as being hovered 
and further actions pertaining to it can be 
performed.

Selecting Bonds
Bonds can only be selected when using the 
selection tools discussed in Chapter 5. To 
select bonds, first hover them and then press 
the mouse down. The amber semicircles will 
turn a blue color as shown in Figure 3.9.

Figure 3.9: A Selected Bond

Changing a Bond Type
To change a bond type, first select the bond 
type you would like to change the bond to in 
the Bonds toolbar. Then hover the bond with 
the type that you would like to change and 
click the mouse. The new bond type will 
override the old type.

Changing Selected Bonds to Single 
Bonds
To change the bond types of a large number 
of bonds to all be Single bonds, perform the 
following steps:

1. Select the bonds to be changed to Single 
bonds using a selection tool as discussed 
in Chapter 5.

2. Press the Saturate menu item in the 
Structure menu.

Incrementing a Bond Order
When using the Single Bond tool, clicking on 
hovered bonds will not override other bond 
types. Instead the Single Bond tool will 
increment the bond order. For example, 
clicking on a Double bond will change it to a 
Triple bond and clicking on the Triple bond 
will change it to a Quadruple bond. Clicking 
on a Sextuple bond will change the order 
back to a Single bond.

This functionality can be disabled so that the 
Single Bond tool overrides bond types in the 
Preferences window under the General tab.

Deleting a Bond
To delete an bond, hover it and then press the 
delete or backspace key. The constituent 
atoms will remain.

Deleting Bonds Around Atoms
To delete bonds, but retain the atoms 
contained in the bonds, perform the following 
steps:

1. Select the bonds to be removed using a 
selection tool as discussed in Chapter 5.

2. Press the Remove Selected Bonds menu 
item in the Structure menu.

All selected bonds will be removed, but 
atoms will remain present.
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Changing the Z-Order of Bonds
When bonds overlap, one bond will be 
rendered in front of the other. For structures 
with 3D coordinates, the bond with the most 
positive z-coordinates will be rendered on 
top. Without z-coordinates, the last bond 
drawn will be rendered on top.

To change the z-order of bonds when z-
coordinates are present, perform the 
following steps:

1. Select the structure with the z-orders to be 
changed.

2. Select the Rotate in 3D tool in the 
Content toolbar.

3. Click and drag the mouse to rotate the 
structure in 3D so the desired bond is 
placed on top.

4. Release the mouse to stop the rotation and 
set the new coordinates.

To change the z-order of bonds when z-
coordinates are not present, perform the 
following steps:

1. Delete the bond that is to be rendered on 
top.

2. Redraw the bond.

Chains
Chains are a group of carbon atoms, linked 
linearly by bonds. Three types of chains are 
provided in ChemDoodle:

• Carbon Chain -  A consistent linear 
carbon chain, with all chain angles 
alternating at ±120° as shown in Figure 
3.10.

Figure 3.10: A Carbon Chain

• Fisher Projection Chain -  A straight 
carbon chain, with all chain angles at 180°. 
All non-terminal chain atoms also have two 
additional carbon atoms depicted 
perpendicular to the chain orientation as 
shown in Figure 3.11.

Figure 3.11: A Fisher Projection Chain

• Random Chain -  A carbon chain 
where all chain angles are at 120°, but the 
chain itself can deviate in any direction as 
shown in Figure 3.12.

Figure 3.12: A Random Chain

Placing Chains at Fixed Angles
To place chains at fixed angles, perform the 
following steps:

1. Select a chain tool in the Shapes toolbar 
using the Chain Tool group button.

2. Choose a starting atom to sprout the chain 
from by hovering it. If you do not want to 
start the chain from any existing atoms, 
create an atom in a new place by clicking 
on the Doodle Board where no atoms are 
hovered.

3. Press the mouse down on the hovered 
atom.
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4. Drag the mouse to the desired length of 
the chain. When using the Random chain, 
drag the mouse in the outline of the chain 
you would like to draw and the chain will 
grow following that path.

5. Release the mouse to set the chain.

By default, the chains will be oriented at fixed 
angles every 15° starting at 0°. All bond 
lengths are defined by the Bond Length 
visual specification in the Preferences 
window under the Visuals tab under the 
Bonds tab.

When dragging the mouse to define the chain, 
a number will be displayed below the mouse 
cursor to keep track of the number of bonds 
being added.

Placing Chains at Non-fixed Angles
To place chains at non-fixed angles, hold 
down the alt key while dragging the mouse 
when defining the chain to break from the 
fixed chain orientation angles.

Forcing the Placement of Chains 
Vertically and Horizontally
To place chains oriented vertically or 
horizontally, hold down the shift key while 
dragging the mouse when defining the chain. 
The chain preview will then automatically 
orient vertically or horizontally depending on 
angle from the starting atom to the current 
mouse cursor position.

Inverting Carbon Chains
Carbon chains can be inverted by holding 
down the slash key (/) while placing. The 
preview will update to reflect this.

Rings
Rings are a chain of carbon atoms where the 
last atom in the chain connects to the first. 
There may be bond types other than Single 

bonds in rings. Currently the following rings 
can be drawn quickly from the Rings toolbar, 
with more ring choices in the Templates 
widget:

• Cyclopropane ring

• Cyclobutane ring

• Cyclopentane ring

• Cyclohexane ring

• Cycloheptane ring

• Cyclooctane ring

• Cyclobutadiene ring

• Cyclopentadiene ring

• Benzene ring

• Cycloheptatriene ring

• Cyclohexane chair conformer 1

• Cyclohexane chair conformer 2

Placing a Ring
To place a ring, click the preferred ring tool in 
in the Rings toolbar.

Then hover over an atom and press the mouse 
down. A preview of the new ring will be 
drawn as shown in Figure 3.13.

Figure 3.13: New Ring Placement Preview

Drag the mouse and use the techniques 
discussed in the following subsections to 
place the ring in the preferred orientation. 
Then release the mouse to set the ring.
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Optimize Zone
The Optimize Zone can be used to optimize 
ring placement as described in the Bonds 
section.

Placing Rings with Fixed Lengths and 
Angles
By default, fixed widths and fixed angles are 
enforced when drawing structures. To place a 
ring within these restraints, hover over an 
atom and press the mouse down with a bond 
tool. You will see the Optimize Zone appear. 
Drag the mouse pointer out of the Optimize 
Zone. The new ring placement will now 
orient towards the mouse pointer.

The default fixed length is defined by the 
Bond Length visual specification in the 
Preferences window under the Visuals tab 
under the Bonds tab. Angles are fixed every 
30° starting at 0°.

You can set whether fixed lengths and/or 
fixed angles are on by default in the 
Preferences window under the General tab.

Placing Rings at Non-fixed Lengths
When placing rings outside of the Optimize 
Zone, fixed lengths will be enforced. To 
break from fixed lengths, hold down the shift 
key while placing the bond.

You may turn off fixed lengths in the 
Preferences window under the General tab. 
In this case, the shift key will then enforce 
fixed lengths.

Placing Rings at Non-fixed Angles
When placing rings outside of the Optimize 
Zone, fixed angles will be enforced. To break 
from fixed angles, hold down the alt key 
while placing the bond.

You may turn off fixed angles in the 
Preferences window under the General tab. 

In this case, the alt key will then enforce 
fixed angles.

Placing Rings at Non-fixed Lengths 
and Non-fixed Angles
When placing rings outside of the Optimize 
Zone, fixed angles and fixed lengths will be 
enforced. To break from fixed lengths and 
fixed angles at the same time, hold down both 
the shift and alt key while placing the bond.

You may turn off fixed lengths and fixed 
angles in the Preferences window under the 
General tab. In this case, holding the shift 
and alt keys will then enforce fixed lengths 
and angles.

Adding Rings to Bonds
When adding rings to atoms, you may not 
always find it easy to achieve an aesthetic 
fuse angle. To solve this, add the ring to a 
bond instead of an atom. The ring will 
automatically align to the bond it is being 
added to.

To add rings to bonds, perform the following 
steps:

1. Select a ring tool from the Rings toolbar.

2. Hover the bond a ring will be added to.

3. Click and drag the mouse pointer to the 
side of the bond the ring should be added 
to.

4. Release the mouse to set the ring.

When the mouse pointer is close to the bond 
the ring is sprouting from, ChemDoodle will 
automatically select the optimal side of the 
bond to add to.

Templates
ChemDoodle contains a very advanced 
structure templates system. Several sets of 
predefined templates are already packaged 
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with ChemDoodle and can be accessed 
through the Templates widget. Currently, the 
following template sets are provided:

• Amino Acids

• Cycloalkanes

• Functional Groups

• Hexoses

• Nucleotides

• Polycyclic Aromatic Hydrocarbons

• Polycycles

• Ring Conformers

• Stereocenters and Geometries

Selecting a Template for Use
The Templates widget organizes your 
templates and allows you to easily use them. 
Just follow these three steps to select a 
template for use:

Activate the Templates widget by clicking on 
the Templates widget button.

1. Choose a template group from the drop 
down selection.

2. Click on a template choice to choose a 
template from the list.

3. Define a substitution atom by clicking on 
the preferred atom in the main structure 
panel. The substitution point will overlap 
with the atom used as the growth position.

Placing templates is discussed in the 
following subsections.

Placing a Template
To place a template, set up a template and 
choose a substitution atom in the Templates 
widget.

Then hover over the atom in the document 
that you are attaching the template to and 
press the mouse down. A preview of the 
template will be depicted as in Figure 3.14.

Figure 3.14: New Template Placement Preview

Drag the mouse and use the techniques 
discussed in the following subsections to 
place the template in the preferred orientation. 
Then release the mouse to set the template.

Optimize Zone
The Optimize Zone can be used to optimize 
template placement as described in the Bonds 
section.

Placing Templates with Fixed Lengths 
and Angles
By default, fixed widths and fixed angles are 
enforced when drawing structures. To place a 
template within these restraints, hover over an 
atom and press the mouse down with a bond 
tool. You will see the Optimize Zone appear. 
Drag the mouse pointer out of the Optimize 
Zone. The new bond placement will now 
orient towards the mouse pointed.

The default fixed length is defined by the 
Bond Length visual specification in the 
Preferences window under the Visuals tab 
under the Bonds tab. Angles are fixed every 
30° starting at 0°.

You can set whether fixed lengths and/or 
fixed angles are on by default in the 
Preferences window under the General tab.
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Placing Templates at Non-fixed 
Lengths
When placing templates outside of the 
Optimize Zone, fixed lengths will be 
enforced. To break from fixed lengths, hold 
down the shift key while placing the template.

You may turn off fixed lengths in the 
Preferences window under the General tab. 
In this case, the shift key will then enforce 
fixed lengths.

Placing Templates at Non-fixed Angles
When placing templates outside of the 
Optimize Zone, fixed angles will be 
enforced. To break from fixed angles, hold 
down the alt key while placing the template.

You may turn off fixed angles in the 
Preferences window under the General tab. 
In this case, the alt key will then enforce 
fixed angles.

Placing Templates at Non-fixed 
Lengths and Non-fixed Angles
When placing templates outside of the 
Optimize Zone, fixed angles and fixed 
lengths will be enforced. To break from fixed 
lengths and fixed angles at the same time, 
hold down both the shift and alt key while 
placing the template.

You may turn off fixed lengths and fixed 
angles in the Preferences window under the 
General tab. In this case, holding the shift 
and alt keys will then enforce fixed lengths 
and angles.

Saving a New Template
To save a template into the Templates widget 
library, perform the following steps:

1. Draw the desired template on the Doodle 
Board.

2. Select the template with the selection 
tools discussed in Chapter 5. Only a 

single structure can be used in any 
template.

3. Right-click after selecting the structure.

4. Press the Add Fragment as Template... 
menu item to pop up the Add Template 
window.

5. Type in a name for the template in the 
Template Name text field.

6. Choose a template group to add the 
template to using the drop down selection. 
You can create a new template group 
using the Add Group button.

7. Click the Done button to add the 
template.

All of your templates are stored in the 
templates folder in the ChemDoodleSettings 
folder located in your operating system’s 
standard Document folder. You may distribute 
your template groups to other ChemDoodle 
users or place third party template groups in 
this folder to use them in ChemDoodle. If 
ChemDoodle is open when manually placing 
template groups in the templates folder, make 
sure to first close and then restart 
ChemDoodle for changes to take effect.

Managing your Templates
To manage your templates, click on the 
Manage My Templates... menu item in the 
Structure menu.

Attributes
Attributes are special objects in ChemDoodle 
that are associated with other chemical 
objects. These include charges, radicals, 
symbols and ids on atoms and ids on bonds. 
They are both spatially and semantically 
linked to the chemical object that they 
describe. Any number of attributes can be 
added to a single chemical object.
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In addition to the standard attributes provided 
in ChemDoodle, you can add your own text 
based attributes as shown for the attribute 
with display text of “attribute” for the 
nitrogen atom as shown in Figure 3.15.

Figure 3.15: An Attribute on an Atom

Adding Attributes
To add a custom attribute, perform the 
following steps:

1. Hover the atom to add the attribute to.

2. Right-click on the hovered atom.

3. Press the Add Attribute... menu item.

4. Type in the text to be displayed in the 
Display text field.

5. Type in an identifying name for the 
attribute in the Name text field. This 
value is used for the internal semantics 
and is not rendered.

6. Press the Add button to set the attribute.

Hovering Attributes
You can hover attributes by using any of the 
selection tools. First, make sure the current 
selection is empty and then move the mouse 
cursor close to the center of the attribute so 
that it is closer to the attribute than any other 
chemical objects. The attribute will then be 
defined as hovered and an amber circle will 
be rendered on top of it as shown in Figure 
3.16.

Figure 3.16: A Hovered Attribute

To help identify which object the attribute 
describes, a transparent amber circle is drawn 
over that object (the nitrogen atom in Figure 
3.16).

Selecting Attributes
Attributes can only be selected when using 
the selection tools discussed in Chapter 5. To 
select attributes, first hover them and then 
press the mouse down. The amber circle will 
turn a blue color as shown in Figure 3.17.

Figure 3.17: A Selected Attribute

Editing Attributes
The display text and names of custom 
attributes can be edited at any time by 
performing the following steps:

1. Hover the attribute to be edited.

84



2. Right-click on the hovered attribute.

3. Press the Format Attribute... menu item.

4. In the visual specifications window that 
appears, change the Name and Display 
text to the new values.

5. Click the Done button to set the new text 
values.

Moving Attributes
To move attributes, perform the following 
steps:

1. Hover the attribute to be moved.

2. Press the mouse down to select the 
hovered attribute.

3. Drag the attribute to the new preferred 
location.

4. Release the mouse to set the new position.

Attributes can only be moved a certain 
distance from the object that they describe. 
This distance is specified by the Allow 
Distance visual specification in the 
Preferences window under the Visuals tab 
under the Attributes tab. Change this to suit 
your needs.

Removing Attributes
To remove an attribute, use the Eraser tool 
and to click on the hovered symbol or hover 
the symbol with the selection tools and press 
the delete or backspace key.

Charges
Charges are attributes can be associated with 
any atoms as shown in Figure 3.18. Both 
positive and negative values can be used.

Figure 3.18: A Charge Attribute

Adding Charges
To add charge to an atom, perform the 
following steps:

1. Select the Increase Charge  or 

Decrease Charge  tools in the 
Attributes group button in the Shapes 
toolbar.

2. Hover the atom to add charge to.

3. Press the mouse down to add the charge.

4. If you prefer to have the charge placed 
elsewhere, then before releasing the 
mouse, drag the pointer to the desired 
location.

5. Release the mouse to set the charge.

Incrementing and Decrementing 
Charges
To change the charge of an atom, perform the 
following steps:

1. Select the Increase Charge  or 

Decrease Charge  tools in the 
Attributes group button in the Shapes 
toolbar.

2. Hover the atom to with the charge to be 
changed.

3. Click the mouse down to increment or 
decrement the charge.

The + and  - keys on the keyboard can also be 
used to increment and decrement charge 
values.

Removing Charges
Removing charges can be done is several 
ways:
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• Decrement or increment the charge value to 
0 using the Increase Charge and Decrease 
Charge tools.

• Select the Eraser tool and click on a 
hovered charge to remove it.

• Hover the charge using the selection tools 
and press the delete or backspace key.

Radicals
Radical types can be associated with any 
atoms as shown in Figure 3.19. Currently 
only Monovalent and Divalent Singlet types 
are supported.

Figure 3.19: A Radical Attribute

Adding Radicals
To add a radical electron to an atom, perform 
the following steps:

1. Select the Increase Number of Radical 

Electrons  tool in the Attributes 
group button in the Shapes toolbar.

2. Hover the atom to add the radical to.

3. Press the mouse down to add the radical.

4. If you prefer to have the radical placed 
elsewhere, then before releasing the 
mouse, drag the pointer to the desired 
location.

5. Release the mouse to set the radical.

Incrementing and Decrementing the 
Number of Radical Electrons
To change the charge of an atom, perform the 
following steps:

1. Select the Increase Number of Radical 

Electrons  or Decrease Number of 

Radical Electrons  tools in the 
Attributes group button in the Shapes 
toolbar.

2. Hover the atom with the radical to be 
changed.

3. Click the mouse down to increment or 
decrement the the number of radical 
electrons.

Removing Radicals
Removing radicals can be done is several 
ways:

• Decrement the radical value to 0 using the 
Decrease Number of Radical Electrons 
tools.

• Select the Eraser tool and click on a 
hovered radical to remove it.

• Hover the radical using the selection tools 
and press the delete or backspace key. 

Symbols
Symbols are standard types of atom 
decorations that can be associated with any 
atoms such as the Radical Cation symbol 
shown in Figure 3.20.

Figure 3.20: A Symbol Attribute

Currently, included symbols are:

1. Single Electron

2. Electron Pair aka. Non-bonding Pair, 
Lone Pair

3. Radical Cation

4. Radical Anion

5. Electron Pair (Bar)
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6. Positive Dipole

7. Negative Dipole

Adding Symbols
To add a symbol to an atom, perform the 
following steps:

1. Select the desired symbol tool in the 
Attributes group button in the Shapes 
toolbar.

2. Hover the atom the symbol will added to.

3. Press the mouse down to add the symbol.

4. If you prefer to have the symbol placed 
elsewhere, then before releasing the 
mouse, drag the pointer to the desired 
location.

5. Release the mouse to set the symbol.

Removing Symbols
To remove a symbol, use the Eraser tool and 
to click on the hovered symbol or hover the 
symbol with the selection tools and press the 
delete or backspace key.

Isotopes
Mass numbers can be associated with atoms 
with element symbols as their label to 
designate isotopes. All mass numbers are 
displayed in superscript format to the left of 
element symbols as shown in Figure 3.21.

Figure 3.21: A Carbon-13 Isotope

If you later change an atom’s label and there 
is a mass number associated with that atom, 
then the mass number will be removed.

Setting Published Isotope Mass 
Numbers
To set a published mass number to an element 
atom, perform the following steps:

1. Hover the atom with the mass number to 
be set.

2. Right-click on the hovered atom.

3. Expand the Mass Number submenu.

4. Press any of the listed values to set the 
mass number of the isotope.

Setting Arbitrary Isotope Mass 
Numbers
To set an arbitrary mass number to an element 
atom, perform the following steps:

1. Hover the atom with the mass number to 
be set.

2. Right-click on the hovered atom.

3. Expand the Mass Number submenu.

4. Press the Other... menu item.

5. Type in an integer value into the text field 
that appears.

6. Click the Accept button to set the mass 
number.

Removing Mass Numbers
To remove a mass number from an atom:

1. Hover the atom with the mass number to 
be removed.

2. Right-click on the hovered atom.

3. Expand the Mass Number submenu.

4. Press the Remove Mass Number menu 
item to remove the mass number.

Orbitals
2D graphics for various orbital shapes can be 
placed directly into the document or attached 
onto structures. Use them to show more 
detailed chemical figures. Each orbital shape 
has several different shading and fill styles.
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The following orbital types are provided:

• Atomic s Orbitals 

• Atomic px|y|z Orbitals 

• Atomic dxz|yz|xy|x2-y2 Orbitals 

• Atomic dz2 Orbitals 

• Atomic fxz2|xy2|x(x2-3y2)|y(3x2-y2) Orbitals 

• Atomic fz3 Orbitals 

• Hybrid sp3 Orbitals 

• Hybrid sp Lobes 

• Bonding σ Orbitals 

• Bonding π Orbitals 

Orbitals are defined by two anchor points as 
shown in Figure 3.22. The first anchor point 
defines the center of the orbital while the 
second anchor point defines the extent of the 
orbital.

Figure 3.22: Orbital and Anchors

Placing Orbitals at Fixed Lengths and 
Angles
To place an orbital, perform the following 
steps:

1. Select an orbital tool by expanding any of 
the Orbital group button in the Orbitals 
toolbar.

2. Press the mouse down on the Doodle 
Board to set the center of the orbital.

3. Drag the mouse to preview the placement 
of the extent of the orbital. A dotted green 
outline of the orbital will be shown.

4. Release the mouse to set the orbital.

You can also click the mouse to set the start 
center then move the mouse and click again 
to set the extent.

In step 2, you may want to attach the orbital 
to an atom or bond center. ChemDoodle will 
automatically lock onto atoms and bonds 
when placing orbitals if the mouse pointer 
gets close enough to them. Once the atom or 
bond has been highlighted, continue through 
step two to place the orbital and set the center 
to be the atom or bond center.
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Placing Orbitals at Non-fixed lengths 
or Angles
To place lines at non-fixed lengths or angles, 
hold down the alt key while dragging the 
mouse when defining the orbital to break 
from the fixed lengths and angle orientations.

Forcing Orbitals to be Drawn Vertically 
and Horizontally
To place orbitals oriented vertically or 
horizontally, hold down the shift key while 
dragging the mouse when defining the orbital. 
The orbital preview will then automatically 
orient vertically or horizontally depending on 
the angle from the start point to the current 
mouse cursor position.

Moving Orbitals
To move orbitals, use a selection tool, either 
the lasso or the rectangular marquee. Make 
sure that no content is currently selected by 
emptying the current selection. Perform the 
following steps:

1. Hover the mouse pointer over the orbital 
so an open hand mouse cursor appears 
and the rectangle anchor points are drawn 
as shown in Figure 3.19.

2. Press the mouse down and drag to move 
the orbital.

3. Release the mouse to finish the move 
action.

Resizing Orbitals
To resize orbitals, use a selection tool, either 
the lasso or the rectangular marquee. Make 
sure that no content is currently selected by 
emptying the current selection. Perform the 
following steps:

1. Hover the mouse pointer over the orbital 
so an open hand mouse cursor appears 
and the orbital anchor points are drawn as 
shown in Figure 3.19.

2. Move the mouse pointer over one of the 
two end anchor points so that anchor point 
is filled in with an amber color.

3. Press the mouse down so the anchor point 
is filled with a blue color.

4. Drag the anchor point to resize the orbital.

5. Release the mouse to finish the resize 
action.

Removing Orbitals
Orbitals can be removed in a number of ways. 
You can do the following:

• Use a selection tool to hover the mouse 
pointer over the orbital so an open hand 
mouse cursor appears and the rectangle 
anchor points are drawn as shown in Figure 
3.19. Then press the backspace or delete 
key.

• Use the eraser tool to hover the mouse 
pointer over the orbital so the orbital anchor 
points are drawn. Then click with the 
mouse.
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Chapter 4: Shapes
Overview
In addition to chemical structures, 
ChemDoodle provides tools for drawing 
shapes for advanced figures.

This section introduces the new user to shapes 
within ChemDoodle. It covers the following 
topics:

• The different types of shapes.

• How to draw shapes.

• Adding arrows to figures.

• Adding text to figures.

• How to move shapes.

• How to resize shapes.

• How to remove shapes.

• What the anchor decorations mean.

Anchors
Anchors are points that define a given shape. 
By moving them, you modify how the shape 
appears. There are two types of anchors, 
control anchors and corner/edge anchors.

Control Anchors
Control anchors represent points that can be 
moved anywhere and have no relationship to 
other anchors, such as in lines, custom shapes 
or orbitals. They appear as compass shapes as 
shown in Figure 4.1.

Figure 4.1: Control anchors

Corner/Edge Anchors
Corner edge anchors define corners and edges 
of shapes. Moving these anchors will change 
the shape in relationship to the other anchors. 
For instance, if you move a left-right pointing 
anchor, you will not affect the vertical 
positioning of the other anchors. These 
anchors are present for box shaped objects, 
like rectangles and ovals. They appear as 
double sided arrows as shown in Figure 4.2.

Figure 4.2: Corner/Edge Anchors

Lines
Lines are the most basic shape and are 
defined by two anchors placed at their 
endpoints as shown in Figure 4.3. There is 
also a third anchor at the midpoint for 
controlling the arc angle. This anchor point is 
discussed in the next section (Arcs).

Figure 4.3: Line Shape and Anchors

Drawing Lines at Fixed Angles
To draw a line at fixed angles, perform the 
following steps:
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1. Select a line tool by expanding the Lines 
group button in the Shapes toolbar.

2. Press the mouse down on the Doodle 
Board to set the start point of the line.

3. Drag the mouse to preview the placement 
of the end of the line.

4. Release the mouse to set the line.

You can also click the mouse to set the start 
point then move the mouse and click again to 
set the end point.

By default, lines will be oriented at fixed 
angles every 15° starting at 0°.

Drawing Lines at Non-fixed Angles
To place lines at non-fixed angles, hold down 
the alt key while dragging the mouse when 
defining the line to break from the fixed 
orientation angles.

Forcing the Lines to be Drawn 
Vertically and Horizontally
To place lines oriented vertically or 
horizontally, hold down the shift key while 
dragging the mouse when defining the line. 
The line preview will then automatically 
orient vertically or horizontally depending on 
the angle from the start point to the current 
mouse cursor position.

Moving Lines
To move lines, use a selection tool, either the 
lasso or the rectangular marquee. Make sure 
that no content is currently selected by 
emptying the current selection. Perform the 
following steps:

1. Hover the mouse pointer over the line so 
an open hand mouse cursor appears and 
the anchor points are drawn as shown in 
Figure 4.3.

2. Press the mouse down and drag to move 
the line.

3. Release the mouse to finish the move 
action.

Resizing Lines
To resize lines, use a selection tool, either the 
lasso or the rectangular marquee. Make sure 
that no content is currently selected by 
emptying the current selection. Perform the 
following steps:

1. Hover the mouse pointer over the line so 
an open hand mouse cursor appears and 
the line anchor points are drawn as shown 
in Figure 4.3.

2. Move the mouse pointer over one of the 
two end anchor points so that anchor point 
is filled in with an amber color.

3. Press the mouse down so the anchor point 
is filled with a blue color.

4. Drag the anchor point to resize the line.

5. Release the mouse to finish the resize 
action.

Removing Lines
Lines can be removed in a number of ways. 
You can do the following:

• Use a selection tool to hover the mouse 
pointer over the line so an open hand mouse 
cursor appears and the line anchor points 
are drawn as shown in Figure 4.3. Then 
press the backspace or delete key.

• Use the eraser tool to hover the mouse 
pointer over the line so the line anchor 
points are drawn. Then click with the 
mouse.

Arcs
Arcs are segments of a circle and are defined 
by two anchors placed at their endpoints as 
shown in Figure 4.4. There is also a third 
anchor at the middle for controlling the arc 
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angle. Only 90°, 120°, 180° and 270° arcs are 
directly provided in the Arcs group button, 
but an arc of any angle can be drawn. The 
only difference between the line shape and 
the arc shape is the angle, and either shape 
can be converted into the other by changing 
this value.

Figure 4.4: Arc Shape and Anchors

Drawing Arcs at Fixed Angles
To draw an arc at fixed angles, perform the 
following steps:

1. Select an arc tool by expanding the Arcs 
group button in the Shapes toolbar.

2. Press the mouse down on the Doodle 
Board to set the start point of the arc.

3. Drag the mouse to preview the placement 
of the end of the arc.

4. Release the mouse to set the arc.

You can also click the mouse to set the start 
point then move the mouse and click again to 
set the end point.

By default, arcs will be oriented at fixed 
angles every 15° starting at 0°.

Drawing Arcs at Non-fixed Angles
To place arcs at non-fixed angles, hold down 
the alt key while dragging the mouse when 
defining the arc to break from the fixed 
orientation angles.

Forcing the Arcs to be Drawn 
Vertically and Horizontally
To place arcs oriented vertically or 
horizontally, hold down the shift key while 

dragging the mouse when defining the arc. 
The arc preview will then automatically 
orient vertically or horizontally depending on 
the angle from the start point to the current 
mouse cursor position.

Moving Arcs
To move arcs, use a selection tool, either the 
lasso or the rectangular marquee. Make sure 
that no content is currently selected by 
emptying the current selection. Perform the 
following steps:

1. Hover the mouse pointer over the arc so 
an open hand mouse cursor appears and 
the arc anchor points are drawn as shown 
in Figure 4.4.

2. Press the mouse down and drag to move 
the arc.

3. Release the mouse to finish the move 
action.

Resizing Arcs
To resize arcs, use a selection tool, either the 
lasso or the rectangular marquee. Make sure 
that no content is currently selected by 
emptying the current selection. Perform the 
following steps:

1. Hover the mouse pointer over the arc so 
an open hand mouse cursor appears and 
the arc anchor points are drawn as shown 
in Figure 4.4.

2. Move the mouse pointer over one of the 
two end anchor points so that anchor point 
is filled in with an amber color.

3. Press the mouse down so the anchor point 
is filled with a blue color.

4. Drag the anchor point to resize the arc.

5. Release the mouse to finish the resize 
action.
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Changing Arc Angles
Arc angles can be changed using the midpoint 
anchor. Choose a selection tool, either the 
lasso or the rectangular marquee. Make sure 
that no content is currently selected by 
emptying the current selection. Perform the 
following steps:

1. Hover the mouse pointer over the arc so 
an open hand mouse cursor appears and 
the arc anchor points are drawn as shown 
in Figure 4.4.

2. Move the mouse pointer over the middle  
anchor point so that it is filled in with an 
amber color.

3. Press the mouse down so the anchor point 
is filled with a blue color.

4. Drag the anchor point to change the arc 
angle.

5. Release the mouse to set the new arc 
angle.

While changing the angle of arcs, the arc 
angle will be displayed below the mouse 
cursor.

Flipping an Arcʼs Orientation
To flip an arc’s orientation, so that the curve 
faces the opposite direction. use a selection 
tool, either the lasso or the rectangular 
marquee. Make sure that no content is 
currently selected by emptying the current 
selection. Perform the following steps:

1. Hover the mouse pointer over the arc so 
an open hand mouse cursor appears and 
the line anchor points are drawn as shown 
in Figure 4.4.

2. Right-click on the hovered arc.

3. Select the Flip Arc menu item to flip the 
arc’s orientation.

You can also click and drag the midpoint to 
the other side of the arc to perform this task.

Removing Arcs
Arcs can be removed in a number of ways. 
You can do the following:

• Use a selection tool to hover the mouse 
pointer over the arc so an open hand mouse 
cursor appears and the arc anchor points are 
drawn as shown in Figure 4.4. Then press 
the backspace or delete key.

• Use the eraser tool to hover the mouse 
pointer over the arc so the arc anchor points 
are drawn. Then click with the mouse. 

Arrows
Arrows are essential in chemical graphics for 
many reasons, the most important being for 
reaction and mechanism diagrams. Arrows 
are so important that they have their own 
unique toolbar. Essentially, arrow shapes are 
just lines and arcs with arrowheads as shown 
in Figure 4.5.

Figure 4.5: Arrow Shape and Anchors

ChemDoodle also provides advanced features 
for building and defining reactions. Reactions 
are covered in Chapter 7.

Drawing Arrows at Fixed Angles
To draw an arrow at fixed angles, perform the 
following steps:

1. Select the desired arrowheads and 
connector styles in the Arrows toolbar.

2. Click on one of the arc angle buttons in 
the Arrows toolbar to enter the arrow 
placement mode.
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3. Press the mouse down on the Doodle 
Board to set the start point of the arrow.

4. Drag the mouse to preview the placement 
of the end of the arrow.

5. Release the mouse to set the arrow.

You can also click the mouse to set the start 
point then move the mouse and click again to 
set the end point.

By default, arrows will be oriented at fixed 
angles every 15° starting at 0°.

Drawing Arrows at Non-fixed Angles
To place arrows at non-fixed angles, hold 
down the alt key while dragging the mouse 
when defining the arrow to break from the 
fixed orientation angles.

Forcing the Arcs to be Drawn 
Vertically and Horizontally
To place arrows oriented vertically or 
horizontally, hold down the shift key while 
dragging the mouse when defining the arrow. 
The arrow preview will then automatically 
orient vertically or horizontally depending on 
the angle from the start point to the current 
mouse cursor position.

Moving Arrows
To move arrows, use a selection tool, either 
the lasso or the rectangular marquee. Make 
sure that no content is currently selected by 
emptying the current selection. Perform the 
following steps:

1. Hover the mouse pointer over the arrow 
so an open hand mouse cursor appears 
and the arrow anchor points are drawn as 
shown in Figure 4.5.

2. Press the mouse down and drag to move 
the arrow.

3. Release the mouse to finish the move 
action.

Resizing Arrows
To resize arrows, use a selection tool, either 
the lasso or the rectangular marquee. Make 
sure that no content is currently selected by 
emptying the current selection. Perform the 
following steps:

1. Hover the mouse pointer over the arrow 
so an open hand mouse cursor appears 
and the arrow anchor points are drawn as 
shown in Figure 4.5.

2. Move the mouse pointer over one of the 
two end anchor points so that anchor point 
is filled in with an amber color.

3. Press the mouse down so the anchor point 
is filled with a blue color.

4. Drag the anchor point to resize the arrow.

5. Release the mouse to finish the resize 
action.

Changing Arrow Arc Angles
Arrow arc angles can be changed using the 
midpoint anchor. Choose a selection tool, 
either the lasso or the rectangular marquee. 
Make sure that no content is currently 
selected by emptying the current selection. 
Perform the following steps:

1. Hover the mouse pointer over the arrow 
so an open hand mouse cursor appears 
and the arrow anchor points are drawn as 
shown in Figure 4.5.

2. Move the mouse pointer over the middle  
anchor point so that anchor point is filled 
in with an amber color.

3. Press the mouse down so the anchor point 
is filled with a blue color.

4. Drag the anchor point to change the arrow 
arc angle.
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5. Release the mouse to set the new arrow 
arc angle.

While changing the angle of arrow arcs, the 
arrow arc angle will be displayed below the 
mouse cursor.

NOTE: A few special arrow types, such as 
the retrosynthetic type, are straight, and 
you will not be able to change the arc 
angles for these types.

Removing Arrows
Arrows can be removed in a number of ways. 
You can do the following:

• Use a selection tool to hover the mouse 
pointer over the arrow so an open hand 
mouse cursor appears and the arrow anchor 
points are drawn as shown in Figure 4.5. 
Then press the backspace or delete key.

• Use the eraser tool to hover the mouse 
pointer over the arrow so the arrow anchor 
points are drawn. Then click with the 
mouse.

Editing Arrowheads
Arrowheads can be added/removed from the 
ends of the line shape. This can be done 
before they are drawn, with the Arrow 
toolbar, or afterwards by using the Format 
Arrow window.

There are several settings that control how 
arrowheads are drawn:

• Indented - When selected, the back end of 
the arrow will be indented in.

• Filled - When selected, the arrow will be 
filled in, otherwise it will just be an outline.

• Chevroned - When selected, the arrow will 
be drawn as a simple chevron.

• Length - This setting controls the length of 
the arrow head along the line.

• Angle - This setting controls the angle of 
the arrow, from one side to the other.

Use these settings to control how arrowheads 
are drawn.

NOTE: If the arrowhead length is greater 
than 50% of the length of the line it is on, 
then the length will be decreased to 50% of 
the length of the line it is on.

Rectangles
Rectangles can be drawn in several styles and 
are defined by two anchor points that 
correspond to a pair of rectangle corners 
along one of the diagonals as shown in Figure 
4.6.

Figure 4.6: Rectangle Shape and Anchors

Drawing Rectangles
To draw a rectangle, perform the following 
steps:

1. Select a rectangle tool by expanding the 
Rectangle group button in the Shapes 
toolbar.

2. Press the mouse down on the Doodle 
Board to set one corner of the rectangle.

3. Drag the mouse to preview the placement 
of the opposite corner along the diagonal 
of the rectangle.

4. Release the mouse to set the rectangle.

You can also click the mouse to set the start 
point then move the mouse and click again to 
set the end point.
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Drawing Squares
To draw squares, hold down the shift key 
while dragging the mouse when defining the 
rectangle to force the width and height to be 
equivalent.

Moving Rectangles
To move rectangles, use a selection tool, 
either the lasso or the rectangular marquee. 
Make sure that no content is currently 
selected by emptying the current selection. 
Perform the following steps:

1. Hover the mouse pointer over the 
rectangle so an open hand mouse cursor 
appears and the rectangle anchor points 
are drawn as shown in Figure 4.6.

2. Press the mouse down and drag to move 
the rectangle.

3. Release the mouse to finish the move 
action.

Resizing Rectangles
To resize rectangles, use a selection tool, 
either the lasso or the rectangular marquee. 
Make sure that no content is currently 
selected by emptying the current selection. 
Perform the following steps:

1. Hover the mouse pointer over the 
rectangle so an open hand mouse cursor 
appears and the rectangle anchor points 
are drawn as shown in Figure 4.6.

2. Move the mouse pointer over one of the 
anchor points so that anchor point is filled 
in with an amber color.

3. Press the mouse down so the anchor point 
is filled with a blue color.

4. Drag the anchor point to resize the 
rectangle.

5. Release the mouse to finish the resize 
action.

Converting Between Rounded and 
Non-rounded Rectangles
To change a rectangle into a rounded-
rectangle or vice versa, use a selection tool, 
either the lasso or the rectangular marquee. 
Make sure that no content is currently 
selected by emptying the current selection. 
Perform the following steps:

1. Hover the mouse pointer over the 
rectangle so an open hand mouse cursor 
appears and the arrow anchor points are 
drawn as shown in Figure 4.6.

2. Right-click on the hovered rectangle and 
select the Format Rectangle... menu 
item.

3. Scroll to the Rectangle section and use 
the  Rounded on/off choice to set the 
rectangle to be rounded or not.

Removing Rectangles
Rectangles can be removed in a number of 
ways. You can do the following:

• Use a selection tool to hover the mouse 
pointer over the rectangle so an open hand 
mouse cursor appears and the rectangle 
anchor points are drawn as shown in Figure 
4.4. Then press the backspace or delete key.

• Use the eraser tool to hover the mouse 
pointer over the rectangle so the rectangle 
anchor points are drawn. Then click with 
the mouse.

Ovals
Ovals can be drawn in several styles and are 
defined by two anchor points that correspond 
to a pair of rectangle corners along one of the 
diagonals that circumscribes the oval as 
shown in Figure 4.7.

Figure 4.7: Oval Shape and Anchors
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Drawing Ovals
To draw an oval, perform the following steps:

1. Select an oval tool by expanding the Oval 
group button in the Shapes toolbar.

2. Press the mouse down on the Doodle 
Board to set one corner of the 
circumscribing rectangle.

3. Drag the mouse to preview the placement 
of the opposite corner along the diagonal 
of the circumscribing rectangle.

4. Release the mouse to set the oval.

You can also click the mouse to set the start 
point then move the mouse and click again to 
set the end point.

Drawing Circles
To draw circles, hold down the shift key while 
dragging the mouse when defining the oval to 
force the major and minor axes lengths to be 
equivalent.

Moving Ovals
To move ovals, use a selection tool, either the 
lasso or the rectangular marquee. Make sure 
that no content is currently selected by 
emptying the current selection. Perform the 
following steps:

1. Hover the mouse pointer over the oval so 
an open hand mouse cursor appears and 
the oval anchor points are drawn as shown 
in Figure 4.7.

2. Press the mouse down and drag to move 
the oval.

3. Release the mouse to finish the move 
action.

Resizing Ovals
To resize ovals, use a selection tool, either the 
lasso or the rectangular marquee. Make sure 
that no content is currently selected by 
emptying the current selection. Perform the 
following steps:

1. Hover the mouse pointer over the oval so 
an open hand mouse cursor appears and 
the oval anchor points are drawn as shown 
in Figure 4.7.

2. Move the mouse pointer over one of the 
anchor points so that anchor point is filled 
in with an amber color.

3. Press the mouse down so the anchor point 
is filled with a blue color.

4. Drag the anchor point to resize the oval.

5. Release the mouse to finish the resize 
action.

Removing Ovals
Ovals can be removed in a number of ways. 
You can do the following:

• Use a selection tool to hover the mouse 
pointer over the oval so an open hand 
mouse cursor appears and the oval anchor 
points are drawn as shown in Figure 4.7. 
Then press the backspace or delete key.

• Use the eraser tool to hover the mouse 
pointer over the oval so the oval anchor 
points are drawn. Then click with the 
mouse.

Brackets
Brackets can be drawn in several styles and 
are defined by two anchor points that 
correspond to a pair of rectangle corners 
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along one of the diagonals that defines the 
bracket space as shown in Figure 4.8.

Figure 4.8: Bracket Shape and Anchors

There are currently 4 bracket styles:

• Square Brackets - [ ]

• Parenthesis - ( )

• Curly Brackets - { }

• Chevrons - < >

Drawing Brackets
To draw a set of brackets, perform the 
following steps:

1. Select a bracket tool by expanding the 
Bracket group button in the Shapes 
toolbar.

2. Press the mouse down on the Doodle 
Board to set one corner of the bracket.

3. Drag the mouse to preview the placement 
of the opposite corner along the diagonal 
of the bracket.

4. Release the mouse to set the bracket.

You can also click the mouse to set the start 
point then move the mouse and click again to 
set the end point.

Drawing Brackets with Equal Width 
and Height
To draw square brackets, hold down the shift 
key while dragging the mouse when defining 
the bracket to force the width and height of 
the bracket content to be equivalent.

Moving Brackets
To move brackets, use a selection tool, either 
the lasso or the rectangular marquee. Make 
sure that no content is currently selected by 
emptying the current selection. Perform the 
following steps:

1. Hover the mouse pointer over the brackets 
so an open hand mouse cursor appears 
and the bracket anchor points are drawn 
as shown in Figure 4.8.

2. Press the mouse down and drag to move 
the brackets.

3. Release the mouse to finish the move 
action.

Resizing Brackets
To resize brackets, use a selection tool, either 
the lasso or the rectangular marquee. Make 
sure that no content is currently selected by 
emptying the current selection. Perform the 
following steps:

1. Hover the mouse pointer over the brackets 
so an open hand mouse cursor appears 
and the bracket anchor points are drawn 
as shown in Figure 4.8.

2. Move the mouse pointer over one of the 
two end anchor points so that anchor point 
is filled in with an amber color.

3. Press the mouse down so the anchor point 
is filled with a blue color.

4. Drag the anchor point to resize the bracket 
set.

5. Release the mouse to finish the resize 
action.

Editing Bracket Lip Protrusion
To change the widths of the current bracket 
rendering style, use a selection tool, either the 
lasso or the rectangular marquee. Make sure 
that no content is currently selected by 
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emptying the current selection. Perform the 
following steps:

1. Hover the mouse pointer over the brackets 
so an open hand mouse cursor appears 
and the arrow anchor points are drawn as 
shown in Figure 4.8.

2. Right-click on the hovered rectangle and 
select the Format Bracket... menu item.

3. Scroll to the Bracket section and use the  
Wideness number slider to define how 
protruded bracket lips are rendered.

Removing Brackets
Brackets can be removed in a number of 
ways. You can do the following:

• Use a selection tool to hover the mouse 
pointer over the brackets so an open hand 
mouse cursor appears and the bracket 
anchor points are drawn as shown in Figure 
4.8. Then press the backspace or delete key.

• Use the eraser tool to hover the mouse 
pointer over the brackets so the bracket 
anchor points are drawn. Then click with 
the mouse.

Custom Shapes
In addition to the standard defined shapes 
previously discussed, ChemDoodle allows 
you to create custom shapes. Currently there 
are three types of custom shapes:

• Pen - The Pen tool  allows you to draw 
any shape by clicking and dragging an 
outline.

• Bezier Curve - The Bezier Curve tool  
allows you to draw a bezier curve by 
defining its control points.

• Polyline - The Polyline tool  allows you 
do draw any polygon shape that can be 
convex or concave.

Both pen paths and polylines can be open or 
closed and are defined by their control points, 
which the shape will pass through as shown 
in Figure 4.9.

Figure 4.9: Pen and Polyline Control Points

Bezier curves can be open or closed and are 
defined by a more complex set of control 
points as shown in Figure 4.10.

Figure 4.10: Bezier Control Points

Drawing with the Pen Tool
To draw a custom shape with the Pen tool, 
perform the following steps:

1. Select a Pen tool by expanding the 
Custom Shapes group button in the 
Shapes toolbar.

2. Press the mouse down on the Doodle 
Board to begin drawing.

99



3. Drag the mouse in an outline of the shape 
you would like.

4. Release the mouse to set shape.

ChemDoodle will automatically simplify your 
path for you and generate a cubic 
interpolation.

Drawing with the Polyline Tool
To draw a custom shape with the Polyline 
tool, perform the following steps:

1. Select the Polyline tool by expanding the 
Custom Shapes group button in the 
Shapes toolbar.

2. Press the mouse down on the Doodle 
Board to set the first point.

3. Move the mouse to location you prefer the 
next point to be placed.

4. Click to place the next point. Points will 
automatically connect to previous points.

5. Repeat steps 3 and 4 until finished.

6. Click on the first point drawn or double-
click the last point to complete the shape 
and set it.

Moving Pen Paths and Polylines
To move custom shapes, use a selection tool, 
either the lasso or the rectangular marquee. 
Make sure that no content is currently 
selected by emptying the current selection. 
Perform the following steps:

1. Hover the mouse pointer over the custom 
shape so an open hand mouse cursor 
appears and the control points are 
rendered as shown in Figure 4.9.

2. Press the mouse down and drag to move 
the custom shape.

3. Release the mouse to finish the move 
action.

Modifying Pen Paths and Polylines
You can move the control points that define 
pen paths and polylines. To do so, use a 
selection tool, either the lasso or the 
rectangular marquee. Make sure that no 
content is currently selected by emptying the 
current selection. Perform the following 
steps:

1. Hover the mouse pointer over the custom 
shape so an open hand mouse cursor 
appears and the control points are drawn 
as shown in Figure 4.9.

2. Move the mouse pointer over one of the 
control points that you desire to be moved 
so that control point is filled in with an 
amber color.

3. Press the mouse down so the control point 
is filled with a blue color.

4. Drag the control point to move it.

5. Release the mouse to finish.

Drawing with the Bezier Tool
Bezier curves are defined by pairs of control 
points. There is a main point which the curve 
passes through, and a second control point 
that describes the tangent of the line at the 
point that the curve passes through. To draw a 
bezier curve, perform the following steps:

1. Select the Bezier Curve tool by 
expanding the Custom Shapes group 
button in the Shapes toolbar.

2. Press the mouse down on the Doodle 
Board to set the first point.

3. Drag your mouse to set the paired control 
point that defines the tangent of the curve 
at the first point. The further from the first 
point you make this paired control point, 
the tighter the curve will hug the first 
point.
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4. Release the mouse to set the paired 
control point.

5. Move the mouse to location you prefer the 
next point to be placed that the curve will 
pass through.

6. Press the mouse down to place the next 
point. Points will automatically connect to 
previous points.

7. Drag your mouse to set the paired control 
point that defines the tangent of the curve 
at the second point. The further from the 
second point you make this paired control 
point, the tighter the curve will hug the 
second point.

8. Repeat steps 5 through 7 until finished.

9. Press the escape key to complete the 
shape and set it.

Modifying Bezier Curves
You can move the control points that define 
bezier curves in one of two ways. The first 
way is by following the same instructions as 
in the Modifying Pen Paths and Polylines  
section. The second is by using the Bezier 
Curve tool. Perform the following steps:

1. Select the Bezier Curve tool by 
expanding the Custom Shapes group 
button in the Shapes toolbar.

2. Move the mouse pointer over the bezier 
curve that you desire to be modified so 
that its control points are rendered.

3. Click on the bezier curve so that all of its 
control points are rendered as shown in 
Figure 4.10.

4. Hover over any of the control points so 
that an amber color fills the one you wish 
to move.

5. Press the mouse down and drag the 
control point to the new desired location.

6. Release the mouse to finish moving the 
control point.

Deleting Bezier Control Points
Only the control points that have the curve 
pass through them may be deleted. Deleting 
one of these control points will also remove 
the corresponding paired control point. To 
delete a bezier control point, perform the 
following steps:

1. Select the Bezier Curve tool by 
expanding the Custom Shapes group 
button in the Shapes toolbar.

2. Move the mouse pointer over the bezier 
curve that you desire to be modified so 
that its control points are rendered.

3. Click on the bezier curve so that all of its 
control points are rendered as shown in 
Figure 4.10.

4. Hover over the control point that you wish 
to remove so that it is filled in with an 
amber color.

5. Press the delete key to delete the control 
point.

Adding Arrows to Bezier Curves
To add arrows to bezier curves follow the 
same procedures as discussed for the Arrow 
shapes earlier in the Chapter. Just right click 
on the bezier curve after it is hovered, select 
the Format Bezier Curve... menu item, and 
define the arrow sections to your preference.

Closing and Opening Custom Shapes
To close or open a custom shape, use a 
selection tool, either the lasso or the 
rectangular marquee. Make sure that no 
content is currently selected by emptying the 
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current selection. Perform the following 
steps:

1. Hover the mouse pointer over the custom 
shape so an open hand mouse cursor 
appears and the arrow anchor points are 
drawn as shown in Figure 4.9.

2. Right-click on the hovered custom shape 
and select the Format Custom Shape... 
menu item.

3. Scroll to the Path or Bezier Curve 
section and use the Close on/off choice to 
set if the custom shape path is closed or 
not.

If closed, the custom shape can be filled in 
with a desired color.

Removing Custom Shapes
Custom Shapes can be removed in a number 
of ways. You can do the following:

• Use a selection tool to hover the mouse 
pointer over the custom shape so an open 
hand mouse cursor appears and the custom 
shape anchor points are drawn as shown in 
Figure 4.9. Then press the backspace or 
delete key.

• Use the eraser tool to hover the mouse 
pointer over the custom shape so the custom 
shape anchor points are drawn. Then click 
with the mouse.

Rulers
Rulers measure distances in 2 dimensions and 
are defined by two anchors placed at their 
endpoints as shown in Figure 4.11. There is 
also a third midpoint in the middle for 
controlling the arc angle. This anchor point is 
discussed in the next section.

Figure 4.11: Ruler Shape and Anchors

Drawing Rulers at Fixed Angles
To draw a ruler at fixed angles, perform the 
following steps:

1. Select a Ruler tool in the Shapes toolbar.

2. Press the mouse down on the Doodle 
Board to set the start point of the ruler.

3. Drag the mouse to preview the placement 
of the end of the ruler.

4. Release the mouse to set the ruler.

You can also click the mouse to set the start 
point then move the mouse and click again to 
set the end point.

By default, rulers will be oriented at fixed 
angles every 15° starting at 0°.

Drawing Rulers at Non-fixed Angles
To place rulers at non-fixed angles, hold 
down the alt key while dragging the mouse 
when defining the ruler to break from the 
fixed chain orientation angles.

Forcing Rulers to be Drawn Vertically 
and Horizontally
To place rulers oriented vertically or 
horizontally, hold down the shift key while 
dragging the mouse when defining the ruler. 
The ruler preview will then automatically 
orient vertically or horizontally depending on 
angle from the start point to the current 
mouse cursor position.

Automatically Measuring Object Width 
and Height
To measure the width and height of selected 
objects, perform the following procedure:
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1. Select the content to be measured using 
the selection tools.

2. Select the Width and Height menu item 
in the Measure> submenu in the Content 
menu.

Two rulers will be placed to measure the 
width and height of the selected content.

Automatically Measuring Object 
Diagonal
To measure the diagonal of selected objects, 
perform the following procedure:

1. Select the content to be measured using 
the selection tools.

2. Select the Diagonal menu item in the 
Measure> submenu in the Content 
menu.

A single ruler will be placed across the 
diagonal of the selected content.

Moving Rulers
To move rulers, use a selection tool, either the 
lasso or the rectangular marquee. Make sure 
that no content is currently selected by 
emptying the current selection. Perform the 
following steps:

1. Hover the mouse pointer over the ruler so 
an open hand mouse cursor appears and 
the anchor points are drawn as shown in 
Figure 4.11.

2. Press the mouse down and drag to move 
the ruler.

3. Release the mouse to finish the move 
action.

Resizing Rulers
To resize rulers, use a selection tool, either 
the lasso or the rectangular marquee. Make 
sure that no content is currently selected by 

emptying the current selection. Perform the 
following steps:

1. Hover the mouse pointer over the ruler so 
an open hand mouse cursor appears and 
the ruler anchor points are drawn as 
shown in Figure 4.11.

2. Move the mouse pointer over one of the 
two end anchor points so that anchor point 
is filled in with an amber color.

3. Press the mouse down so the anchor point 
is filled with a blue color.

4. Drag the anchor point to resize the ruler.

5. Release the mouse to finish the resize 
action.

Showing and Hiding Major and Minor 
Ticks
To show and hide ruler major and minor ticks, 
use a selection tool, either the lasso or the 
rectangular marquee. Make sure that no 
content is currently selected by emptying the 
current selection. Perform the following 
steps:

1. Hover the mouse pointer over the ruler so 
an open hand mouse cursor appears and 
the ruler anchor points are drawn as 
shown in Figure 4.11.

2. Right-click on the hovered ruler and 
select the Format Ruler... menu item.

3. Scroll to the Ruler section and use the  
Show Major Ticks and Show Minor 
Ticks on/off choices to set whether major 
and minor ticks are visible or not.

Changing the Measurement Unit
To change the ruler’s measurement unit, use a 
selection tool, either the lasso or the 
rectangular marquee. Make sure that no 
content is currently selected by emptying the 
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current selection. Perform the following 
steps:

1. Hover the mouse pointer over the ruler so 
an open hand mouse cursor appears and 
the ruler anchor points are drawn as 
shown in Figure 4.11.

2. Right-click on the hovered ruler and 
select the Format Ruler... menu item.

3. Scroll to the Ruler section and use the 
Unit drop down selection to select the 
unit to be displayed.

Removing Rulers
Rulers can be removed in a number of ways. 
You can do the following:

• Use a selection tool to hover the mouse 
pointer over the ruler so an open hand 
mouse cursor appears and the ruler anchor 
points are drawn as shown in Figure 4.11. 
Then press the backspace or delete key.

• Use the eraser tool to hover the mouse 
pointer over the ruler so the ruler anchor 
points are drawn. Then click with the 
mouse.

Text Areas
In addition to atom labels, you can also add 
blocks of text in text area objects. Text areas 
can have a border and can have a background, 
and can be resized to any dimension.

To place text areas, click on the Text Area 

tool  in the Shapes toolbar. You can place 
text areas and edit them just as you would 
Rectangle shapes. The text area is resizable 
and can have a border and background. It will 
not automatically fit its contained text.

When editing the text area, text format 
functions will be provided in a toolbar that 
appears above it as shown in Figure 4.12.

Figure 4.12: Editing a Text Area

To edit text areas, use the Text Area tool to 
click on an existing text area, or hover the 
text area using a selection tool and double-
click.
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Chapter 5: Editing 
Content
Overview
The most important feature of graphical 
editors is access to a robust set of content 
management tools.

This section introduces the new user to 
content management tools within 
ChemDoodle. It covers the following topics:

• Selecting content.

• Duplicating content.

• Editing content.

• Organizing content.

• Grouping content.

• Removing content.

Selecting Content
Content can be selected by using any of the 
selection tools. There are 3 types of selection 
tools provided in ChemDoodle:

• Lasso -  Define an arbitrary boundary 
that follows the mouse and selects any 
objects contained within.

• Rectangular Marquee -  Define a 
rectangle that selects any objects contained 
within.

• Lasso Only Shapes -  Define an 
arbitrary boundary that follows the mouse 
and selects only shape objects contained 
within.

These tools can be quite complex to learn, so 
we suggest you practice with them for a 
while.

Selected content will show an amber 
highlight and will be surrounded by an an 
animated amber outline as shown in Figure 
5.1.

Figure 5.1: Selected Content

The crawling ants animation can be turned off 
in the Preferences window under the 
General tab.

Selecting Individual Objects
To select an individual object, first select a 
lasso tool and make sure no content is 
currently selected. Then hover the object to 
be selected and click. The single object will 
then be selected.

Selecting Groups of Objects
To select groups of object, perform the 
following steps:

1. Select a lasso tool.

2. Click and drag to draw an outline with a 
lasso or to draw a rectangle with the 
rectangular marquee to surround all of the 
objects you would like to select.

3. Release the mouse to select the contained 
objects.

NOTE: It may be difficult to see the full 
bounds for some shapes, such as large text 
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areas with little text in them. If you have 
trouble selecting a shape, make sure to 
discover where its bounds are and draw the 
selection bounds around both anchors.

Select All
To select all content on a page, expand the 
Select submenu in the Content menu and 
press the All menu item. The keyboard 
shortcut to use this function is ctrl-A 
(command-A on Mac OS X).

Adding/Removing Individual Objects 
from a Selection
If a selection has already been made, you can 
add or remove an individual object from the 
selection. Hold down the alt key and hover 
the object to be added or removed and click 
the mouse. If that object was previously 
selected, it will be removed from the 
selection, otherwise it will be added to the 
selection.

Adding/Removing Groups of Objects 
from a Selection
If a selection has already been made, you can 
add or remove groups of objects from the 
selection. Hold down the shift key and hover 
the object to be added or removed and click 
and drag to draw an outline with a lasso or to 
draw a rectangle with the rectangular 
marquee to surround all of the objects you 
would like to select or deselect. Then release 
the mouse. Any objects contained within the 
new boundary will be removed from the 
selection if they were previously selected, 
otherwise they will be added to the selection.

Selecting Whole Molecules
Instead of surrounding an entire molecule 
with the selection tools to select it, the 
following techniques will allow you to select 
individual molecules:

• Using a selection tool, hold down both the 
alt and shift keys and then click on an atom 
or bond in the molecule.

• Press the tab key to navigate through 
molecules, selecting one at a time, starting 
at the last drawn molecule and then 
navigating through them chronologically.

Selecting Chemical Objects by 
SMARTS
SMARTS is single line, text-based query 
system for matching chemical objects, similar 
to how systems like regular expressions 
match text. You may find it very convenient 
to select content in files by SMARTS queries. 
To do so, perform the following steps:

1. Select the SMARTS... menu item in the 
Select> submenu in the Content menu.

2. A window will appear prompting you for 
the SMARTS query. Input your query 
here and press the Accept button.

Any content that matches the SMARTS string 
will then be selected.

Navigating Through Single Shapes
Instead of surrounding an entire shape with 
the selection tools to select it or clicking on 
the shape, you can also press the tab key 
while holding down the shift key to navigate 
through shapes, selecting one at a time, 
starting at the last drawn shape and then 
navigating through them chronologically.

Selecting Only Shapes
When figures are highly congested, it may be 
difficult to select shapes from surrounding 
structures. In this case, use the Lasso Only 
Shapes tool which will only recognize 
shapes. The Lasso Only Shapes tool works 
identically to the Lasso tool in every other 
way.
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Select the Inverse of the Current 
Selection
To select the inverse of the current selection 
on a page, expand the Select submenu in the 
Content menu and press the Inverse menu 
item.

Deselecting Objects
To deselect the current selection, perform one 
of the following actions:

• Move the mouse cursor away from the 
selection so that the lasso cursor icon 
appears. Then click the mouse.

• When the mouse cursor is within the current 
selection boundary, double-click the mouse.

• Press the Deselect menu item in the 
Content menu.

• Press the space key to deselect the current 
selection and return to the structure drawing 
mode.

Reselecting Objects
If you lost the current selection by mistake, 
you can reselect it by selecting the Reselect 
menu item in the Content menu.

Duplicating Content
Content in ChemDoodle can be duplicated on 
the Doodle Board in the current document or 
between separate documents through copy 
and paste actions. To have ChemDoodle 
objects copied and pasted correctly on the 
Doodle Board, make sure to keep 
ChemDoodle Collage enabled in the 
Preferences window under the Advanced 
tab.

Copy and Paste
To duplicate content, perform the following 
steps:

1. Select the content to be duplicated.

2. Press the Copy menu item in the Edit 
menu. The keyboard shortcut to use this 
function is ctrl-C (command-C on Mac 
OS X).

3. Press the Paste menu item in the Edit 
menu. The keyboard shortcut to use this 
function is ctrl-V (command-V on Mac 
OS X).

Cut and Paste
To duplicate content and remove the original, 
perform the following steps:

1. Select the content to be duplicated.

2. Press the Cut menu item in the Edit 
menu. The keyboard shortcut to use this 
function is ctrl-X (command-X on Mac 
OS X).

3. Press the Paste menu item in the Edit 
menu. The keyboard shortcut to use this 
function is ctrl-V (command-V on Mac 
OS X).

Organizing Content
ChemDoodle provides several tools for laying 
out content in the document.

Aligning
To align content relative to each other, 
perform the following steps:

1. Select the content to be aligned.

2. Expand the Align submenu in the 
Content menu and press the Left Edges, 
Horizontal Centers, Right Edges, Top 
Edges, Vertical Centers or Bottom 
Edges menu items.

Aligning by Bond
To align an entire molecule by a given bond, 
perform the following steps:

1. Hover the bond to align the molecule by.
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2. Press the up, down, left or right arrow 
keys to align the bond from its first to 
second constituent atom in the selected 
direction. This will rotate the entire 
molecule with the bond.

Centering
To center all content on the page, expand the 
Center submenu in the Content menu and 
press the All on Page menu item.

To center selected content on the page, 
perform the following steps:

1. Select the content to be centered.

2. Expand the Center submenu in the 
Content menu and press the Selection on 
Page, Selection Horizontally or 
Selection Vertically menu items.

Distributing
To distribute content across the document, 
perform the following steps:

1. Select the content to be distributed.

2. Expand the Distribute submenu in the 
Content menu and press the Horizontally 
on Page or Vertically on Page menu 
items.

To distribute content across the document 
using a buffer spacing that you provide, 
perform the following steps:

1. Select the content to be distributed.

2. Expand the Distribute submenu in the 
Content menu and press the Horizontally 
by Buffer Space... or Vertically by 
Buffer Space... menu items.

3. Input a buffer space value into the number 
field that appears.

4. Click the Accept button to perform the 
distribution.

Flipping
To flip content horizontally or vertically, 
perform the following steps:

1. Select the content to be flipped.

2. Expand the Flip submenu in the Content 
menu and press the Horizontally or 
Vertically menu items.

Flipping a Bond
You may wish to flip non-symmetrical bonds 
when you need it to face the other direction, 
such as when working with wedge bonds. 
There are a few quick ways to do so:

• Hover over the bond and press the f key to 
flip it.

• Hover the bond, right-click and select Flip 
Bond Orientation.

• Use the bond tool of that bond type and 
click on the bond after hovering it. 
ChemDoodle will detect the bond is being 
set to its current bond type and will instead 
flip the bond.

Placing in Grid

To place all content in a grid that covers the 
document, perform the following steps:

1. Select the Grid All on Page... submenu in 
the Content menu.

2. In the prompt that appears, select whether 
you  want to specify the grid dimensions 
by Columns or by Rows by choosing the 
corresponding selection from the drop 
down menu.

3. Input the dimension of the grid in the 
number field. The other dimension will be 
automatically calculated based on the 
number of objects being placed in the 
grid.

4. Select the Grid button.
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Stacking
Stacking will place all content on the page 
starting from the top-left of the document to 
the bottom-right, such that their visual bounds 
are separated by a small buffer and that all 
objects are within the page margins. To stack 
all content on the page, press the Stack All on 
Page menu item in the Content menu.

If content is ever placed outside of the page 
bounds, red strips will appear at the sides of 
the page that the content extends from. Click 
on the red strip to stack all of the content that 
extends from that side of the page back onto 
the page.

Framing Content
Content can be automatically framed with 
various different shapes. To frame objects, 
perform the following steps:

1. Select the objects to be framed using the 
selection tools.

2. Expand the Add Frame> submenu in the 
Content menu.

3. Select the type of frame to use.

The selected content will then be framed.

Editing Content
The selection area is context sensitive and 
you can click and drag on the various features 
of the selection to perform different actions.

Translating
To translate content, or move it on the page, 
perform the following steps:

1. Select the content to be translated.

2. Hover the mouse cursor over the selection 
so that an open hand cursor appears.

3. Press the mouse down so the mouse 
cursor turns into a closed hand cursor.

4. Drag the mouse to translate the content.

5. Release the mouse to finish the 
translation.

During the translation, the change in x 
position and change and y position will be 
displayed below the mouse cursor. You can 
disable this feedback in the Preferences 
window under the General tab.

Translating Horizontally or Vertically
If you hold the shift key down while 
translating will lock the content horizontally 
or vertically depending on where the mouse 
pointer is.

Duplicating Content
If you hold the shift and alt keys down while 
translating content, you will duplicate that 
content and it will be locked horizontally or 
vertically depending on where the mouse 
pointer is. To remove the lock, release the 
shift and alt keys.

Rotating
To rotate content, perform the following 
steps:

1. Select the content to be rotated.

2. Hover the mouse just outside the edge of 
the selection border so that the rotation 
cursor appears.

3. Press the mouse down and drag it to rotate 
the content.

4. Release the mouse to finish the rotation.

During the rotation, the rotation angle will be 
displayed below the mouse cursor. You can 
disable this feedback in the Preferences 
window under the General tab.
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To more precisely rotate content, perform the 
following steps:

1. Select the content to be rotated.

2. Expand the Rotate submenu in the 
Content menu and press the 90° CW, 90° 
CCW or 180° menu items.

To more precisely rotate content by an 
arbitrary angle, perform the following steps:

1. Select the content to be rotated.

2. Expand the Rotate submenu in the 
Content menu and press the Arbitrary... 
menu item.

3. Enter a degree value in the number field 
that appears and select whether the 
rotation should be done clockwise or 
counterclockwise.

4. Press the Rotate button to perform the 
rotation to the settings you provided.

Moving the Rotation Anchor
Sometimes you may not want to rotate 
content around its center, as is done by 
default. For instance, you may desire to rotate 
structures around an atom. This can be 
achieved by moving the rotation anchor that 
is initially found in the center of the selection.

To move the rotation anchor, perform the 
following steps:

1. Move the mouse over the rotation anchor 
so that the anchor fills in with an amber 
color and the mouse cursor changes to a 
resize cursor.

2. Press the mouse down and drag the 
rotation anchor to the desired position.

3. Release the mouse to set the new rotation 
anchor position.

Now all rotations will proceed around the 
new rotation anchor position.

When moving the rotation anchor, it will 
automatically lock on to atoms within the 
selection as you get close to them, aiding you 
in setting the rotation anchor over atom 
positions.

Scaling
To scale content, perform the following steps:

1. Select the content to be scaled.

2. Hover the mouse over one of the anchor 
points in the selection so that the mouse 
resize cursor appears.

3. Press the mouse down and drag the 
anchor to scale the content.

4. Release the mouse to finish the scale 
action.

While scaling, the x scale factor and y scale 
factor will be displayed below the mouse 
cursor. You can disable this feedback in the 
Preferences window under the General tab.

To preserve the width-to-height ratio while 
scaling content along the diagonals, just hold 
down the shift key while performing the 
above steps.

To precisely scale content, perform the 
following steps:

1. Select the content to be scaled.

2. Press the Scale... menu item in the 
Content menu.

3. Select whether to scale the content by 
dimension or bond length and then 
specify the rest of the settings.

4. Press the Scale button to scale the content 
to the settings you provided.
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Fonts
To change the fonts of atom labels and text 
based shapes, perform the following steps:

1. Select the atoms and shapes that you 
would like to change the fonts of.

2. Choose the font family, font size and font 
style in the Files + Formatting toolbar to 
change the fonts.

Drawing Aids
Drawing guides will help when precision is 
important. There are several categories of 
drawing guides, and each have their own 
benefit. Guides can be enabled and disabled 
in the Drawing Aids> submenu of the View 
menu.

Atom Aids
Two types of aids can be drawn for atoms:

• Orthogonal - Will show a horizontal and 
vertical line through the center of each atom 
to help with alignment.

• Circular - Will show a circle around each 
atom with radius equal to the current 
standard bond length to help with distances.

Bond Aids
A single type of aid can be drawn for bonds:

• Parallel - Will draw a line through each 
bond, parallel to its direction to help with 
extrapolation.

Ring Aids
Rings can be colored in with a different color 
corresponding to the size of the ring to help 
with perception.

Molecule Aids
Two types of aids can be drawn for 
molecules:

• Bounds - Will show a rectangle 
representing the bounds of each molecule to 
help with placement.

• Orthogonal - Will show a horizontal and 
vertical line through the center of each 
molecule to help with alignment.

Background Aids
Three types of aids can be drawn on the 
background:

• Crosshair - Will render a crosshair and grid 
to help with partitioning and aligning 
objects.

• Grid - Will render a grid at an interval that 
you specify to help with aligning objects.

• Margins - Will render the bounds for the 
margins.

Colors
There are two features in the Files + 
Formatting toolbar for changing the colors 
of content, the Color button and the Quick 
Colors button.

Color Button
The Color Button was specifically created in 
ChemDoodle to make it easy to quickly 
change the colors of groups of objects. There 
are eight colors defined the color button:

• Background

• Borders and Lines

• Bonds

• Fill

• Atom Labels

• Identifier Text

• Other Text

• Plots
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You may change these colors by clicking the 
thin rainbow button placed directly to the 
right of the Color Button. All objects drawn 
after choosing colors will conform to those 
choices. To change the colors of a group of 
objects to the current selection of colors, just 
select them and click the Color Button.

The Color Button will change its display 
colors to reflect the current settings. A 
breakdown of the sections of the Color 
Button is shown in Figure 5.2.

Figure 5.2: Color Button Layout

If you wish for a certain fill to be empty and 
to not be colored, then in the color chooser, 
click the Empty Color button for the desired 
fills to not be painted.

Quick Colors Button
The Color Button is powerful but is certainly  
not a quick way to change colors. To quickly 
change colors, just use the Quick Colors 
Button.

Just selected the content that you would like 
colors changed for, and press the quick colors 
button. All of the content will be changed to 
that color regardless of the content type.

If you click and hover (or drag) over the 
Quick Colors button, a palette will appear to 
select a new color. Drag the mouse pointer 
over one of the preset colors to select it and 

immediately change the selected content to 
that color.

You can also add custom colors to the last 
three rows of the Quick Colors palette. Just 
release your mouse over the circled plus icon 

 and release to show a color chooser. 
Choose the desired color and press the OK 
button to add it to the palette and change the 
currently selected content to that color.

The Quick Colors palette is shown in Figure 
5.3.

Figure 5.3: The Quick Colors palette.

Color Detection
When working with content that uses non 
standard colors, you may wish to detect what 
those colors are. To do this, expand the Quick 
Colors Button and release the mouse over 

the Detect Color button . Then hover 
over the color in the document you wish to 
detect and press the mouse down when that 
color is centered in the cursor. That color will 
be added to the Quick Colors Button for 
further use.

Color Chooser
The color chooser will be different on all 
platforms, with different templates to use to 
pick colors from. However, the ChemDoodle 
pinwheel color chooser will be present on all 
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platforms. The pinwheel color chooser is 
shown in Figure 5.3.

Figure 5.3: ChemDoodleʼs Pinwheel Color 
Chooser

The color selected can be seen in the preview 
bar at the bottom, with the hex value shown 
by default. You can also view the RGB value 
by enabling the Decimal RGB checkbox.

To select a color, just move the mouse pointer 
over the pinwheel until the color you would 
like to select is hovered, then click the mouse. 
You can also use the mouse wheel to scroll 
through colors.

If the pinwheel appears all black, you will 
need to increase the Brightness setting by 
moving the Brightness slider up. If the 
pinwheel appears all white, you will need to 
decrease the Saturation setting by moving the 
Saturation slider down.

Modifying the Z-order of 
Shapes
Occasionally, you may want to change how 
shapes are z-ordered with respect to each 
other and with respect to atoms and bonds. 
Shapes, by default, will always render behind 
atoms and bonds and will be z-ordered 
chronologically.

To modify the z-order of a shape, perform the 
following steps:

1. Hover the shape to change the z-order of.

2. Right-click on the shape.

3. Expand the Arrange submenu.

4. Select the Send Forward, Send 
Backward, Send to Front or Send to 
Back menu item depending on your 
preference.

To change if a shape is rendered in front of or 
behind atoms and bonds, perform the 
following steps:

1. Hover the shape to change the z-order of.

2. Right-click on the shape.

3. Expand the Arrange submenu.

4. Select the Place in Front of Structures 
or Place in Back of Structures menu 
item depending on your preference.

Grouping Content
Content in ChemDoodle can be grouped. 
Once grouped, you will no longer be able to 
edit the member objects individually. Any 
transformations performed on the group will 
affect all member objects.

Grouping can be nested, so groups can be 
grouped into further groups. Ungrouping is 
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not recursive, so ungrouping a group 
containing groups will leave those contained 
groups intact.

Grouping
To group content, perform the following 
steps:

1. Select the content to be grouped.

2. Press the Group menu item in the 
Content menu.

Ungrouping
To ungroup content, perform the following 
steps:

1. Select the groups to be ungrouped.

2. Press the Ungroup menu item in the 
Content menu.

Removing Content
Removing individual Objects
Individual objects can be removed by using 
the eraser tool to hover the object and then by  
clicking to remove it. Additionally, at any 
time, when an object is hovered, press the 
backspace or delete key.

Removing Groups of Objects
Groups of objects can be removed in a 
number of ways. You can do the following:

• Use a selection tool to select the content to 
be removed. Then press the backspace or 
delete key.

• First select the content to be removed. Then 
use the eraser tool to click on the Doodle 
Board.

• Select the eraser tool, then press the mouse 
down and drag over all of the content to be 
removed. Selected content will be 
highlighted. Then release the mouse to 
remove all highlighted objects. Dragging 

over content that has already been 
highlighted will de-highlight it.
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Chapter 6: 
Advanced 
Chemistry and 
Cheminformatics
Overview
ChemDoodle is powered by an advanced 
cheminformatics engine to perform several 
functions for creating graphics, such as ring 
perception and structure depiction. This 
engine allows for some very powerful 
functions to help you create your chemical 
graphics and to analyze the structures you 
draw.

This section introduces the new user to 
advanced structure functionality within 
ChemDoodle. It introduces the following 
topics:

• The cheminformatics algorithms 
implemented in ChemDoodle.

• How to use these functions to perform 
various advanced tasks.

• How to edit your structures in a more 
advanced way than described in Chapter 3.

• How to take full advantage of the functions 
provided in ChemDoodle.

Aromaticity
Aromaticity is detected based on the Hückel 
model. All rings are assumed to be planar. 
Any appropriately hybridized heteroatoms 
can be constituents in an aromatic ring.

Toggling between Kekulé and Circle 
Representations for Aromatics
To toggle between viewing aromatics in 
Kekulé form (with double bond lines) or with 
circles, perform the following steps.

1. Open the Preferences window.

2. Select the Rings tab under the Visuals 
tab.

3. Check or uncheck the Use Circles visual 
specification under the Aromatics section 
based on your preference.

Forcing Aromaticity
In rare cases, ChemDoodle may determine a 
ring to have no aromatic character when it 
should be aromatic for some purpose. To 
force a ring to be recognized as aromatic, 
change all of the ring bonds to Resonance 
bonds.

Calculating Covalent Bonds
Some chemical input read into ChemDoodle 
may not include bond topology such as PDB 
and XYZ files as well as some output from 
modeling programs. Instead of having to 
define the bonds by hand, ChemDoodle 
contains tools for deducing covalent bonds 
based on published covalent radii.

To deduce covalent bonds, perform the 
following steps:

1. Select the atoms that you would like 
covalent bonds deduced between.

2. Select the Calculate Covalent Bonds 
menu item from the Structure menu.

Covalent radii are a best fit from a large 
number of experimental covalent radii. In 
some cases, a bond distance from a file may 
be larger than the distance calculated by 
adding the corresponding element covalent 
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radii together and the bond will not be found. 
To address this, ChemDoodle multiplies all 
covalent radii by a scalar when deducing 
bonds. By increasing this multiplier, 
ChemDoodle will discover bonds at longer 
distances. You can change the radius 
multiplier in the Preferences window under 
the Functions tab.

Carbon Labels
By default, ChemDoodle draws skeleton 
figures where carbon labels are suppressed. 
Regardless, it may be necessary to show the 
carbon label for various reasons and this can 
be done easily for each atom or globally for 
all atoms. To affect this globally, change the 
following visual specification for the 
document style sheet in the Preferences 
window. For each atom, change the following 
visual specification in the atom’s Format 
window.

The atom Display Carbon Label visual 
specification has 4 options for displaying 
carbon labels:

• Always - always display the “C” for the 
carbon label.

• On Lone and Hidden - only display carbon 
labels on lone and hidden carbons.

• On Hidden - only display carbon labels on 
hidden carbons. (default)

• Never - never display “C” labels.

The default is On Hidden and only carbon 
atoms that are “hidden” between two bonds of 
the same bond order will have their label 
displayed as shown in Figure 6.1. 

Figure 6.1: Hidden carbon labels are shown.

Lone carbons are disconnected atoms and 
have no bonds attached.

In addition to manually changing this visual 
specification, there is a quick method 
provided to show/hide carbon labels. To 
quickly show individual carbon labels, 
perform the following steps:

1. Hover the carbon atom with label to be 
shown.

2. Right-click on the atom and select the 
Show Carbon Label menu item.

To hide the carbon label. Perform the same 
steps, but instead select the Hide Carbon 
Label menu item.

Terminal Carbon Labels
By default, all terminal carbon atoms will 
display labels. In some cases, these labels 
may clutter a diagram. To hide terminal 
carbon labels, uncheck the Show Terminal 
Labels visual specification in the Carbons 
section in the Atoms section in the Visuals 
section of the Preferences window.

Chemical Suppliers
Chemical suppliers for the structures you 
draw can be listed by performing the 
following steps:

1. Draw the structure you would like to 
search for.

2. Select the structure with a selection tool.

3. In the Structure menu, expand the 
Chemical Suppliers menu item.

4. Select the Substructure Match or Exact 
Match menu item depending on whether 
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you want to search for a substructure or 
exact match for the selected structure.

5. The ChemExper database will appear in 
your default browser with a listing of 
matches. Select the match to view the 
chemical suppliers.

The ChemExper database provides the 
supplier information and you must abide by 
their terms of use and any copyrights or 
disclaimers presented when using their 
service.

Chemical Warnings
ChemDoodle will check your structures for 
you and flag any questionable objects.

Warning Types
The following warnings are currently 
implemented:

• Improper Valency - It is unlikely that this 
element can have the current coordination 
number. Or the atom label is an 
abbreviation and the valency is 
overextended.

• Uninterpretable Label - ChemDoodle 
does not understand or interpret the text 
present in the atom label as chemically 
relevant.

• Unpublished Mass Number - This mass 
number is not found in ChemDoodle’s 
database of published isotopes for the 
element.

• Unpublished Oxidation State - The 
oxidation state of this atom is not found in 
ChemDoodle’s database of published 
oxidation states for the element.

• Sum of Bonds is not an Integer - The 
coordination number of this atom is not a 
whole number.

• Questionable Stereochemistry - The 
stereochemistry of this atom is 
questionable.

• Atom Overlaps Another - This pair of 
atoms has the same coordinates and will be 
perceived as a single atom in graphical 
output.

Disabling Warnings Globally
These warnings can be disabled individually 
in the Preferences window under the 
Warnings tab as shown in Figure 6.2. This 
tab also contains an option to disable the 
display of chemical warning explanations at 
the top-left of the document the warnings are 
present in.

Figure 6.2: Chemical Warnings

Disabling Warnings for a Single Atom
To disable warnings on a single atom, 
perform the following steps:

1. Hover the atom with the warning shown 
to be disabled.

2. Right-click on the atom and select the 
Ignore Warnings menu item.
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To reenable warnings for an atom that is 
ignoring warnings, just right-click on it after 
hovering it and select the Check for 
Warnings menu item.

Hiding Warnings from Rendering
Chemical warnings will never appear in any 
image output or printouts. 

If the warnings clutter the document while 
drawing, they can be easily suppressed by 
selecting the Hide Warnings menu item in 
the View menu.

Cleaning Structures
ChemDoodle can generate 2D and 3D 
coordinates for structures.

Optimizing Structures in 2D
If your structures do not have acceptable or 
aesthetic coordinates, ChemDoodle can clean 
them. To clean your structures, perform the 
following steps:

1. Select the structures to be cleaned.

2. Expand the Clean submenu in the 
Structure menu and select the 2D 
Optimization menu item.

ChemDoodle employs the published CCG 
algorithm for cleaning structures. This 
method is a statistical approach. Therefore, 
repeated applications of the function may 
produce different results. If you are not happy 
with the first result of the function, try it 
again, something better may be generated.

Distance Geometry Embedding
Distance geometry embedding sets 3D 
coordinates for a structure based on a 
regression of its bond distance matrix. This 
function works best on highly embedded 
structures such as fullerenes and carbon 
nanotubes. To use this method, perform the 
following steps:

1. Select the structures to generate 3D 
coordinates for by distance geometry 
embedding.

2. Expand the Clean submenu in the 
Structure menu and select the Distance 
Geometry Embedding menu item.

Preserving Stereochemistry
By default, structure cleaning will preserve 
stereochemical configurations. To disable 
this, deselect Clean Retains 
Stereochemistry in the Functions panel in 
Preferences.

Descriptors
ChemDoodle calculates a large number of 
molecular descriptors. The descriptors are 
currently categorized into 4 types: 
constitutional, topological, physicochemical 
and ADME.

Constitutional
Constitutional descriptors are based on the 
makeup of the molecule, such as atom counts 
and molecular formula. The following 
constitutional descriptors are provided:

• Atom Count - The number of atoms in a 
molecule.

• Bond Count - The number of bonds in a 
molecule.

• Degree of Unsaturation - The sum of all 
bond orders substracting 1 for each, plus the 
number of rings.

• Element Counts - The number of each 
element that is present in a molecule.

• Euler Facet Ring Count - The count of all 
Euler facets in a molecule. This is defined 
as all of the sides of the 3D shape that is 
created by expanding the 2D structure on a 
3D sphere.
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• Exhaustive Ring Count - The total number 
of graph cycles present in the molecule.

• Frèrejacque Number - The fundamental 
ring count. Also known as the cyclomatic 
number or the SSSR count.

• Frèrejacque Number - The fundamental 
ring count. Also known as the cyclomatic 
number or the SSSR count.

• Hydrogen Bond Acceptor Count - Counts 
the number of atoms with lone pairs capable 
of hydrogen bonding.

• Hydrogen Bond Donor Count - Counts all 
Nitrogens, Oxygens and Fluorines that have 
Hydrogens attached.

• Rotatable Bond Count - Counts all 
saturated bonds. Exceptions are Single 
bonds connected to Hydrogens or terminal 
atoms, Single bonds of amides, thioamides, 
sulphonamides and those connecting two 
hindered aromatic rings (having at least 
three ortho substituents).

• Total Electron Count - Counts all 
electrons in a molecule. Takes into account 
charges.

• Lightest Isotopic Mass - Calculates the 
lightest isotopic mass by summing the 
lightest isotope for each atom given its 
element.

• McGowan Characteristic Volume - 
Calculates the vdW volume with 
McGowan’s method.

• Molecular Mass - Calculates the molecular 
mass from atomic masses based on the 
IUPAC technical reports.

• Monoisotopic Mass - Calculates the 
monoisotopic mass from isotopic masses 
based on the IUPAC technical reports.

• Volume as a Sum of Atomic and Bond 
Contributions - Calculates the VABC 
vdW volume.

• Empirical Formula - Generates the 
empirical formula for the molecule. The 
empirical formula is just the molecular 
formula, where all element multiplicities 
have been divided by the greatest common 
denominator.

• Molecular Formula - Generates the 
molecular formula for the molecule in the 
form of CxHy... where ... denotes all other 
elements and their counts in alphabetical 
order. This is based on the Hill system, so if 
no carbon atoms are present, the hydrogen 
count will be in alphabetical order with the 
rest of the elements.

Topological
Constitutional descriptors are solely based on 
the connectivity between atoms in a molecule, 
such as a bond distance matrix. The following 
topological descriptors are provided:

• Centric Index - Calculates the Centric 
index for the molecule (Bonchev et al.).

• Diameter - Calculates the longest 
topological distance in a molecule.

• Hosoya Index - Calculates the Hosoya 
index for the molecule.

• Molecular Topological Index - Calculates 
the Molecular Topological index for the 
molecule (Schultz et al.).

• Platt Index - Calculates the Platt index for 
the molecule.

• Ring Complexity - Calculates the Ring 
Complexity for the molecule.

• Szeged Index - Calculates the Szeged index 
for the molecule.
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• Wiener Index - Calculates the Wiener 
index for the molecule.

• Zagreb Indices - First and second order 
calculations are supported. (Z1, Z2)

• Balaban Index - Calculates the Balaban 
index for the molecule.

• Bertz Complexity Index - Calculates the 
Bertz Complexity index for the molecule.

• Branching Index - Calculates the 
Branching index for the molecule. The 
Branching index is equivalent to 1χ.

• Chi Molecular Connectivity Indices - 
Indices from zeroth to third order are 
supported. Both simple and valence models 
are calculated. (0χ, 1χ, 2χ, 3χ, 0χv, 1χv, 2χv, 3χv)

• Fraction Molecular Framework - 
Calculates the Fraction Molecular 
Framework (fMF) ratio for the molecule.

• Harary Index - Calculates the Harary 
index for the molecule.

• Kappa Shape Indices - Indices from the 
first to third order are supported. Both 
simple and alpha models are calculated. (1κ, 
2κ, 3κ, 1κα, 2κα, 3κα)

• Superpendentic Index - Calculates the 
Superpendentic index for the molecule.

• Adjacency Matrix - Generates a matrix M 
of size AxA, where A is the number of 
atoms in the molecule. M(Ai, Aj) equals 1 if 
there is a bond connecting atoms i and j, 
and equals 0 otherwise.

• Bond Distance Matrix - Generates a 
matrix M of size AxA, where A is the 
number of atoms in the molecule. M(Ai, Aj) 
equals the the number of electrons shared 
between atoms i and j.

• Bond Electron Matrix - Generates a 
matrix M of size AxA, where A is the 
number of atoms in the molecule. M(Ai, Aj) 
equals the shortest bond distance between 
atoms i and j.

• Detour Matrix - Generates a matrix M of 
size BxA, where B is the number of bonds 
in the molecule and A is the number of 
atoms in the molecule. M(Bi, Aj) equals 1 if 
bond i contains atom j, and 0 otherwise.

• Incidence Matrix - Generates a matrix M 
of size AxA, where A is the number of 
atoms in the molecule. M(Ai, Aj) equals the 
longest bond distance between atoms i and 
j.

• Laplacian Matrix - Generates a matrix M 
of size AxA, where A is the number of 
atoms in the molecule. M(Ai, Aj) equals 1 if 
there is a bond connecting atoms i and j, 
and equals 0 otherwise. M(i,i) equals the 
number of bonds connected to atom Ai.

Physicochemical
Constitutional descriptors describe the 
physical or chemical properties of a molecule.  
These are estimations of their real physical 
values. The following physicochemical 
descriptors are provided:

• Average Molecular Polarizability - 
Estimates the average molecular 
polarizability. Both the average hybrid 
components (Miller) and average hybrid 
polarizabilities (Kang) methods are 
implemented.

• Critical Pressure - Estimates the critical 
pressure (Pc) of a substance based on 
Joback’s method.

• Critical Temperature - Estimates the 
critical temperature (Tc) of a substance 
based on Joback’s method.
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• Critical Volume - Estimates the critical 
volume (Vc) of a substance based on 
Joback’s method.

• Enthalpy of Formation - Estimates the 
enthalpy of formation (ΔH0f,298) of a 
substance (ideal gas at 298K) based on 
Joback’s method.

• Enthalpy of Fusion - Estimates the 
enthalpy of fusion (ΔHf) of a substance 
based on Joback’s method.

• Enthalpy of Vaporization - Estimates the 
enthalpy of vaporization (ΔHvb) of a 
substance (at Tb) based on Joback’s method.

• Gibbs Energy of Formation - Estimates 
Gibbs energy of formation (ΔG0f,298) of a 
substance (ideal gas, unit fugacity, at 298K) 
based on Joback’s method.

• Heat Capacity - Estimates the heat 
capacity(C0p) of a substance (ideal gas) 
based on Joback’s method.

• Lipophilicity, logP - Estimates the octanol/
water partition coefficient (logP) of a 
substance. The NC+NHET, AlogP98, and 
XlogP v2.0 (Wang) algorithms are 
implemented.

• Liquid Viscosity - Estimates the liquid 
viscosity (ηL) of a substance (at 298K) 
based on Joback’s method.

• Molar Refractivity - Estimates the molar 
refractivity of a substance. Both the CMR3 
and AMR algorithm are implemented.

• Normal Boiling Point - Estimates the 
normal boiling point (Tb) of a substance 
based on Joback’s method.

• Normal Freezing Point - Estimates the 
normal freezing point (Tf) of a substance 
based on Joback’s method.

• Topological Polar Surface Area - 
Estimates the topological polar surface area 
(TPSA) of a molecule with the algorithm 
developed by Ertl et al.

ADME
Descriptors that rank bioactivity of drugs 
(ADME stands for absorption, distribution, 
metabolism, and excretion):

• Bioavailability Score - Calculates the 
bioavailability score (Martin).

• Egan Violations Count - Calculates the 
number of violations to Egan’s rules.

• Lipinski’s Rule of 5 Violations Count - 
Counts the number of violations to 
Lipinski’s rule of 5.

• Veber Violations Count - Calculates the 
number of violations to Veber’s rules.

Flattening Atomic Coordinates
In cases where imported chemical data 
contains 3D coordinates, you can set all the z-
coordinates to 0 by selecting that content and 
choosing the Flatten menu item in the 
Content menu.

Fragmentation
ChemDoodle contains several functions for 
fragmenting molecules with various results. 
The fragmentation functions can be found in 

the Content toolbar .

There are three fragmentation functions:

• Molecular Weight -  The molecules 
will be fragmented and each fragment will 
have a molecular weight assigned.

• Synthesis -  The molecules will be 
fragmented and each fragment will be set as 
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a reactant in a synthetic reaction leading to 
the original molecules.

• Retrosynthesis -  The molecules will 
be fragmented and each fragment will be set  
as a product in the retrosynthetic reaction 
resulting in the original molecules.

To fragment a molecule or group of 
molecules, perform the following steps:

1. Select the desired fragmentation function 
in the Content toolbar.

2. Press the mouse down and drag over all 
the bonds to be removed, defining how 
the molecule is fragmented.

3. Release the mouse to complete the 
function.

Formal Charges
While you can place charges on atoms 
manually, ChemDoodle can also guess the 
formal charges for a structure. To have 
ChemDoodle guess formal charges for a 
structure, perform the following steps:

1. Select the atoms for which formal charges 
are to be guessed.

2. Choose the Place Formal Charges menu 
item in the Structure menu.

Glassware Clipart
Figures for glassware setups can be created 
by using the glassware clipart library within 
ChemDoodle.

To build glassware setups, perform the 
following steps:

1. Click on the Laboratory Glassware 
button in the Shapes toolbar.

2. In the window that appears, select a 
glassware piece that you would like to 
place into your figure.

3. Press the mouse down on the current 
document and drag to place it where you 
prefer the piece to be placed. Hold down 
the shift key to flip the template 
horizontally while placing.

4. Release the mouse to set the glassware 
piece.

5. Repeat steps 2-4 until your figure is 
complete.

It may prove necessary to be conscious of the 
order in which you place the glassware pieces 
in the figure, in order to show some piece 
over another.

Keep in mind that each template is a complete 
image, and it is not possible to show one 
piece in between the front and back of 
another piece. However, you may export your 
figure to be post-edited in vector editing 
software (such as Adobe Illustrator) to 
achieve this effect.

All glassware clipart is governed by the same 
visual specifications that other shapes are. So 
you can change the stroke thickness and the 
colors of the various components in the 
clipart as shown in Figure 6.3.

Figure 6.3: A glassware setup with altered colors.
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Flipping Glassware
To flip the clipart graphics, just hold down the 
shift key while placing them. The preview 
will then show you the flipped graphic.

You can also manually edit whether a clipart 
is flipped or not by right-clicking on it with 
nothing selected, selecting the Format 
Clipart... menu item and then changing the 
Flip on/off choice in the Clipart section.

Tubing
You may wish to connect pieces of glassware 
via tubing. A good technique for doing this is 
by using the Bezier Curve tool to draw the 
path of the tubing, and then increasing the 
stroke width of the path to the desired 
thickness.

One method for doing so is as follows:

1. Select the Bezier Curve tool in the 
Shapes toolbar.

2. Press the mouse down in the middle of the 
outlet in the glassware figure where the 
first tubing connection will be made.

3. Drag the mouse out in the direction that 
the first outlet faces. The longer you drag 
out the control point, the longer the curve 
will be straight at that point.

4. Press the mouse down in the middle of the 
outlet in the glassware figure where the 
second tubing connection will be made.

5. Drag the mouse out in the direction that 
the second outlet faces. The longer you 
drag out the control point, the longer the 
curve will be straight at that point.

6. Edit the bezier curve if necessary, or press 
the escape key to finish drawing the 
curve.

7. Hover the curve using a selection tool and 
right-click, selecting the Format Bezier 
Curve... menu item.

8. In the Strokes section of the settings 
window that appears, change the 
Thickness setting to 10 pixels.

9. Select the Done button to close the 
settings window.

Your completed figure will then contain a 
nice smooth curve connecting the outlets that 
represents tubing as shown in Figure 6.4.

Figure 6.4: Glassware figure containing tubing
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Graph Reduction
To reduce molecule graphs, perform the 
following steps:

1. Select the structure with the graphs you 
would like to be reduced.

2. Expand the Graph Reduction submenu 
in the Structure menu and select the 
preferred reduction method.

Reduce 0° (Lone)
Will remove all selected atoms that have no 
bonds attached.

Reduce 1° (Terminals)
Will remove all selected atoms that have only 
1 bond attached to them. This process will 
stop after the first iteration.

Repeatedly Reduce 1°
Will remove all selected atoms that have only 
1 bond attached to them. This process will 
continue until it has pruned all terminal 
chains from the selection.

Reduce 1° + 0°
Will remove all selected lone and terminal 
atoms.

Reduce 2° (Chains)
Will remove all chains from a molecule, 
leaving single bonds connecting any 
remaining 3° atoms.

Reduce 2° + 1° + 0°
Will remove all lone, terminal and chain 
atoms, leaving a simplified core that 
represents the embedded ring structure of a 
graph.

Hydrogens
Hydrogens do not need to be drawn on 
structures as they are implicitly declared. At 
any time, Hydrogens can be added to a 
structure as text in atom labels or as atoms 
with bonds attached.

Implicit Hydrogen Rendering
By default, implicit hydrogens are 
automatically rendered on any element labels 
that are visible.

To disable the auto-rendering of implicit 
hydrogens, uncheck the Show Implicit 
Hydrogens visual specification in the 
Hydrogens section of the Atom section of 
the Visuals tab in the Preferences window.

You can also disable the auto-rendering of 
implicit hydrogens for a specific atom by 
performing the following steps:

1. Hover the atom with implicit hydrogens 
to remove.

2. Right-click on the atom.

3. Select the Hide Implicit Hydrogens 
menu item.

This will stop the auto-rendering of implicit 
hydrogens on that atom. To restore the 
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implicit hydrogen auto-rendering, just follow 
the same steps as above, but choose the Show 
Implicit Hydrogens menu item.

Adding Hydrogens as Atoms
To add hydrogens to a structure as atoms as 
shown in Figure 6.5, perform the following 
steps:

1. Select the structure to add hydrogens to.

2. Expand the Add/Remove Hydrogens 
submenu in the Structure menu and 
select the From Selection menu item.

Figure 6.5: Hydrogens added as atoms

Adding Hydrogens as Text
To add Hydrogens as text into atom labels as 
shown in Figure 6.6, change the Add as 
setting in the Hydrogens section in the 
Preferences window, under the Visuals tab, 
under the Atoms tab to Text. Now when using 
the Add/Remove Hydrogens functions, 
hydrogens will be explicitly added as text.

Figure 6.6: Hydrogens added as text

Defining when Hydrogens are Added 
to Carbons
You can modify how hydrogens are added to 
carbon atoms: whether they are always added, 
only added to unsaturated carbons or never 
added to carbons. These options are presented 
in the Preferences window, under the Visuals 
tab, under the Atoms tab in the Carbons 
section.

IUPAC Naming
Currently only generating a structure from an 
IUPAC name is supported.

Name to Structure
To parse an IUPAC name and generate a 
chemical structure, perform the following 
steps:

1. Select the Parse IUPAC Name... menu 
item from the Structure menu.

2. In the prompt that appears, input the 
IUPAC name and select the Accept 
button.

The generated structure will then be placed in 
the document.

Kekulé Structures
ChemDoodle contains a function for 
assigning Double bonds to a structure such 
that pi electron delocalization is maximized. 
Both frames of Single bonds and 
substructures consisting of only Resonance 
bonds can be affected.

Kekulizing a Single Bond Frame
To easily draw Kekulé structures, you may 
begin by just drawing a Single bond frame. 
This way, ChemDoodle can optimally assign 
Double bonds to the structure. If there are 
other bond types present, ChemDoodle will 
not Kekulize the structure. However, the 
Saturate function in the Structure menu will 
change all bond types to Single bonds.

To Kekulize a structure of only Single bonds, 
perform the following steps:

1. Select the structure containing only Single 
bonds to be Kekulized.

2. In the Structure menu, select the 
Kekulize menu item.
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For example, corannulene is generated from a 
Kekulization of a Single bond frame in Figure 
6.7.

Figure 6.7: Kekulizing a Single bond frame to 
generate corannulene.

Kekulizing a Substructure of 
Resonance Bonds
In some cases, structures may be read in with 
Resonance bonds. It may be necessary to 
present a Kekulé structure instead of the 
resonance model. When Kekulizing a 
structure with Resonance bonds, only those 
Resonance bonds will be affected.

To Kekulize a substructure of Resonance 
bonds, perform the following steps:

1. Select the structure containing the 
substructure of Resonance bonds to be 
Kekulized.

2. In the Structure menu, select the 
Kekulize menu item.

For example, the aromatic rings in Viagra are 
Kekulized in Figure 6.8.

Figure 6.8: Kekulizing the aromatic rings in the 
resonance model for Viagra.

Delocalizing a Kekulé Structure
You can also perform the reverse reaction and 
delocalize a Kekulé structure. Do this by 
selecting the content to delocalize and select 

the Delocalize menu item in the Structure 
menu.

Label Expansion
Atom labels can be much more than just an 
element symbol. They may contain implicit 
hydrogens or chemical shorthand notations or 
abbreviations. ChemDoodle can expand these 
condensed labels to their all atom models.

Expanding Labels
To expand labels, perform the following 
steps:

1. Select the atoms with labels to be expanded 
using any of the selection tools.

2. Select the Expand Labels menu item in 
the Structure menu.

Implicit Hydrogens
Implicit hydrogens can be presented as text in 
an atom label. They may be added 
automatically, can be added manually using 
the Atom Label tool or globally using the 
Add/Remove Hydrogens function with the 
appropriate visual specifications set.

When expanded, implicit hydrogens are 
ignored. So the label NH2 will become a N 
label when expanded.

Condensed Labels
Chains and functional groups may be denoted 
with a condensed label. For instance, a 
carboxy group may be denoted by a COOH 
atom label or an ethyl group may be denoted 
by CH2CH3.

When expanded, condensed labels will be 
replaced by the all atom model of the 
fragment as shown in Figure 6.9.

Figure 6.9: Left a molecule with condensed atom 
labels; right the corresponding expanded 
structure.
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Several constructs are supported by the 
condensed interpreter in ChemDoodle:

1. Linear Chains - Stringing elements 
together will place them in a chain, so 
CCCC or CH2CH2CH2CH3 denotes a n-
butyl group.

2. Multiple Attachments - Using parenthesis 
will denote multiple attachments, so the 
label C(CH3)3 will denote a t-butyl group.

3. Single and Double Bonds - If no bonds 
are placed between elements, then Single 
bonds are used to connect them. The - 
(minus) character will also specify a Single 
bond connection and the = (equals) 
character will specify a Double bond 
connection. Therefore, CC and C-C both 
specify an ethyl group while C=C will 
specify an vinyl group.

Abbreviations
In addition to condensed formulas, 
abbreviations can be used to define fragments 
in atom labels. For instance, the Ph 
abbreviation defines a phenyl group. All 
supported abbreviations are listed in the 
Symbols widget in the Abbreviations section.

When expanded, abbreviations will be 
replaced by the all atom model they define as 
shown in Figure 6.10.

Figure 6.10: Left a molecule with abbreviations; 
right the corresponding expanded structure.

ChemDoodle can only expand abbreviations 
that represent discrete molecules, monovalent 
or divalent fragments. ChemDoodle will 
attempt to interpret abbreviations properly 
based on their valency. For instance, the CO2 
abbreviation with a valency of 0 is a carbon 
dioxide molecule while that same label with a 
valency of 2 denotes a ester group.

Adding Custom Abbreviations
Custom abbreviations can be added by 
performing the following steps:

1. Select the Add New... menu item in the 
Abbreviations submenu of the Structure 
menu.

2. Type the abbreviation label to be used in 
atom labels in the Abbreviation Label text 
field.

3. Type the full name of the abbreviation in 
the Full Description/Name text field.

4. Provide the SMILES string for the full 
atom model of the abbreviation in the 
SMILES for Abbreviation text field. If the 
valency of the abbreviation is greater than 
0, then the attachment atom is the first 
atom defined by the SMILES string. If 
the abbreviation is divalent, then the last 
atom defined in the SMILES string will 
be used as the second attachment atom.

5. Select the valency of the abbreviation 
using the Valency drop down selection.

6. Press the Add button to add the new 
abbreviation.

ChemDoodle will update to recognize the 
added abbreviation and when used, that 
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abbreviation will be expanded to the 
SMILES string defined.

Mixing Condensed Notations and 
Abbreviations
Abbreviations and condensed notations can 
be combined. So the atom label CPh3 will 
denote a triphenylmethyl group.

Molecular Formulas
Sometimes you may intend to input a 
molecular formula into an atom label, to 
calculate a molecular weight, for instance. If a 
molecular formula is input, then ChemDoodle 
will associate that atom with an isomer of the 
molecular formula, as best as it can as shown 
in Figure 6.11. So your calculations of weight 
will be correct, but other calculations will 
have to be met with scrutiny. For accurate 
calculations, make sure to draw a correct 
structure or structural formula.

Figure 6.11: ChemDoodle expands a molecular 
formula to an isomer all atom model as best as it 
can.

Newman Projections
To build graphics for Newman Projections, 
perform the following steps:

1. Draw a 2-methylpropane structure.

2. Hover the central atom and right-click.

3. Select the Show Carbon Label menu 
item.

4. Again, hover the central atom and right-
click.

5. Select the Format Atom... menu item.

6. In the Elements section, select the Use 
Circles checkbox, make sure Coloring is 
set to User Chosen and Radius 
Convention is set to Constant, and then 
set the Constant Radius to the preferred 
size. You will now see a black circle 
appear over the central carbon.

7. Still in the Atom Settings window, under 
the Colors section, change the Text Color 
to white. You should now see a figure just 
like Figure 6.12.

Figure 6.12: A half completed Newman Projection.

8. Click on the Done button exit the Atom 
Settings window.

9. Draw a second 2-methylpropane structure.

10. Rotate the second structure to the desired 
torsion for the Newman Projection.

11. Using a lasso tool, move the second 
drawn structure over the first to complete 
the Newman Projection.

Figure 6.13: A finished Newman Projection.

You can then edit the terminal labels to 
display the structure desired as is shown in 
Figure 6.13. It may be convenient to save a 
copy of this structure as a file for later use.

Ring Perception
Rings are cycles of atoms and are important, 
because ChemDoodle uses them to define 
graphics such as which direction double 
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bonds face and calculations such as 
aromaticity detection. There are several 
published algorithms to define rings in 
structures producing different ring sets.

Supported Ring Sets
Currently, ChemDoodle can perceive the 
following sets:

• Smallest Set of Smallest Rings - The 
smallest set of smallest rings (SSSR) is the 
standard for defining ring sets in flat 2D 
structures.

• Euler Facet Rings - The Euler facet ring 
set is better than the SSSR at defining 
essential rings in 2D depictions of 3D 
structures. It is defined by all the rings that 
make up the faces of a 3D object when the 
2D chemical graph is placed on a 3D 
sphere.

• Hanser (All) Rings - Every last graph cycle 
in selected structures.

Exploding Ring Sets
Ring sets can be exploded from the structure. 
In other words, they will be laid out around 
the structure to show the rings and where they 
are contained. To explode ring sets, perform 
the following steps:

1. Select the structures with the rings to be 
exploded.

2. Expand the Rings submenu in the 
Structure menu and select the Explode 
Smallest Set of Smallest Rings, Explode 
Euler Facet Rings or Explode Hanser 
(All) Rings menu items.

In very complex structures, the exploded ring 
diagram will be highly overlapped. Just stack 
the rings (in the Content menu) to view them 
all clearly.

Performance Considerations
If dealing with heavily embedded structures, 
such as zeolites or MOFs, the algorithms may 
become very cpu intensive. In these cases, 
you can disable deep searching for rings by 
selecting Ring Search Cutoff in the 
Functions panel in Preferences.

Sequence Tool
ChemDoodle provides a tool for generating 
sequence structures for common polymer 
types. The following polymer types are 
supported:

1. Three Letter Amino Acid Sequence

To generate sequences, use the Sequence tool 

 in the Shapes toolbar. To draw a 
sequence, perform the following steps:

1. Click on the current document where you 
want the sequence to originate from. The 
endpoints of the sequence will appear. For 
amino acid sequences, a water molecule 
will appear.

2. A single atom will be surrounded by a 
blue circle; this is the appending atom. All 
changes to the sequence append directly 
to this atom. You can hover over other 
atoms and click to set a new appending 
atom.

3. Use the keyboard to type the one letter 
hotkeys for the residues in the sequence 
set. For instance, pressing the A key will 
append an Alanine residue, and pressing 
the R key will append an Arginine residue.

Sequences will automatically wrap to stay 
within the margins of the current document as 
shown in Figure 6.14.

Figure 6.14: A wrapped sequence for Crambin.
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Use this tool to easily create macromolecular 
structures, and to quickly calculate properties 
such as weights and isotopic distributions.

Stereochemistry
The stereochemistry of chiral centers and 
double bonds can be determined by selecting 
the Stereochemistry functions located in the 
Structure menu. An Attribute object will be 
associated with the stereocenter to denote the 
stereochemical configuration. Several 
conventions can be used. Centers can be 
forced into a particular configuration in 
addition to determining the configurations 
based on the 2D layout.

Chiral Centers
Cahn-Ingold-Prelog (CIP) priority rules are 
used to resolve rectus (R) and sinister (S) 
enantiomers.

Forcing a configuration will interchange the 
protruding and recessed bonds, if necessary. 
If only single bonds are present, then the 
appropriate wedge bonds will be placed when 
a configuration is forced.

Double Bonds
CIP priority rules are used to resolve 
entgegen (E) or zusammen (Z) configurations 
around double bonds. The less systematic cis/
trans conventions can also be used to define 
olefin enantiomers. The E/Z system will work 
for any double bond presented, while the cis/
trans conventions will not return results in 
ambiguous cases.

Forcing Double bond stereochemistry will 
flip both substituents on one atom's side of 

the double bond through the double bond 
axis, if necessary.

Resolving Stereochemistry
To resolve stereochemistry for structures, 
perform the following steps:

1. Select the structures or parts of structures 
with stereocenters to be resolved with the 
selection tools.

2. Expand the Stereochemistry> submenu 
in the Structure menu.

3. Choose the appropriate Assign menu item 
to resolve stereocenters of that type.

You may also access these functions through 
the right-click menu.

Forcing Stereochemical 
Configurations
To force a stereochemical configuration on an 
atom or bond, perform the following steps:

1. Hover the atom or bond on which the 
configuration will be forced.

2. Right-click on the hovered object.

3. If that object is a potential stereocenter, 
then the Stereochemistry> submenu will 
be present. Expand this submenu.

4. Choose the appropriate Force menu item 
to force the configuration.

Structure Perspective
Even though ChemDoodle generates graphics 
for structures in two dimensions, the 
underlying structures are defined in three 
dimensions.

ChemDoodle will read in 3D coordinates 
from all chemical files and provides functions 
for rotating structures in 3D.
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NOTE: While ChemDoodle has some 3D 
editing features, it is not a molecular 
modeler and is not the appropriate choice 
to build 3D coordinates for structures.

To rotate structures in 3D, perform the 
following steps:

1. Select the structures to be rotated in 3D 
using the selection tools.

2. Select the Rotate in 3D tool  in the 
Content toolbar.

3. Click the mouse down and drag to rotate 
the structure in 3D.

4. Release the mouse to finish the action.

By default, mouse movements while rotating 
structures in 3D will rotate the structure 
around the x and y axes based on horizontal 
and vertical movement respectively. You can 
also set the 3D rotations to be defined by a 
quaternion trackball in the Preferences 
window under the General tab.

Just like when rotating structures in 2D, there 
will also be a rotation anchor present during 
3D rotation. Before selecting the 3D rotation 
tool, you can move the rotation anchor to a 
helpful position than the center, such as over 
atom positions. This makes it easy to rotate 
structures around atoms in 3D space.

Unique IDs
IDs can be automatically added as attributes 
for atoms and bonds. To do so, just select the 
appropriate choice in the Unique IDs> 
submenu in the View menu.

Zero Order/Ionic Bonds
In some cases, a molecule may contain ionic 
bonds or you may wish to associate two 

atoms that are not connected with a covalent 
bond.

ChemDoodle contains a zero/ionic bond order 
specifically for these cases. You can use this 
bond order by selecting the Zero/Ionic bond 

type button  in the Bonds toolbar. Any 
atoms connected with this bond type will be 
spatially linked and can be sent to 
cheminformatics algorithms such as 
molecular formula generation and structure 
cleaning.

Note: Most filetypes have no concept of a 
zero order bond, so saving these bond 
types and loading them into other 
applications may not produce desired 
results.
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Chapter 7: 
Reactions
Overview
Reactions can be drawn in ChemDoodle 
using structures and arrow shapes. Almost 
any type of reaction or mechanism can be 
drawn. ChemDoodle also contains tools for 
explicitly defining reactions for various 
purposes.

This section introduces the new user to 
reactions within ChemDoodle. It covers the 
following topics:

• How to draw reactions.

• How to draw mechanisms.

• What types of arrows can be drawn.

• How to build and define reactions and 
reaction schemes.

• How to edit reactions.

• How to clean reactions.

Drawing Reaction Arrows
Reaction arrows are created from basic arrow 
shapes. Instructions for drawing arrow shapes 
are provided in Chapter 4.

Arrow Types
Many different types of arrows can be easily 
created using the Arrows toolbar described in 
Chapter 2. This section briefly goes over the 
different styles and presets.

Arrowhead Styles
Arrowhead styles can be set to both the start 
and end of the arrow. Several arrowhead 

styles (half-heads) can be flipped over the 
arrow axis. The following arrowhead styles 
are provided:

• Full Indented - 

• Full - 

• Unfilled Full Indented - 

• Unfilled Full - 

• Chevron - 

• Half Indented - 

• Half - 

• Unfilled Half Indented - 

• Unfilled Half - 

• Hook - 

Changing Arrowhead Lengths and 
Angles
Both the arrowhead length and angle can be 
changed to match any look. To change the 
arrowhead length and angle, perform the 
following steps:

1. Hover the arrow containing the arrowhead 
to be edited.

2. Right-click on the arrow and select the 
Format Line... menu item.

3. Scroll down to the Reaction section in the 
Format Line window that appears.

4. In the Arrow at Start and Arrow at End 
sections, use the Length and Angle 
sliders to edit the arrowheads.

Quickly Toggle Arrowheads
Instead of opening the shape settings window, 
you can easily toggle default arrowheads on 
the ends of objects that support arrowheads 
by hovering the object and pressing the left 
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arrow (to toggle start) or right arrow (to 
toggle end) keys.

Connector Styles
A connector is the line that connects the start 
and end arrows, if any. The following 
connector styles are provided:

• Solid - 

• Dashed - 

• Wavy - 

• Doubled - 

• No Go (cross) - 

• No Go (slash) - 

• Rearrangement - 

Special Arrow Presets
Many different types of arrows can be drawn 
with Arrows toolbar. The following describes 
how these tools build common arrow types.

Reaction Arrow - A reaction arrow 
is the default style and is drawn with no start 
arrow, a Full Indented end arrow and a Solid 
connector.

Retrosynthetic Arrow -  A 
retrosynthetic arrow can be drawn with no 
start arrow, a Chevron end arrow and a 
Doubled connector. The default arrowhead 
angle and length is not aesthetic for this type 
of arrow, so use the retrosynthetic preset in 
the presets group button to quickly access this 
type.

Equilibrium Arrow - An 
equilibrium arrow can be drawn with a Half 
Indented start arrow, a Half Indented end 
arrow and a Doubled connector. The double 
line spacing can be edited in the arrow’s 
visual specifications.

Resonance Arrow - A resonance 
arrow can be drawn with a Full Indented 
start arrow, a Full Indented end arrow and a 
Solid connector.

Electron Pair Shift - A shift of an 
electron pair can be drawn with no start 
arrow, a Full Indented end arrow and a Solid 
connector. Then select the appropriate arc 
angle for the figure.

Single Electron Shift - A shift of a 
single electron can be drawn with no start 
arrow, a Half Indented end arrow and a Solid 
connector. Then select the appropriate arc 
angle for the figure.

Photon - A photon can be drawn 
with a Full end arrow and a Wavy connector.

Bold - A bold arrow can be drawn 
with no start arrow, an Unfilled Full end 
arrow and a Doubled connector. The default 
arrowhead angle and length is not aesthetic 
for this type of arrow, so use the 
retrosynthetic preset in the presets group 
button to quickly access this type.

Bezier Arrow Ideas
In addition to straight and arced arrows, some 
pretty complex arrow shapes may be drawn 
with the bezier tools. The following are a few 
ideas. Just mimic the location of the control 
points to match them.
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The Chute Arrow

The Loop Arrow

The Escalator Arrow

The Hump Arrow

The Zigzag Arrow

Building Reactions
Reaction figures can be drawn by placing 
structures next to arrow shapes to describe 
reaction schemes. This method will create a 
visual diagram for the reaction, but 

underlying semantics will not exists. In other 
words, there is no formal definition of the 
reaction reactants or products.

To address this, ChemDoodle provides a 
reaction building system to explicitly define 
reactions and reaction schemes.

Implicitly
To implicitly define a reaction, perform the 
following steps:

1. Draw the arrow you would like to 
represent the reaction arrow.

2. Draw any reactants and place them to the 
left of the arrow shape.

3. Draw and products and place them to the 
right of the arrow shape.

4. Select the arrow shape and all reactants 
and products using the selection tools.

5. Press the Build Implied Reaction menu 
item in the Reaction menu to define the 
reaction.

All structures with midpoints to the left of the 
arrow shape’s midpoint will be defined as 
reactants in the reaction while all structures 
with midpoints to the right of the arrow 
shape’s midpoint will be defined as products 
in the reaction.

Explicitly
To explicitly define a reaction, first select the 
arrow shape you would like to represent the 
reaction arrow using the selection tools. Then 
press the Edit Reaction… menu item in the 
Reaction menu open the Edit Reaction 
window for that selected arrow, as shown in 
Figure 7.3.

The Edit Reaction window is a drag and 
drop interface. All molecules in the current 
document are displayed in the bottom tray, 
while the left and right trays correspond to the 
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constituent reactants and products 
respectively. Just drag and drop molecules 
from the bottom tray into the other two to set 
up the reaction. Once a molecule has been 
placed, it will be grayed out in the bottom 
tray and no longer selectable. You can transfer 
a placed molecule between the products and 
reactants by dragging the molecule between 
the side trays. You can remove a molecule 
from the reaction completely by dragging and 
dropping it back in the bottom tray.

Press the Done button in the Reaction 
Builder window to set the reaction.

Adding Reaction Conditions
To add reaction conditions above and below 
the reaction arrow, first select the arrow shape 
you would like to add conditions to using the 
selection tools. Then press the Edit 
Reaction… menu item in the Reaction menu 
open the Edit Reaction window for that 
selected arrow, as shown in Figure 7.3.

The Edit Reaction window contains two text 
editors for adding text above and below the 
reaction arrow. Click on a text area and type 
to add text. You can format the text using the 
text formatting tools above the text areas.

Use the Symbols widget to input characters 
into the reaction condition text areas that are 
not present on the keyboard.

Press the Done button in the Reaction 
Builder window to set the reaction.

Adding Plus Symbols
After building a reaction, plus symbols will 
automatically be added at the midpoints 
between the constituent reactants and 
products. This feature can be turned off in the 
Preferences window under the Visuals tab 
under the Reactions tab as shown in Figure 
7.2. Just uncheck the Automatically Place 
Pluses option.

If you want to add your own symbols, just use 
Text Area objects. Text Area objects are 
discussed in Chapter 4.

Dissolving Reactions
To dissolve a built reaction, just select the 
arrow the reaction is defined by with a 
selection tool, then select the Dissolve 
Reactions menu item in the Reaction menu.

Cleaning Reactions
To clean a reaction, perform the following 
steps:

1. Define the reaction implicitly or explicitly 
using the instructions in the previous 
section.

2. Select the arrow shape of the reaction you 
would like to clean using the selection 
tools.

3. Press the Clean menu item in the 
Reaction menu to clean it.

The reaction arrow will be horizontally 
leveled and resized to its text adhering to the 
Text Buffer visual specification. Then the 
reaction arrow and constituent molecules will 
be aligned according to their vertical centers 
and distributed horizontally with a buffer 
space. The entire reaction is then centered 
horizontally. If the reaction is too wide for the 
document, the reactants and arrow are then 
stacked above the products so that both 
groups are mutually centered as shown in 
Figure 7.1.

Figure 7.1: A wide reaction that has been stacked.
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The settings for determining how reactions 
are laid out can be set in the Preferences 
window under the Visuals tab under the 
Reactions tab as shown in Figure 7.2.

Figure 7.2: Reaction Visual Specifications

You can adjust the double line spacing for 
equilibrium arrows, decide whether or not 
pluses should be automatically drawn, set the 
text buffer for conditions text and the buffer 
between constituent reaction objects. You can 
also set the default settings for arrowheads.

ChemDoodle can clean multiple reactions at 
the same time, but currently can only properly 
clean discrete reactions. Cleaning complex 
reaction schemes with a given molecule 
defined in several different reactions may not 
produce desired results.
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Figure 7.3: Edit Reaction Window

137

Reactants 
Tray

Products 
Tray

Document 
Structures 
Tray

Text Formatting Tools
Reaction Condition Text Areas



Chapter 8: Spectra
Overview
ChemDoodle understands several 
spectroscopy and spectrometry techniques. 
These spectra can be loaded and edited to 
create graphics.

This section introduces the new user to 
spectra within ChemDoodle. It covers the 
following topics:

• What types of spectra are supported.

• How to load spectra.

• How to save spectra.

• How to simulate spectra.

• How to edit spectra.

Inserting Spectra
Spectra can be read in from the JCAMP-DX 
format which is the standard defined by 
IUPAC. The currently supported JCAMP 
formats are for nuclear magnetic resonance 
spectroscopy (NMR), infrared spectroscopy 
(IR), mass spectrometry (MS) and chemical 
structures.

To insert spectra from JCAMP files, perform 
the following steps:

1. Select the Open... menu item in the File 
menu.

2. In the file chooser that appears, change 
the format filter on the bottom to IUPAC 
JCAMP-DX.

3. Find the JCAMP file on your computer 
and select it with the file chooser.

4. Press the Open button at the bottom-right 
of the file chooser to load the spectrum.

The spectrum will be loaded and displayed in 
the center of a new document.

Spectra Types
Both continuous and discontinuous spectra 
are supported. An example of NMR input is 
shown in Figure 8.1. An example of IR input 
is shown in Figure 8.2. An example of MS 
input is shown in figure 8.3.

Figure 8.1: An NMR spectrum loaded from a 
JCAMP file.

Figure 8.2: An IR spectrum loaded from a JCAMP 
file.

Figure 8.3: An MS spectrum loaded from a 
JCAMP file.
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Uninterpretable Spectra
There are many different ways to represent 
JCAMP data. Therefore, ChemDoodle may 
not be able to understand a JCAMP file. If 
ChemDoodle was not able to interpret any 
spectra from the JCAMP file, you will see the 
message shown in Figure 8.4. Please send us 
the JCAMP file if you see this issue so that 
we may improve our compatibility with the 
format.

Figure 8.4: ChemDoodle could not understand the 
spectrum in the JCAMP file.

Saving Spectra
ChemDoodle can output spectra in the 
following formats:

1. ChemDoodle Documents {.icl, .icxml}

2. IUPAC JCAMP-DX {.jdx, .dx}

Be very careful when overwriting spectra to 
formats other than the ChemDoodle 
Document. ChemDoodle only reads and 
writes the information that is relevant to the 
display of its graphics, and other data will be 
lost. If saving 3rd party spectra files for any 
reason, always save them as a new file.

Simulating Spectra
ChemDoodle can simulate spectra for various 
techniques. Currently the following 
techniques are implemented:

• 1H Nuclear Magnetic Resonance 
Spectroscopy

• 13C Nuclear Magnetic Resonance 
Spectroscopy

• Mass Spectrum Parent Peak

To simulate spectra, perform the following 
steps:

• Select a the chemical structure you would 
like to simulate a spectrum for using the 
selection tools.

• In the Spectrum menu, hover over the 
Generate submenu to view available 
techniques.

• Click on the technique you would like to 
use.

The generated spectrum will then appear on 
the Doodle Board. Some very intense 
simulations may take a few seconds to 
complete.

Editing Spectra
Moving Spectra
To move spectra, use a selection tool, either 
the lasso or the rectangular marquee. Make 
sure that no content is currently selected by 
emptying the current selection. Perform the 
following steps:

1. Hover the mouse pointer over the 
spectrum so an open hand mouse cursor 
appears and the two spectrum anchor 
points are drawn as shown in Figure 8.5.
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2. Press the mouse down and drag to move 
the spectrum.

3. Release the mouse to finish the move 
action.

Figure 8.5: Hovering over the spectrum will 
display its anchor points.

Resizing Spectra
To resize spectra, use a selection tool, either 
the lasso or the rectangular marquee. Make 
sure that no content is currently selected by 
emptying the current selection. Perform the 
following steps:

1. Hover the mouse pointer over the 
spectrum so an open hand mouse cursor 
appears and the two spectrum anchor 
points are drawn as shown in Figure 8.5.

2. Move the mouse pointer over one of the 
two anchor points so that anchor point is 
filled in with an amber color.

3. Press the mouse down so the anchor point 
is filled with a blue color.

4. Drag the anchor point to resize the 
spectrum.

5. Release the mouse to finish the resize 
action.

Removing Spectra
Spectra can be removed in a number of ways. 
You can do the following:

• Use a selection tool to hover the mouse 
pointer over the spectrum so an open hand 
mouse cursor appears and the two spectrum 
anchor points are drawn as shown in Figure 
8.5. Then press the backspace or delete key.

• Use the eraser tool to hover the mouse 
pointer over the spectrum so the two 
spectrum anchor points are drawn. Then 
click with the mouse.

• Select the spectrum using any of the 
selection tools. Then press the delete or 
backspace key.

Expanding the Perspective
Expanding the spectrum will fit the entire 
range and domain of the plot to the display 
rectangle. Perform the following steps.

1. Use the selection tools to select any 
number of spectra.

2. Click on the Expand Perspective menu 
item in the Spectrum menu.

All selected spectra will have their 
perspectives expanded.

Editing the Perspective
Editing the perspective will allow you to 
modify how the plot fits in the viewing 
rectangle and will also allow you to edit the 
axes and title. These functions are presented 
in the Spectrum Edit window as shown in 
Figure 8.8.

To change the plot domain, click and drag the 
sliders presented directly under the spectrum. 
The sliders display, from left to right, the 
minimum domain cutoff, the magnitude of the 
domain, and the maximum domain cutoff. 
You can also change the plot domain by 
clicking and dragging on the main spectrum 
panel. Click on the placement where you 
would like the domain to begin, then drag to 
where you would like the domain to end and 
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release the mouse. A dotted grey line will 
display while dragging to show you the new 
domain. Additionally, holding the shift key 
while dragging on the spectrum will translate 
the domain of the spectrum.

To change the range scale, click and drag the 
vertical slider directly to the right of the 
spectrum. You can also change the range scale 
by using the mouse scroll gesture on the main 
spectrum panel. Scroll up to increase the 
range scale and scroll down to decrease the 
range scale.

To expand the perspective, double-click on 
the main spectrum panel.

Changing the Title
To change the title of the spectrum, in the 
Spectrum Edit window shown in Figure 8.8, 
click on the Title text field located at the 
bottom-left and type in the desired title.

Changing the Axes
There are several options for editing the axes.

X-axis options are presented in the X Axis 
section of the Spectrum Edit window shown 
in Figure 8.8. You can choose to show or hide 
it by clicking the Show check box. You can 
choose whether to flip the domain or not by 
clicking the Flip check box. You can adjust 
the increments for the major and minor tick 
spacings using the Major Tick Spacing and 
Minor Tick Spacing drop down selections. 
The values in the drop down selections are 
exponents for base 10. You can change the 
title of the X-axis by clicking on the Unit text 
field and typing the desired title.

Y-axis options are presented in the Y Axis 
section of the Spectrum Edit window shown 
in Figure 8.8. You can choose to show or hide 
it by clicking the Show check box. The 
Baseline Bump check box will positively 
offset the plot by a small value.  You can 

adjust the increment for the major tick 
spacing using the Tick Spacing drop down 
selection. The values in the drop down 
selection are exponents for base 10. You can 
change the title of the Y-axis by clicking on 
the Unit text field and typing the desired title.

Showing Grids
Grids can be displayed by performing the 
following steps:

1. Hover the spectrum to display the grid 
over.

2. Right-click on the spectrum and select the 
Format Spectrum... menu item.

3. Scroll down to the Grid section and select 
the Show Grid checkbox.

The color and thickness of the grid lines can 
also be set in this format window. A grid 
appears as shown in Figure 8.6.

Figure 8.6: A grid is displayed over a spectrum.

Showing Integration Lines
Integration lines can be displayed by 
performing the following steps:

1. Hover the spectrum to display the 
integration line over.

2. Right-click on the spectrum and select the 
Format Spectrum... menu item.

3. Scroll down to the Integration Line 
section and select the Show for NMR 
Spectra checkbox.
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The color and thickness of the integration line 
can also be set in this format window. While 
intended for NMR spectra, integration lines 
can be added to any plot if desired. An 
integration line appears as shown in Figure 
8.7.

Figure 8.7: An integration line is calculated over 
an NMR multiplet.

Figure 8.8: The Spectrum Edit Window
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Chapter 9: Visual 
Specifications
Overview
All graphics in ChemDoodle are fully 
customizable. Visual specifications for the 
graphics can be defined for the entire 
document, groups of objects or individual 
objects.

This section introduces the new user to 
ChemDoodle document settings and visual 
specifications. It covers the following topics:

• What are document settings, visual 
specifications and style sheets.

• How to create and install custom Chemical 
Document Settings files.

• Which graphic specifications can be 
customized.

• How to customize the graphics of your 
figures.

Document Settings
Document settings are the variables that 
determine how graphics are rendered in a 
document. They are also called visual 
specifications when referring to an individual 
object. All together, they form the document’s 
style sheet.

Style Sheets
Style sheets can be named when creating 
formatted documents. The creation of 
formatted documents is discussed in Chapter 
1.

In addition to creating or conforming 
ChemDoodle documents to the preset style 

sheets, you can create your style sheets in 
ChemDoodle Document Settings files that can 
be used later. In the Preferences window, 
under the Visuals tab, under the Page tab, 
there is a Create Chemical Document 
Settings File button at the bottom of the 
options. Just perform the following steps to 
create a new ChemDoodle Document Settings 
file with your completed style sheet:

1. Go through the all of the tabs under the 
Visuals tab in the Preferences window 
and set all of the values in the options to 
the preferred values.

2. Click on the Create Chemical Document 
Settings File button in the Preferences 
window under the Visuals tab under the 
Page tab.

3. A new window will appear. Type in the 
name of the ChemDoodle Document 
Settings file.

4. Choose three fonts to cascade through. 
This is important because different 
operating systems have different font sets 
and you may have selected a font not 
accessible on another operating system if 
you want to use it on that operating 
system. Serif and SansSerif will always be 
defined on all operating systems, so select 
those fonts in the third option as wild 
cards.

5. Press the Ok button to save the Chemical 
Document Settings file.

All Chemical Document Settings files are 
saved to the presets folder in the 
ChemDoodleSettings folder located in your 
operating system’s standard Documents 
folder. Any functions for using ChemDoodle 
Document Settings files or for conforming 
documents will now list the new style sheet.
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If you want to use Chemical Document 
Settings files provided by other users of 
ChemDoodle, just copy their file into the 
presets folder in the ChemDoodleSettings 
folder located in your operating system’s 
standard Documents folder. If you have 
ChemDoodle open while copying the file, 
close and restart it. They copied style sheet 
will then be accessible in ChemDoodle.

Setting the Default Document Settings
When you globally change the visual 
specifications for a document, ChemDoodle 
will ask you if you would like the changed 
settings to become the new default settings. 
There are two cases when this happens:

1. After opening the Preferences window and 
changing visual specifications.

2. After conforming a document using the 
Conform Document... menu item in the 
Edit menu.

Just click Yes to set the changed settings as 
the default settings. Now when a new 
document is opened, the current default 
settings will be used to define the graphics.

Alternatively, you may answer No to the 
question, and later, if you decide to indeed 
use the current document settings as the 
default document settings, then select the 
Save Document Settings... menu item in the 
Window menu.

Restore the Original Default Document 
Settings
To restore the original default document 
settings, open the Preferences window and 
click the Restore Defaults button at the 
bottom of the window. Then close the 
window and select Yes when asked to set the 
current settings as the new default settings.

Individual Settings
Setting Types
All visual specifications provided in 
ChemDoodle are listed in the Preferences 
window under the Visuals tab as shown in 
Figure 9.1.

Figure 9.1: Visual Specifications

Each visual specification consists of a title to 
the left and a component to the right. These 
components include:

• On/Off Choices - Click the check box to 
choose whether the specification is used or 
not. For example, the following check box 
will enable or disable the Clear Bond 
Overlaps visual specification. 

• Single Option Choices - Choose one of the 
options from a group exclusively to define 
it as the value to use for the specification. 
For example one option can be chosen from 
the following group set to determine the 
value for the Covalent Style specification.
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• Number Sliders - Define a number value 
by clicking and dragging the slider or by 
explicitly typing the value in the text field. 
Some number components will be 
associated with a dimension drop down 
selection to easily set values in other units, 
such as centimeters instead of pixels. For 
example, slide the slider or type a value into 
the text box of the following number 
component to define the value for the Bond 
Line Thickness specification.

NOTE: Some number components define 
angles, and an angle swivel will be 
provided instead of a slider. Click and drag 
to the angle you want on the swivel to set 
the angle.

• Color Buttons - Click on color buttons and 
use the color selection window that appears 
to select a new color. For example, the 
following color button will determine bond 
line color.

All objects drawn after changing the visual 
specifications in the Preferences window will 
conform to the new specifications. All visual 
specifications are listed in the following 
sections.

Page

Colors

Background - A color button for the 
background color of the document.

Dimensions

Page Size - A specialized component for 
setting the page size. Set the width and height 
by typing in the text boxes or select a 
standard size from the drop down selections. 
The button to the left of the text fields will 
swap the width and height.

Ångströms / Bond Length - A number slider 
for setting the ratio between Ångströms and 
the Bond Length specification in pixels. This 
specification is useful when finding covalent 
bonds and when reading in files with 
Ångström coordinates.

Margins

Top - Type in the value for the top page 
margin.

Left - Type in the value for the left page 
margin.

Bottom - Type in the value for the bottom 
page margin.

Right - Type in the value for the right page 
margin.

Atoms

Colors

Text - A color button for the text color of atom 
labels.

Labels

Buffer Space - A number slider to set the 
amount of whitespace between atom text and 
the bonds connected to that atom.
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Vertical Alignment - A number slider to 
control the baseline for rendering text relative 
to the center of the atom.

Token Stacking - A single option choice to set 
whether atom labels will stack all tokens, 
stack only the second token or will never 
stack tokens.

Stack Lone/Terminal - An on/off choice to set 
whether lone and terminal atoms will stack 
their label tokens.

Horizontal Spacing - A number slider to set 
the horizontal whitespace between each label 
token.

Vertical Spacing - A number slider to set the 
vertical whitespace between each label token.

Subscript Reduction - A number slider to set 
the size of subscript font relative to the atom 
label font.

Subscripts Shift - A number slider to set the 
magnitude of the offset from the atom label 
font baseline to draw subscripts from.

Superscript Reduction - A number slider to set 
the size of superscript font relative to the 
atom label font.

Superscript Shift - A number slider to set the 
magnitude of the offset from the atom label 
font ascent to draw superscripts from.

Hydrogens

Add as - A single option choice to determine 
if Hydrogens are added as text to labels or as 
atoms with bonds attached.

Add to Carbons - A single option choice to set 
how Hydrogens add to Carbons; Hydrogens 
can always add to Carbons, can only add to 
unsaturated Carbons or will never add to 
Carbons.

Show Implicit Hydrogens - An on/off choice 
to set whether implicit hydrogens are 
automatically rendered or not.

Carbons

Display Carbon Labels - A single option 
choice to set if Carbon labels display always, 
only on lone and hidden Carbons, only on 
hidden Carbons, or never show.

Hidden Carbon Angle - An angle number 
slider for setting the hidden Carbon angle. 
The hidden Carbon angle is the deviation 
from 180° between bonds on a Carbon atom 
that only has 2 bonds attached to it.

Show Terminal Labels - An on/off choice to 
set whether terminal carbon labels are 
displayed or not.

Elements

Use Circles - An on/off choice for controlling 
if element labels are rendered as text or as 
circles.

Coloring - A single option choice for 
determining whether user chosen colors, CPK 
colors, Jmol colors, or PyMOL colors are 
used for element labels.

Radius Convention - A single option choice to 
control if circles are rendered with a constant 
radius, the atomic radius of their element, the 
covalent radius of their element or the van der 
Waals radius of their element.

Constant Radius - A number slider to set the 
constant radius to render element atom circles 
with.

Border Width - A number slider to set the 
width of the circle outlines when atoms are 
rendered as circles.
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Attributes

Colors

Fill/Text - A color button for the text color of 
attribute labels and graphics.

Logistics

Allowed Distance - A number slider to control 
the maximum distance an attribute can be 
translated away from the object it defines.

Text

Font Size Reduction - A number slider to 
control the font size reduction of attribute text 
from its defined font. This is so attribute text 
is smaller than the text of the object is 
associated with.

Charges

Surround with a Circle - An on/off choice to 
set whether charges are rendered with a circle 
around them.

Radicals

Diameter - A number slider to set the 
diameter of rendered electrons.

Separation - A number slider to set the 
separation distance between electrons or 
electrons and charges in paired attributes such 
as electron pairs and radical cation symbols.

Bonds

Colors

Fill - A color button for the bond line color.

Use Gradient - An on/off choice for rendering 
bonds with a gradient between the constituent 
atom colors.

Split Color - An on/off choice for rendering 
bonds that will split the bond color between 
the constituent atom colors.

Settings

Bond Length - A number slider to define the 
optimal length for bonds. This affects 
anything that depends on bond length 
including drawing bonds and cleaning 
structures.

Bond Line Thickness - A number slider to 
define the width of bond lines.

Bold Bond Thickness - A number slider to 
define the width of bold bonds.

Wedge Thickness - A number slider to define 
the width of the wide end of wedge bonds.

Unsaturated Spacing (Absolute) - A number 
slider to define the spacing between bond 
lines in higher order bonds.

Unsaturated Spacing (Relative) - A number 
slider to define the spacing between bond 
lines in higher order bonds, but relative to the 
length of the bond.

Clip Angle - An angle number slider to define 
the angle at which non-symmetrical double 
bonds will clip the second bond line.

Hash Width - A number slider to define the 
width of hashes in bonds rendered with a 
hash.

Hash Spacing - A number slider to define the 
width the spacing between hashes in bonds 
rendered with a hash.

Hash Offset - A number slider to define the 
translation from the origin of hashes in bonds 
rendered with a hash.

Arrow Length - A number slider to define the 
arrowhead length of covalent bonds.
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Arrow Angle - An angle number slider to 
define the arrowhead angle of covalent bonds.

Wavy Length - A number slider to define the 
amplitude of wavy bonds.

Zigzag Length - A number slider to define the 
amplitude of zigzag bonds.

Stroke

Style - A drop down selection to set the 
default bond stroke style.

Texture - A number slider for setting the 
magnitude of texture in stroke styles. For 
instance, a higher number will cause Bristle 
strokes to look more bristled.

Bond Ends - A single option choice to set how 
bond ends are rendered; with no cap, a round 
cap or a square cap.

Options

Join Bond Connections - An on/off choice to 
define whether the rendering engine will 
merge bonds end together for more aesthetic 
graphics. 

Double Bond Asymmetry - A single option 
choice to set when double bonds will be 
rendered asymmetrically; always, when 
between 2 Carbons, only in rings or never.

Heteroatom Retraction - An on/off choice that 
defines whether asymmetric double bonds 
will retract the second line from an atom or 
not based on that atom being a heteroatom.

Terminal Retraction - An on/off choice that 
defines whether terminal double bonds will 
retract the second line from a terminal atom 
or not.

Unsaturated Spacing - A single option choice 
for setting whether unsaturated bonds are 

rendered with an absolute spacing or with a 
relative spacing between bond lines. 
Changing this specification will place the 
corresponding visual specification in the 
Settings section.

Even Hashes - An on/off choice to determine 
if the Hash Width and Hash Offset 
specifications only affect Bold Dashed and 
Recessed bonds.

Clear Bond Overlaps - An on/off choice to 
determine if an overlapped bond will erase 
the section of overlap.

Overlap Clear Width - A number slider to 
define the length of the bond that is erased 
when overlapped.

Covalent Style - A single option choice to set 
if covalent bonds are rendered as Polar 
Covalent bonds with a slash in the stroke, or 
as Coordinate Covalent bonds.

Indent Arrow Bond - An on/off choice to set if 
covalent bond arrowheads are indented.

Rings

Fused

Favor Aromatics - An on/off choice to force 
double bonds in fused systems to face 
aromatic rings over non-aromatic rings.

Double Bond Orientation - A single option 
choice to determine if double bonds in fused 
ring systems will face larger rings or smaller 
rings.

Aromatics

Use Circles - An on/off choice to render 
aromatics with a circle instead of in Kekulé 
form.
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Circle Radius - An number slider to define the 
diameter of the aromatic circle relative to the 
dimensions of the ring.

Reactions

Layout

Double Line Spacing - A number slider to 
define the spacing between the lines in 
equilibrium arrows.

Automatically Place Plusses - An on off 
choice to set whether reactions automatically 
place plusses between constituent reactants 
and products.

Text Buffer - A number slider to define the 
buffer between the text set as the reaction 
conditions and the ends of the associated 
arrow when the text is centered. This value 
times 2 will determine the default length that 
arrows without associated text are cleaned to 
when cleaning reactions.

Constituent Buffer - A number slider to define 
the spacing between reaction constituents 
when cleaning reactions.

Arrowheads

Length - A number slider to define the 
arrowhead length of arrow shapes.

Angle - An angle number slider to define the 
arrowhead angle of arrow shapes.

Shapes

Colors

Borders and Lines - A color button for the 
lines and borders of shapes.

Fill - A color button for the fill color of 
shapes.

Text - A color button for the text color of 
shapes.

Settings

Shapes Add - A single option choice to set 
whether shapes are drawn in front of atoms or 
behind atoms.

Strokes

Thickness - A number slider to define the 
width of solid strokes in shapes.

Hash Width - A number slider to define the 
width of hashes in shapes rendered with a 
hash.

Hash Spacing - A number slider to define the 
width the spacing between hashes in shapes 
rendered with a hash.

Hash Offset - A number slider to define the 
translation from the origin of hashes in shapes 
rendered with a hash.

Shadows

Translation - A number slider to define the 
distance from the shape the shadow should be 
rendered.

Angle - An angle number slider to define the 
angle in relation to the shape to place the 
shadow.

Opacity - A number slider to define the 
transparency of shadows.

Brackets

Wideness - A number slider to define the 
width of bracket lips relative to the standard 
size.

Orbitals

Length Multiplier - A number slider to define 
the default extent of orbitals in bond lengths. 
So if the length multiplier is 1, then all 
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orbitals placed will have a length of 1 bond 
length.

Stroke Shaded Lobes - An on/off choice to set 
whether shaded lobes in orbitals will also be 
outlined.

Paths

Close - An on/off choice to set if paths are 
closed by default.

Rectangles

Rounded Arc Width - A number slider to 
define the width of the corner arcs in rounded 
rectangles.

Rounded Arc Height - A number slider to 
define the height of the corner arcs in rounded 
rectangles.

Rulers

Show Major Ticks - An on/off choice to set if 
major ticks are shown in rulers.

Close - An on/off choice to set if minor ticks 
are shown in rulers.

Unit - A drop down selection to set the default 
units of ruler objects.

Spectra

Colors

Plots - A color button for the spectrum plots.

Grids - A color button for the spectrum grids.

Integration Lines - A color button for the 
spectrum integration lines.

Plot Strokes

Thickness - A number slider to define the 
width of solid strokes in spectrum plots.

Hash - An on/off choice to render spectrum 
plots with a hashed stroke.

Hash Width - A number slider to define the 
width of hashes in spectrum plots rendered 
with a hash.

Hash Spacing - A number slider to define the 
width the spacing between hashes in spectrum 
plots rendered with a hash.

Hash Offset - A number slider to define the 
translation from the origin of hashes in 
spectrum plots rendered with a hash.

Grids

Show - A on/off switch to set whether 
spectrum grids are shown by default.

Thickness - A number slider to define the line 
thickness of spectrum grids.

Integration Lines

Show - A on/off switch to set whether 
spectrum integration lines are shown by 
default.

Thickness - A number slider to define the line 
thickness of spectrum integration lines.

Editing Visual Specifications
For Single Objects
To edit the visual specifications of a single 
object, perform the following steps:

1. Switch to a selection tool and make sure 
the current selection is empty.

2. Hover the mouse pointer over the object 
of which the visual specifications are to 
be changed. 

3. Right-click on the object and select the 
Format Object... menu item or double-
click on the object.

150



4. Change the visual specifications in the 
window that appears. You will see the 
graphics update in real-time on the 
Doodle Board.

5. Click the Done button in the window to 
set the changes.

You can also press the Cancel button to 
cancel all changes.

For a Group of Objects
To edit the visual specifications of a group of 
objects, perform the following steps:

1. Switch to a selection tool.

2. Select all of the content of which the 
visual specifications are to be changed.

3. Open the Preferences window and click 
on the Visuals tab.

4. Change all the visual specifications in the 
Visuals tab to your preference. You will 
see the graphics update in real-time on the 
Doodle Board.

5. Click the Done button in the Preferences 
window to set the changes.

You can also press the Cancel button to 
cancel all changes.

Conforming a Group of Objects to the 
Current Style Sheet
To conform a group of objects to the current 
style sheet, perform the following steps:

1. Switch to a selection tool.

2. Select all of the content of which the 
visual specifications are to be changed.

3. Press the Conform to Document 
Settings menu item in the Content menu.

All content will conform to the visual 
specifications defined in the document’s style 
sheet. This function will also change fonts 

and scale structures to match the defined bond 
length.

Conforming the Entire Document to a 
Different Style Sheet
To conform the entire document to a different 
style sheet, perform the following steps:

1. Press the Conform Document... menu 
item in the Edit menu.

2. In the window that appears, choose the 
style sheet you prefer from the drop down 
selection.

3. You will be asked if you would like to 
conform atom text by changing fonts; 
choose Yes or No.

4. If the bond length has changed, you will 
be asked if you would like the structures 
to be scaled to match the new value; 
choose Yes or No.

The entire document will now conform to 
your choice of style sheet.

3D Graphics
ChemDoodle is a tool for generating 2D 
graphics. However, ChemDoodle handles 3D 
input and you can create orthographic 2D 
scenes of your 3D data. That being said, with 
all of the bond types and atom labels 
showing, the figure may not be very aesthetic. 
To create better looking 2D orthographic 
scenes of your 3D data, perform the following 
suggestions.

• Change all bonds to plain single bonds, and 
include double bonds if necessary.

• Change the visual specifications to show all 
atoms as circles instead of as text labels.

• Change the visual specifications to render 
atoms with their Jmol colors.
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• Increase the bond line width visual 
specification.

• Change the visual specifications to render 
bonds with a gradient between their 
constituent atoms.

• Increase the bond overlap buffer visual 
specification to clearly show bond overlaps.

We have provided a sample style sheet to 
quickly create 2D orthographic scenes from 
3D data that can be accessed when creating a 
formatted document or conforming a given 
document as is described in the previous 
section called Orthographic 3D Scene.

Bond Stroke Styles
ChemDoodle provides several bond stroke 
styles to casually style your structures for 
presentations, posters and more casual media. 
To change bond stroke styles, select the bonds 
to be changed with a selection tool and use 
the Stroke toolbar.

The default bond line stroke width is 1.2 
pixels. This is not sufficient to see some 
stroke styles and the value will need to be 
increased. Other stroke styles, such as the 
Brush style, will not display well for really 
short bonds and structures rendered with 
those styles should be expanded.

The following bond stroke styles are currently 
provided:

• Basic - 

• Bristle - 

• Brush - 

• Calligraphy - 

• Charcoal - 

• Scribble - 

• Wobble - 

Advanced Document 
Rendering
The graphics defined by ChemDoodle are 
always exact and based on very precise 
coordinates. However, the screen that you use 
to display ChemDoodle and bitmap images 
that are output will need to define the 
graphics in a much less precise resolution. 
Algorithms have been developed to minimize 
the perception of this loss of resolution and 
ChemDoodle provides full access to control 
how the graphics are rendered. Note that 
scalable vector graphics are also exact and 
based on precise coordinates and are therefore 
resolution-less. The following settings will 
only affect the display of graphics on your 
computer monitor and the output of bitmap 
graphics; scalable vector graphics will not be 
affected.
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Advanced document rendering settings can be 
defined in the Preferences window under the 
Advanced tab.

Anti-Aliasing
Anti-aliasing controls whether or not the 
geometry rendering methods will attempt to 
reduce aliasing artifacts along the edges of 
shapes. Anti-aliasing is enabled by default.

A typical antialiasing algorithm works by 
blending the existing colors of the pixels 
along the boundary of a shape with the 
requested fill paint according to the estimated 
partial pixel coverage of the shape. This 
function reduce the appearance of jagged 
edges. Figure 9.2 is a structure rendered 
without anti-aliasing enabled, while Figure 
9.3 is a structure rendered with anti-aliasing 
enabled.

Figure 9.2: Anti-aliasing is disabled.

Figure 9.3: Anti-aliasing is enabled.

Font Fractional Metrics
Font fractional metrics controls whether the 
positioning of individual character glyphs 
takes into account the sub-pixel accuracy of 
the scaled character advances of the font or 
whether such advance vectors are rounded to 
an integer number of whole device pixels. 
This hint only recommends how much 
accuracy should be used to position the 
glyphs and does not specify or recommend 
whether or not the actual rasterization or pixel 
bounds of the glyph should be modified to 
match. Font fractional metrics are disabled by 
default to produce better graphics for bitmap 
images and for the computer screen. In 
ChemDoodle, this property does not affect 
printing. Since printing is usually with a high 
resolution device, ChemDoodle will always 
enable font fractional metrics for printer 
rendering.

Rendering text to a low resolution device like 
a screen will necessarily involve a number of 
rounding operations as the high quality and 
very precise definition of the shape and 
metrics of the character glyphs must be 
matched to discrete device pixels. Ideally the 
positioning of glyphs during text layout 
would be calculated by scaling the design 
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metrics in the font according to the point size, 
but then the scaled advance width will not 
necessarily be an integer number of pixels. If 
the glyphs are positioned with sub-pixel 
accuracy according to these scaled design 
metrics then the rasterization would ideally 
need to be adjusted for each possible sub-
pixel origin.

Unfortunately, scaling each glyph customized 
to its exact subpixel origin during text layout 
would be prohibitively expensive so a 
simplified system based on integer device 
positions is typically used to lay out the text. 
The rasterization of the glyph and the scaled 
advance width are both adjusted together to 
yield text that looks good at device resolution 
and has consistent integer pixel distances 
between glyphs that help the glyphs look 
uniformly and consistently spaced and 
readable.

This process of rounding advance widths for 
rasterized glyphs to integer distances means 
that the character density and the overall 
length of a string of text will be different from 
the theoretical design measurements due to 
the accumulation of a series of small 
differences in the adjusted widths of each 
glyph. The specific differences will be 
different for each glyph, some being wider 
and some being narrower than their 
theoretical design measurements. Thus the 
overall difference in character density and 
length will vary by a number of factors 
including the font, the specific device 
resolution being targeted, and the glyphs 
chosen to represent the string being rendered. 
As a result, rendering the same string at 
multiple device resolutions can yield widely 
varying metrics for whole strings.

When font fractional metrics are enabled, the 
true font design metrics are scaled by the 

point size and used for layout with sub-pixel 
accuracy. The average density of glyphs and 
total length of a long string of characters will 
therefore more closely match the theoretical 
design of the font, but readability may be 
affected since individual pairs of characters 
may not always appear to be consistent 
distances apart depending on how the sub-
pixel accumulation of the glyph origins 
meshes with the device pixel grid. Enabling 
this hint may be desirable when text layout is 
being performed that must be consistent 
across a wide variety of output resolutions. 
Specifically, this hint may be desirable in 
situations where the layout of text is being 
previewed on a low resolution device like a 
screen for output that will eventually be 
rendered on a high resolution printer or 
typesetting device.

When disabled, the scaled design metrics are 
rounded or adjusted to integer distances for 
layout. The distances between any specific 
pair of glyphs will be more uniform on the 
device, but the density and total length of 
long strings may no longer match the 
theoretical intentions of the font designer. 
Disabling this hint will typically produce 
more readable results on low resolution 
devices like computer monitors.

Dithering
Dithering controls how closely to 
approximate a color when storing into a 
destination with limited color resolution. 
Dithering is enabled by default

Some rendering destinations may support a 
limited number of color choices which may 
not be able to accurately represent the full 
spectrum of colors that can result during 
rendering operations. For such a destination, 
dithering controls whether rendering is done 
with a flat solid fill of a single pixel value 
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which is the closest supported color to what 
was requested, or whether shapes will be 
filled with a pattern of colors which combine 
to better approximate that color.

Rendering Algorithm
This setting provides a high level 
recommendation as to whether to bias 
algorithm choices more for speed or quality 
when evaluating tradeoffs. This hint could be 
consulted for any rendering or image 
manipulation operation, but decisions will 
usually honor other, more specific settings in 
preference to this setting. The rendering 
algorithm is set to Quality by default.

Alpha Interpolation Algorithm
The alpha interpolation setting is a general 
setting that provides a high level 
recommendation as to whether to bias alpha 
blending algorithm choices more for speed or 
quality when evaluating tradeoffs. The alpha 
interpolation algorithm is set to Quality by 
default.

This setting controls the choice of alpha 
blending calculations that sacrifice some 
precision to use fast lookup tables or lower 
precision SIMD instructions. This hint could 
also control whether or not the color and 
alpha values are converted into a linear color 
space during the calculations for a more linear 
visual effect at the expense of additional per-
pixel calculations.

Color Rendering Algorithm
The color rendering algorithm controls the 
accuracy of approximation and conversion 
when storing colors into a destination image 
or surface. The color rendering algorithm is 
set to Quality by default.

When a rendering or image manipulation 
operation produces a color value that must be 
stored into a destination, it must first convert 

that color into a form suitable for storing into 
the destination image or surface. Minimally, 
the color components must be converted to bit 
representations and ordered in the correct 
order or an index into a color lookup table 
must be chosen before the data can be stored 
into the destination memory. Without this 
minimal conversion, the data in the 
destination would likely represent random, 
incorrect or possibly even unsupported 
values. Algorithms to quickly convert the 
results of rendering operations into the color 
format of most common destinations are well 
known and fairly optimal to execute.

Simply performing the most basic color 
format conversion to store colors into a 
destination can potentially ignore a difference 
in the calibration of the color space of the 
source and destination or other factors such as 
the linearity of the gamma correction. Unless 
the source and destination color space are 
identical, to correctly perform a rendering 
operation with the most care taken for the 
accuracy of the colors being represented, the 
source colors should be converted to a device 
independent color space and the results then 
converted back to the destination color space. 
Furthermore, if calculations such as the 
blending of multiple source colors are to be 
performed during the rendering operation, 
greater visual clarity can be achieved if the 
intermediate device independent color space 
is chosen to have a linear relationship 
between the values being calculated and the 
perception of the human eye to the response 
curves of the output device.

Stroke Control
Stroke control defines whether a rendering 
implementation should or is allowed to 
modify the geometry of rendered shapes for 
various purposes. Stroke control is set to Best 
Compromise by default.
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Some implementations may be able to use an 
optimized platform rendering library which 
may be faster than traditional software 
rendering algorithms on a given platform, but 
which may also not support floating point 
coordinates. Some implementations may also 
have sophisticated algorithms which perturb 
the coordinates of a path so that wide lines 
appear more uniform in width and spacing.

If an implementation performs any type of 
modification or "normalization" of a path, it 
should never move the coordinates by more 
than half a pixel in any direction.

When stroke control is set to Normalize, 
geometry will be altered to improve 
uniformity or spacing of lines and overall 
aesthetics. The compromise is that geometry 
will be offset to fit to the pixel resolution of 
the rendering device. A consequence is that 
lines that are parallel may not appear exactly 
parallel, such as in double bonds.

When stroke control is set to Pure, geometry 
will be left unmodified and rendered with 
sub-pixel accuracy. There will be noticeable 
lightness and bolding in straight lines that are 
vertical or horizontal.

Figure 9.5 shows a rectangle and structure 
displayed with stroke control set to Pure, 
while Figure 9.6 shows the same objects with 
stroke control set to Normalize.

Figure 9.5: A structure and rectangle rendered 
with stroke control set to Pure. Notice the bolding 
and blurring of the horizontal and vertical lines.

Figure 9.6: A structure and rectangle rendered 
with stroke control set to Normalize. Notice that 
parallel lines are not preserved.

For even better graphics, a third option is 
provided called Best Compromise. This 
option will use pure stroke control for all 
chemical structures. All other shapes will first 
be analyzed for vertical and horizontal lines, 
and any found will be rendered with 
normalized stroke control while the rest of the 
graphics will be rendered with pure stroke 
control.
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Image Scaling
Image scaling controls how image pixels are 
filtered or resampled during an image 
rendering operation. This will have noticeable 
affects on images that are not rendered in 
their natural scale. The image scaling 
algorithm is set to Progressive Bilinear by 
default.

Implicitly images are defined to provide color 
samples at integer coordinate locations. When 
images are rendered upright with no scaling 
onto a destination, the choice of which image 
pixels map to which device pixels is obvious 
and the samples at the integer coordinate 
locations in the image are transferred to the 
pixels at the corresponding integer locations 
on the device pixel grid one for one. When 
images are rendered in a scaled, rotated, or 
otherwise transformed coordinate system, 
then the mapping of device pixel coordinates 
back to the image can raise the question of 
what color sample to use for the continuous 
coordinates that lie between the integer 
locations of the provided image samples. 
Interpolation algorithms define functions 
which provide a color sample for any 
continuous coordinate in an image based on 
the color samples at the surrounding integer 
coordinates.

Progressive Bilinear is better than Bicubic 
which is better than Bilinear which is better 
than Nearest-Neighbor at producing 
reasonable graphics of stretched or shrunken 
bitmap images. The better the algorithm used, 
the worse the runtime will get.
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Chapter 10: 
Sharing 
Information
Overview
ChemDoodle has advanced functions for 
interacting with other applications on your 
computer. This is essential for inputting 
graphics into word processors or for 
transferring chemical data into modeling 
applications.

This section introduces the new user to 
ChemDoodle’s system clipboard capabilities. 
It covers the following topics:

• Introducing the system clipboard.

• How to copy data and graphics from 
ChemDoodle into other applications.

• How to copy data and graphics from other 
applications into ChemDoodle.

• What types of data can be transferred.

• What image formats are supported.

• How to save images.

• How to insert images.

• How to take advantage of round trip editing.

The System Clipboard
The system clipboard is a construct of the 
operating system that contains data for 
sharing between applications. Only one 
application can place data on the system 
clipboard at a time. Other applications can 
then see that data and load it. This system 
forms the basis for copy and paste 

functionality. ChemDoodle will place a wide 
range of chemical and graphic data on the 
system clipboard as well as associate that data 
with the correct MIME types for other 
applications to use.

MIME Types
A MIME type is an identifier to define the 
data it is associated with. For example, a 
structure can be represented in MDL 
MOLFile format. The MDL MOLFile format 
is a plain text format and can be associated 
with the MIME type, text/plain. However, this 
is a very generic description and other 
applications will only recognize it as plain 
text, rather than as a chemical structure. 
Therefore a different MIME type is associated 
with this data, chemical/x-mdl-molfile, to 
define it as a structure in the MDL MOLFile 
format. In this manner, other applications will 
recognize this data as a chemical.

ChemDoodle follows the MIME standards put 
forth by the Chemical MIME Project (http://
www.ch.ic.ac.uk/chemime/). This should be 
regarded as the standard, however, many 
chemical software developers do not follow 
these rules, thereby causing issues when 
transferring data between chemical 
applications. 

Additionally, since many items can be present 
on the system clipboard at once, applications 
may paste a certain data type by default that 
may not be the data you want to paste. For 
instance, Microsoft Word can paste both text 
data types and image data types. If both are 
present on the system clipboard, Microsoft 
Word will automatically select the text data 
type when pasting, even if you wanted the 
image to be pasted. There can even be 
different image types, confusing the situation 
further.
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Therefore, ChemDoodle allows you to define 
how data and which data is placed on the 
system clipboard to work with the 
applications that you use.

Clipboard Settings
ChemDoodle can transfer data to almost any 
application that has been created. But it is 
impossible for ChemDoodle to determine 
which data should be transferred. Therefore, 
you need to set the appropriate Copy Settings 
to make sure any ambiguities are resolved 
with the application you are pasting to. Copy 
Settings can be set in the Preferences 
window under the Advanced tab as shown in 
Figure 10.1. These settings will allow you to 
explicitly control what data ChemDoodle will 
transfer to other applications.

Figure 10.1: Copy Settings

There are three main types of data that may 
be transferred:

• Text Types - Contains a line or lines of text 
that will be interpretable by other 
applications. Some chemical formats are 
also listed here to be pasted as text into 
other applications. All text data will be 
interpreted as text by other applications and 

any chemical significance will be lost. Only 
one text data type will be placed on the 
system clipboard at a time.

• Image Types - This group contains both 
bitmap and vector images. Bitmap images 
are not scalable in resolution. Vector images 
are much more versatile and will remain 
crisp and clear regardless of resizing or 
transformation. Bitmap and vector images 
are discussed in detail in the next section.

• Chemical Types - Chemical types include 
structure information. Only chemical 
programs will see these.

Therefore, to work with other applications, 
first decide what type of data you would like 
to transfer and what types of data the other 
application accepts. Then set the appropriate 
copy settings to continue.

Scalable Vector Graphics
There are two types of images, bitmap and 
vector. Bitmap images are traditional images 
and define a rectangle of pixels and their 
colors, while vector images define drawing 
instructions for recreating it. When resizing, 
the bitmap will become blurry, pixelated and 
lose its quality while the vector image will 
remain crisp and clear. Figure 10.2 shows a 
bitmap image of a structure, while Figure 
10.3 shows a vector image of the same 
structure. Both were created by ChemDoodle. 
Try zooming in on both images using your 
PDF reader and you can see the difference in 
quality for yourself.

Figure 10.2: A Bitmap Image
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Figure 10.3: A Vector Image

Bitmap images will suffer from this issue 
with any change of resolution, including 
printing to a printer. Because of this, we 
recommend you insert vector images into 
your documents. The only downside to using 
vector graphics is that some programs may 
not support them. ChemDoodle compatibility 
with 3rd party applications is discussed in 
Appendix C.

If you must use a bitmap image, then 
ChemDoodle provides high resolution options 
(such as scaling and DPI control) for a few 
bitmap formats as discussed in the Image 
Output Options section later in this chapter.

Copying Data to Other 
Applications
Using the Copy Function
To copy data from ChemDoodle into other 
applications, perform the following steps:

1. Determine which data you would like to 
transfer and the types of data that the 
other application can accept and configure 
the copy settings in the Preferences 
window under the Advanced tab 
accordingly.

2. Select the objects on the Doodle Board 
that you would like to copy using the 
content selection tools.

3. Click on the Copy menu item in the Edit 
menu or press its menu accelerator 
keyboard shortcut which is ctrl-C 
(command-C on Mac OS X).

4. Use the paste function present in the other 
application to paste the content. If the 
other application has a Paste Special... 
function, you may use that to specify 
which data type to paste.

Using the Copy As Function
The copy as functions are preset shortcuts for 
placing certain data forms on the system 
clipboard without changing the data types to 
be copied in the Advanced tab of the 
Preferences window.

Just select the content in the document to be 
copied and then select one of the menu items 
in the Copy As... submenu of the Edit menu. 
The most popular data types are supported. 
These functions will place both text and 
chemical data on the system clipboard for 
maximum compatibility with 3rd party 
applications. No image data will be placed on 
the system clipboard.
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Pasting Data from Other 
Applications
To paste data from other applications into 
ChemDoodle, perform the following steps:

1. Use the copy function present in the other 
application.

2. Click on the Paste menu item in the Edit 
menu or press its menu accelerator 
keyboard shortcut which is ctrl-V 
(command-V on Mac OS X) to paste the 
highest priority data to the Doodle Board.

Where Content is Pasted
The pasted content will be located according 
to the following rules:

1. If your mouse pointer is hovering over the 
document, the center of the pasted content 
will be located at the mouse pointer.

2. If the mouse pointer is not hovering over 
the document, and the lasso is active, then 
the pasted content will appear to the 
bottom-right of the lassoed content.

3. If the mouse pointer is not hovering over 
the document and the lasso is inactive, 
then the pasted content will appear at the 
top left of the document.

Paste Special...
Since an application can place different data 
types on the system clipboard, the data that 
ChemDoodle pastes may not always be the 
desired type. In general, ChemDoodle pastes 
chemical data over images and images over 
text. If you would like to paste alternate data, 
click on the Paste Special... menu item in the 
Edit menu. A window will appear listing all 
ChemDoodle compatible data as shown in 
Figure 10.4. Just select the list item you 
would like to paste and press the Paste 
button.

Figure 10.4: Paste Special Window

Pasting Text as Chemical Data
Sometimes it may be necessary to handle text 
data from the system clipboard. For instance, 
a chemical application may paste the 
MOLFile format in plain text, or you may be 
copying a SMILES string from a web browser. 
ChemDoodle provides a Paste Text as 
Chemical function to conveniently handle 
this.

To paste text content from another application 
as chemical data, perform the following steps:

1. Use the copy function present in the other 
application to place the text on the system 
clipboard.

2. Expand the Paste Text As Chemical... 
submenu in the Edit menu.

3. Depending on the type of data being 
represented by the text, select the 
appropriate menu item in the submenu to 
paste.

Using this method, any of the line notations 
that ChemDoodle understands can be pasted 
as chemical data. Additionally, there is a 
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XYZ-Like Data menu item for pasting text 
as chemical data in an XYZ-like format. This 
option will automatically scan the text to 
extract atom labels and positions. The final 
menu item is Guess Chemical Format. This 
will detect the chemical format of the text 
data on the system clipboard and paste the 
chemical data accordingly, which is perfect 
for ASCII or XML data types, such as 
MOLFiles or CML. This function will alert 
you if not chemical format could be 
associated with the text data.

Chemical Format 
Compatibility
ChemDoodle supports one of the largest 
chemical format libraries in the industry and 
can interpret various chemical formats for 
input to and output from other chemical 
applications. Chemical formats are discussed 
in detail in Appendix B.

Image Format Compatibility
ChemDoodle supports the input and output of 
a wide range of bitmap and vector images.

Supported Input Formats
ChemDoodle can read the following bitmap 
image formats:

• Joint Photographic Experts Group 
{.jpg, .jpeg, .jpe, .jfif, .jfi, .jif}

• Microsoft Bitmap {.bmp, .dib}

• Tagged Image File Format {.tiff, .tif}

• Wireless Bitmap {.wbmp}

• CompuServ Graphics Interchange Format 
{.gif}

• Portable Network Graphics {.png}

• UNIX Portable PixMap 
{.ppm, .pnm, .pbm, .pgm}

• Photoshop Document {.psd}

ChemDoodle can read the following vector 
image formats:

• Adobe Portable Document Format {.pdf}

• Web Scalable Vector Graphics {.svg, .svgz}

Supported Output Formats
ChemDoodle can write the following bitmap 
image formats:

• CompuServ Graphics Interchange Format 
{.gif}

• Joint Photographic Experts Group 
{.jpg, .jpeg, .jpe, .jfif, .jfi, .jif}

• Microsoft Bitmap {.bmp, .dib}

• Portable Network Graphics {.png}

• Tagged Image File Format {.tiff, .tif}

• UNIX Portable PixMap {.ppm, pnm, pbm, 
pgm}

• Wireless Bitmap {.wbmp}

ChemDoodle can write the following vector 
image formats:

• Adobe Portable Document Format {.pdf}

• Encapsulated Postscript 
{.eps, .epi, .epsi, .epsf}

• Macintosh Vector Pict {.pict}

• OpenDocument Graphics {.odg}

• Web Scalable Vector Graphics {.svg, .svgz}

• Windows Enhanced Metafile {.emf}
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Importing Chemical Content from 
Images
ChemDoodle will automatically embed 
chemical data in certain image formats. When  
these images are inserted into ChemDoodle, 
they will be checked for chemical information 
and that chemical information will be loaded 
if found.

ChemDoodle embeds chemical information 
into the following image formats:

• Adobe Portable Document Format {.pdf}

• Encapsulated Postscript {.eps}

• OpenDocument Graphics {.odg}

• Web Scalable Vector Graphics {.svg}

Exporting the Document to an Image
To export all of the objects in the current 
document to an image, perform the following 
steps:

1. Select the Save As Image... menu item 
from the File menu. 

2. A file chooser will appear. Select the 
location you would like to have the 
document saved in and type in a name for 
the file if you do not like the default 
name. You do not need to type in an 
extension as ChemDoodle will do this for 
you.

3. After you are satisfied with a location and 
name, select the image type of the image 
to be exported.

4. After selecting the file type to be used, 
press the Save button to export your 
document as an image.

5. If options are available, a window will be 
shown to allow you to set the options. 
Define the settings to your preference and 
then click the Done button.

Exporting only Certain Objects to an 
Image
To export specific objects in the current 
document to an image, perform the following 
steps:

1. Use a selection tool to select the objects to 
be exported to an image.

2. Select the Save Selection As Image... 
menu item from the File menu. 

3. A file chooser will appear. Select the 
location you would like to have the 
document saved in and type in a name for 
the file if you do not like the default 
name. You do not need to type in an 
extension as ChemDoodle will do this for 
you.

4. After you are satisfied with a location and 
name, select the image type of the image 
to be exported.

5. After selecting the file type to be used, 
press the Save button to export the 
selected objects to an image.

6. If options are available, a window will be 
shown to allow you to set the options. 
Define the settings to your preference and 
then click the Done button.

Image Output Options
There are several options that you can define 
for output images. Some options are only 
available for bitmap or vector types, while 
some options will be available for both.

Image Border Buffer

You can control the image border buffer, or 
the amount of space surrounding the graphics 
in an image, by changing the Border Buffer 
setting in the Preferences window under the 
Advanced tab. The default image border 
buffer is 3 pixels.
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Image Scale (bitmap only)

This setting will determine the scale of the 
output image. The larger the scale, the larger 
the output image. Vector graphics can be 
rescaled at any time, and therefore this setting 
is only available for bitmap images. You will 
need to scale bitmap images to a larger size if 
you want to use a higher resolution, but retain 
the same dimensions.

Resolution (bitmap only)

This setting will instruct printers and other 
renderers how to scale the image. The higher 
the DPI setting, then the crisper the image 
will look, but the smaller it will appear. By 
default, the DPI setting is 300dpi. Currently, 
only the JPEG and PNG output support this 
option. Vector graphics are resolution-less, 
and therefore this setting is only available for 
bitmap images.

Transparency (bitmap only)

If the bitmap image type supports 
transparency, this option will be available.

Render Text as Shapes (PDF)

In vector graphics, text is output as shapes, so 
they are no longer recognized as text by other 
applications. If you prefer to preserve the 
characters for editing in other applications, 
then select this option. Note that the font you 
use for the text must be present on the system 
that you open the PDF in, or the font you 
used will be replaced with something similar, 
but not identical.

Inserting Images
For any of the image formats that 
ChemDoodle can read, you can import files 
of that format into your documents. To do so, 
perform the following steps:

1. Select the Insert Image... menu item in 
the File menu.

2. In the file chooser that appears, navigate 
to and select the image you would like to 
insert.

3. Select the Open button to insert the 
image.

If you selected an image file type that is not 
understood by ChemDoodle, a message will 
appear to notify you of the issue.

In addition to inserting images via the File 
menu, you may also simply drag compatible 
images from your file system or from other 
applications on the Doodle Board.

Round Trip Editing
Round trip editing is a very advanced feature 
for allowing ChemDoodle content to transfer 
between applications by embedding it into 
images. In most cases, ChemDoodle will 
automatically perform this embedding for 
you. Through round trip editing, you can copy  
ChemDoodle content into your word 
processor for instance, and then later copy 
that content back into ChemDoodle for re-
editing.

NOTE: Make sure you always save your 
drawings and figures in a ChemDoodle 
Document and never rely on a third party 
application to save your ChemDoodle data. 
That third party application may change 
how it works and you may lose your data!

Support
Round trip editing requires that both 
ChemDoodle and the application you are 
inserting the ChemDoodle content into work 
together. Currently, ChemDoodle supports 
round trip editing with any applications that 
understand Object Linking and Embedding 
(OLE) on Windows, that preserve PDF 
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comments on Mac OS X, or with OpenOffice 
on Linux. This covers a large number of 
applications that most scientists use, however 
there will always be that one application it 
does not work with. We are actively working 
to expand the range of applications 
ChemDoodle can provide round trip editing 
functionality with.

Windows
Setup

No additional setup is required for round trip 
editing on Windows. The OLE server is 
automatically registered when ChemDoodle 
is installed.

Clipboard Settings

By default, in Advanced Preferences, OLE is 
enabled. OLE is required to be enabled for 
round trip editing to work on Windows.

Procedure

Round trip editing is very simple on 
Windows. Just copy in ChemDoodle and 
paste into the receiving application. To edit 
the content, copy the embedded object from 
the receiving application and paste back into 
ChemDoodle to recover the objects. Once you 
have finished editing, again copy in 
ChemDoodle and paste back into the 
receiving application to replace the original 
object.

Some applications may not paste the OLE 
object by default. In this case, make sure to 
use a provided Paste Special function in the 
receiving application to choose the OLE 
object.

Not all applications on Windows support 
OLE, and round trip editing is not possible 
with those applications.

Mac OS X
Setup

No additional setup is required for round trip 
editing on Mac OS X.

Clipboard Settings

By default, in Advanced Preferences, PDF is 
enabled. PDF is required to be enabled for 
round trip editing to work on Mac OS X.

Procedure

Round trip editing is very simple on Mac OS 
X. Just copy in ChemDoodle and paste into 
the receiving application. To edit the content, 
copy the image from the receiving application 
and paste back into ChemDoodle to recover 
the objects. Once you have finished editing, 
again copy in ChemDoodle and paste back 
into the receiving application to replace the 
original image.

Some applications may not paste the PDF by 
default. In this case, make sure to use a 
provided Paste Special function in the 
receiving application to choose the PDF.

Not all applications on Mac OS X preserve 
PDF comments, and round trip editing is not 
possible with those applications.

Workaround for iWork Pages

iWork Pages corrupts PDF comments, so 
round-trip editing will fail directly from 
Pages. There are two workarounds for this:

1. Copy the figure from Pages into Keynote 
and then copy in Keynote and paste into 
ChemDoodle to recover the data.

2. Use the Inspector to retrieve the unaltered 
PDF directly from Pages.

To perform the second procedure, please 
follow these steps:
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1. When working with figures pasted into 
Pages from ChemDoodle, open the 
Inspector by clicking on the Inspector 

button in Pages top toolbar. 

2. In the Inspector, click on the Metrics icon 

, and then click on the ChemDoodle 
figure so that droppedImage.pdf appears as 
in Figure 10.5.

3. Drag the droppedImage.pdf onto the 
Doodle Board in ChemDoodle to recover 
the data.

Figure 10.5: Inspector showing the 
droppedImage.pdf ChemDoodle embedded 
object.

Linux
Forward

Round trip editing on Linux is only possible 
with OpenOffice/LibreOffice and other 
variants and only on Linux. We did our best to 
provide as simple a procedure as possible, but 
given the lacking state of these projects, there 
are some inconveniences to deal with. We 
will do our best to continue to improve this 
procedure, but your help is required to submit 
issues to the OpenOffice/LibreOffice 
development teams and urge them to improve 
their software and APIs.

Setup

Round trip editing on Linux requires that the 
user install our ChemDoodle OpenOffice 
plugin. The plugin is named ChemDoodle.oxt 
and can be found in the resources folder in 
the ChemDoodle installation folder.

To install the plugin, perform the following 
steps:

1. Launch OpenOffice/LibreOffice.

2. In the Tools menu, select Extension 
Manager...

3. Click the Add... button.

4. In the file chooser that appears, locate the 
ChemDoodle.oxt file in the resources 
folder and select it.

If the plugin is successfully registered, it will 
appear in the Extension Manager as shown 
in Figure 10.6.

Figure 10.6: The Extension Manager with the 
ChemDoodle plugin properly registered
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Clipboard Settings

In Advanced Preferences, both PNG (720dpi) 
and ChemDoodle Collage are required to be 
enabled for round trip editing to work on 
Linux. Other raster image types should be 
disabled.

Procedure

To insert a ChemDoodle object into 
OpenOffice/LibreOffice, perform the 
following steps:

1. Ensure the clipboard settings are correct 
as stated above.

2. Select the content you wish to copy and 
use a copy function in ChemDoodle.

3. In the Office application you want to 
insert the object into, open the Object 
submenu in the Insert menu and select 
OLE Object... (Figure 10.7)

4. In the window that appears, select 
ChemDoodle Embedded Object and 
select the OK button. (Figure 10.8)

Figure 10.7: The OLE Object... menu item

Figure 10.8: Selecting the ChemDoodle 
Embedded Object to insert

To edit the inserted ChemDoodle object, 
perform the following steps:

1. Select the inserted ChemDoodle object 
that you wish to edit, and double-click on 
it.

2. Use a copy function with the 
ChemDoodle object still selected.

3. In ChemDoodle, use a paste function to 
paste the ChemDoodle Objects.

4. Edit the content.

5. Reselect the content and follow the 
procedure for inserting the ChemDoodle 
object into OpenOffice/LibreOffice above 
to replace the previous object.
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Troubleshooting

Common error boxes may appear, 
troubleshoot them as follows.

The following warning means that you should 
enable the PNG (720dpi) option and disable 
the PNG option in Advanced Preferences for 
the best quality images.

The following warnings means that you 
should enable ChemDoodle Collage in 
Advanced Preferences.

The following warning means that PNG 
(720dpi) needs to be enabled in Advanced 
Preferences.

The following warning means you need to 
read the Clipboard Settings section above 
again.

Other Issues

Why is a bitmap image used instead of a 
vector graphic?

OpenOffice/LibreOffice does not support 
vector graphics through their Embedded 
Object insertion. Please contact the 
appropriate Office development teams to urge 
them to improve this. For now, we use a 720 
dpi image so print quality will still be 
excellent.

Why can’t I paste the object directly between 
Office applications?

This is apparently a bug in OpenOffice/
LibreOffice, please contact the appropriate 
Office development teams to urge them to fix 
this.

Why do I have to double click the object to 
round trip it?

This is just what OpenOffice/LibreOffice 
requires to execute the object. Please contact 
the appropriate Office development teams to 
urge them to improve this.

Why can’t I just paste the object? Why do I 
need to go through the menu to insert it?

Implementing direct pasting of the object 
exhibits many inconsistencies which make it 
unsuitable for regular use. This is something 
we are trying to work around. Please contact 
the appropriate Office development teams to 
urge them to fix this.

Printing
The document can be printed from 
ChemDoodle. In most cases, this procedure is 
identical to other applications you use on your 
operating system. You can define settings, 
preview, and print.

Page Setup
By selecting the Page Setup... menu item in 
the File menu, you will be able to set the 
printer settings. The window that appears will 
be identical to the same window that appears 

168



in other applications on your operating 
system. Here, you can determine which 
printer to print to and set up the page 
orientation.

Flipping the Page Orientation
In some cases, you may desire that your 
document is printed in landscape mode. To do 
this, perform the following steps:

1. Select the Page Setup... menu item in the 
File menu.

2. In the window that appears, find the 
appropriate setting for page orientation, 
and change it to landscape.

3. Press the confirm button in the window to 
save your settings and close it.

4. A question will appear asking if you 
would like to swap the width and height 
of ChemDoodle. If this is appropriate for 
your document, select Yes, otherwise, 
select No.

It is important that the direction that the 
printer prints your document, and the size of 
your document are distinct. Printing in 
landscape mode only means that the printer 
prints your content at a 90 degree angle. It 
does not alter your document in any way. So 
in some cases, you may want to flip the 
dimensions of your document and reorient 
your figures such that they will better fit on a 
landscape orientation.

This procedure gives you the most control 
over your documents, by allowing you to 
control the dimensions of your document and 
separately to control the orientation that your 
document is printed to the printer.

Print Preview
To preview your document before you print, 
select the Print Preview menu item in the 
File menu. Click the Ok button to the bottom 

right when you are finished to close the 
preview. Only the content that should appear 
in the printing will appear in the preview, no 
warnings, highlights or other interface 
decorations will be present.

Printing a Document
To print a document, perform the following 
steps:

1. Select the Print... menu item in the File 
menu.

2. In the window that appears, confirm or 
change any available settings.

3. Press the Print button to print your 
document.
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Appendix A: 
Managing 
ChemDoodle
Overview
The chapters in this user guide explain how to 
use ChemDoodle to draw and work with 
chemical figures. There are other functions 
for managing the application itself.

This section shows the new user how to 
manage ChemDoodle. It covers the following 
topics:

• Updating ChemDoodle.

• Deactivating and restoring ChemDoodle.

• Using your iChemLabs account.

• Making use of provided media and 
resources.

Application and File Icons
You may wish to associate file icons and 
application icons with ChemDoodle if 
ChemDoodle does not already do this for you, 
such as on Linux. In the resources folder in 
the main ChemDoodle installation folder, 
operating system specific graphics will be 
provided for ChemDoodle and recognized 
chemical file types. Use you operating 
system’s documentation to associate those 
icons with the application and file types.

Updating ChemDoodle
ChemDoodle will check for official 
iChemLabs updates and will automatically 

update to the latest available version for you 
if you allow it to do so.

To check for updates, just click the Check 
For Updates menu item in the Help menu. If 
no update is available, you will see a 
confirmation message stating that your copy 
of ChemDoodle is up to date. If there is an 
update available, you will see an Update 
Available window appear listing all the 
changes introduced by the update. Just click 
the Update button to proceed. ChemDoodle 
will close to perform the update, so make sure 
to save your files before continuing.

NOTE: You must have administrator 
privileges to update ChemDoodle. If you 
see a message stating that you cannot 
update because you do not have the 
necessary permissions, please double 
check that you ran ChemDoodle as 
administrator (on Windows for instance) or 
contact your system administrator to help 
you.

The auto-updater will then open. It will 
download the latest ChemDoodle updates, 
verify the contents with our server, and then 
proceed to update ChemDoodle. The updater 
can be seen in Figure A.1. It may take several 
minutes to complete. After the updater 
completes, it will notify you that it is ready 
and that ChemDoodle will be reopened. Just 
click the Ok button to close the updater and 
continue. Your version of ChemDoodle has 
now been updated. Enjoy!

Figure A.1: The iChemLabs Updater
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By default, ChemDoodle will automatically 
check for updates while loading. You can 
disable this feature in the Preferences 
window under the Online tab. You may 
always manually check for updates by using 
the menu item mentioned above.

Windows Administrator Privileges
A common issue on Windows Vista/7+ is to 
enable administrator privileges for 
ChemDoodle to update. If ChemDoodle states 
that you do not have the necessary 
administrator privileges on these platforms, 
perform the following steps:

1. Exit ChemDoodle.

2. Locate the ChemDoodle icon (shortcut or 
actual application).

3. Right-click on the icon and select Run as 
administrator.

4. Accept the security request.

You will then be able to update ChemDoodle.

If this process does not work, you will need to 
consult with a system administrator to update 
ChemDoodle.

Skipping Updates
If you wish to ignore the current update, when 
the Update Available window is displayed, 
just select the Skip this Version button as 
shown in Figure A.2. You will no longer be 
notified that this update is available. You will 

still be notified of subsequent updates, which 
you may also skip.

To obtain an update that was skipped, select 
the Check For Updates menu item in the 
Help menu.

Figure A.2: The Update Available window with the 
Skip this Update button.

Purchasing Upgrades
Major version upgrades to ChemDoodle must 
be purchased. When a major version upgrade 
becomes available, you will still be presented 
with the Update Available window. 
However, instead of an Update button, a 
Purchase Upgrade button will be presented. 
Click on the Purchase Upgrade button to be 
directed to the upgrade purchase page. After 
purchasing the upgrade, again check for 
updates. The Update button will then be 
showing and you may proceed with the 
update as described in the previous sections.

Moving your Activated Copy 
to a New Computer
At some point, you may want to switch to a 
different computer. Your purchased 
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ChemDoodle activation code is restricted by 
the number of computers ChemDoodle is 
activated on. Therefore, we provide you the 
ability to deactivate ChemDoodle and 
reactivate it on a new computer. To begin, just 
click the Deactivate ChemDoodle menu item 
in the Help menu.

NOTE: When deactivating ChemDoodle 
and switching to a new computer, your 
custom preferences and other user settings 
will be lost. If you have settings files 
(templates, chemical document settings), 
those can be copied to the new 
ChemDoodleSettings folder that will appear 
after ChemDoodle is activated on the new 
computer.

Once the deactivation procedure has begun, it 
cannot be cancelled. Make sure you record 
your activation code, which will be displayed 
in the Details section of the deactivation 
confirmation message, so you can use it 
again. You should also have a record of your 
code from the email receipt you received 
upon purchasing it.

Once you accept the confirmation message, 
ChemDoodle will close and your copy will be 
deactivated. You may now use your activation 
code to activate ChemDoodle on a new 
computer.

Preparing for a System 
Restore
If you do anything to your system that will 
remove or eliminate the ChemDoodle license 
file, such as performing a system restore or 
installing your operating system from scratch, 
you will need to first deactivate your copy of 
ChemDoodle. Instructions for deactivating 
ChemDoodle can be found in the previous 
section.

Using iChemLabs Cloud 
Services
With an iChemLabs account, you have the 
ability to save files online so you can open 
them anywhere or send them to other 
iChemLabs applications as well as access 
relevant cloud services from within 
ChemDoodle.

You may log into your iChemLabs account at 
anytime in ChemDoodle by choosing the 
Sync with Online Account... menu item in 
the File menu. The login window will also 
have an option to link your iChemLabs 
account with your copy of ChemDoodle. If 
selected, ChemDoodle will automatically log 
into your iChemLabs account while it starts 
up. You can then change these settings at any 
time in the Preferences window under the 
Online tab.

All customers receive a free account to use 
this feature. Your username is the email 
address your activation code is associated 
with, and your password is the last 4 
characters of your activation code. The 
password must be either in all uppercase or 
all lowercase.

Currently, the following iChemLabs 
applications integrate with your iChemLabs 
account:

• ChemDoodle

• ChemDoodle Mobile
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Appendix B: 
Chemical File 
Types
Overview
ChemDoodle can currently read and write 24 
different chemical file types. This section 
discusses the following issues:

• What chemical file types are supported.

• ChemDoodle’s adherence to third party file 
type specifications.

• The extent of support for third party 
chemical file types.

• Warnings about saving your documents in a 
format other than the ChemDoodle 
Document format.

• How to annotate your files.

• How to use ChemDoodle’s file conversion 
tool.

Adherence to Third Party 
Specifications
File formats implemented in ChemDoodle 
strictly follow their published specifications. 
ChemDoodle does not take liberties with their 
rules or inject ChemDoodle-only content into 
them. All file format objects and properties 
are mapped as closely as possible to objects 
and properties in ChemDoodle. Thorough 
implementation details are also provided in 
the following sections. Specification 
references can be found by selecting the 
References menu item in the Help menu.

ChemDoodle will try to interpret all 3rd party  
files as best as possible, so if you do find a 
file that doesn’t read well, please send it to us 
so we can improve our compatibility.

Be Careful Saving 3rd Party 
Formats
ChemDoodle does its best to preserve the data 
it reads in from third party formats, however 
it may not be perfect as those formats may 
have been intended for systems that are very 
different from ChemDoodle. For instance, 
one program may define a charge by placing 
a text box near an atom, while ChemDoodle 
defines a charge by associating a charge 
attribute with that atom. When read, 
ChemDoodle may decide to convert that text 
box to a charge attribute, thereby changing 
the data that is in the file.

That being said, it is very important that you 
carefully consider whether to allow 
ChemDoodle to save over 3rd party data files 
as ChemDoodle may not retain all essential 
information that the other program requires. 
When saving 3rd party files, ChemDoodle 
will display this warning as a reminder before 
allowing you to continue. These warnings can 
be disabled in the Preferences window under 
the Saving tab.

Instead, we recommend that you first save a 
copy of that file to edit, instead of saving over 
files created in other applications.

Testing 3rd Party File Type 
Output
If you are unsure about whether your 
document will be saved in its entirety to a 3rd 
party format, first check with this 
documentation. If you are still concerned, 
save a test file in ChemDoodle, close the 
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document you just saved, and then reopen the 
file in ChemDoodle. If some content is 
missing or any object properties have 
changed in some way, then the format you are 
trying to save to does not support those 
objects and/or properties or ChemDoodle 
does not yet support the output of those 
objects and/or properties for that format.

Supported Chemical File 
Types
1. ChemDoodle Documents (.icl)

2. ChemDoodle Javascript Data (.cwc.js)

3. ACD/ChemSketch Document (.sk2)

4. Beilstein ROSDAL (.ros)

5. CambridgeSoft ChemDraw Exchange 
(.cdx)

6. CambridgeSoft ChemDraw XML (.cdxml)

7. CHARMM CARD File (.crd)

8. ChemAxon Marvin Document (.mrv)

9. Chemical Markup Language (.cml)

10. Daylight SMILES (.smi, .smiles)

11. IUPAC InChI (.inchi)

12. IUPAC JCAMP-DX (.jdx, .dx)

13. ISIS Sketch File (.skc)

14. ISIS Sketch Transportable Graphics File 
(.tgf)

15. MDL MOLFiles, both V2000 and V3000 
connection tables (.mol, .mdl)

16. MDL RXNFiles, both V2000 and V3000 
connection tables (.rxn)

17. MDL RDFiles (.rdf, .rd)

18. MDL SDFiles (.sdf, .sd)

19. Molinspiration JME String (.jme)

20. RCSB Protein Data Bank Files 
(.pdb, .ent)

21. Schrödinger MacroModel (.mmd, .mmod)

22. Schrödinger Maestro (.mae)

23. Standard Molecular Data (.smd)

24. Tripos Mol2 (.mol2, .ml2, .sy2)

25. Tripos Sybyl Line Notation (.sln)

26. XYZ Files (.xyz)

File Annotations
Annotations can be read and written to files 
where possible. Each document has its own 
set of annotations. To view previously defined 
annotations, edit them or create your own, 
select the Annotations... menu item in the 
File menu. Then edit the fields shown in 
Figure B.1.

Figure B.1: File Annotations Window

All data associated with a file will be saved in 
ChemDoodle Documents. Other users that 
open your annotated ChemDoodle 
Documents files will be able to easily access 
them. Other file types may be able to save 
annotations as well, read their documentation 
in the following sections for the extent of 
annotation functionality.
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File Conversion Tool
ChemDoodle contains robust functionality for 
easily and quickly converting files between 
different formats. This tool is accessed by 
clicking the Convert... menu item in the File 
menu and is shown in Figure B.2. Unlike 
other chemical conversion utilities, 
ChemDoodle converts all document objects 
and properties in addition to just atoms and 
bonds; this including shapes, fonts, colors, 
annotations, document settings, etc.

Figure B.2: Chemical File Conversion Utility

Perform the following steps to convert a file:

1. Choose a recognized input file with the 
file chooser that appears after clicking the 
Choose Input button. Use the file format 
filter at the bottom of the file chooser to 
select different file formats.

2. Choose the location to store the output by 
clicking the Choose Location button or 
by manually typing in the path to the file. 
You can change the name of the output 
file this way.

3. Choose an output format and extension 
from the drop down selection below the 
output location.

4. Click the Convert button.

When complete, ChemDoodle will display 
statistics about the conversion or any issues 
encountered.
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iChemLabs ChemDoodle 
Documents
About
The ChemDoodle Document format is the 
native ChemDoodle format. Everything 
created in ChemDoodle can be stored in a 
ChemDoodle Document.

Versions
• any

Extensions
• .icl

• .icxml

Format
XML

Annotations
All annotations are saved.

Document Settings
All document settings are stored.

Options
• Embed Images - Embedding images will 

result in larger save files, but the documents 
will open on other computers without 
needing to first find the images. If there are 
pasted images in a document (rather than 
loaded from a file), allow the embedding of 
images to save them properly.

iChemLabs ChemDoodle 
Javascript Data
About
The ChemDoodle Javascript Data format is a 
Javascript file containing JSON data for 
native objects that can be handled by the 
ChemDoodle Web Components.

Versions
• any

Extensions
• .cwc.js

Format
Javascript with JSON

Annotations
No annotations are saved.

Document Settings
No document settings are stored.

Options
Currently, there are no options.

176



ACD/ChemSketch Document
About
This is a binary format for storing chemical 
figures and is the main format for the ACD/
ChemSketch application. Non-chemical 
objects are not yet supported. Most chemical 
objects and properties that are mutually 
inclusive between ChemSketch and 
ChemDoodle are supported.

Version
2+

Extensions
• .sk2

Format
Binary

Annotations
No annotations are stored. 

Document Settings
Styles for objects are stored but there is no 
global style sheet.

Options
Currently, there are no options. 

Supported Formats
• ACD_ChemSketch_2_0_DocumentFormat

• DocumentDescriptionFormat

• PageDescriptionFormat

• PictureFormat

• StyleListFormat

• BaseGraphStyleFormat

• PenStyleFormat

• FontStyleFormat

• AtomStyleFormat

• BondStyleFormat

• ObjectsListFormat

• MoleculeFormat

• AtomDataFormat

• BondDataFormat

• PageInfoDescriptionFormat

• EnvironmentDescriptionFormat

Notes
• Most mutually inclusive chemical objects 

between ChemSketch and ChemDoodle are 
supported.

• Shapes are not yet supported.

• There is a serious issue with how 
superatoms are stored in ChemSketch files 
that renders them impossible to recover. In 
these cases, ChemDoodle will replace the 
superatom with a Carbon atom.

• All bond types are mapped to the closest 
supported bond type.
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Beilstein ROSDAL
About
Beilstein ROSDAL is a chemical line notation 
format. ROSDAL stands for Representation 
Of Structure Description Arranged Linearly. 
The documentation on this format is quite 
sparse and most programs will not support it.

Version
Unknown

Extensions
• .ros

Format
Line Notation, plain text

Annotations
No annotations are stored. 

Document Settings
No document settings are stored.

Options
Currently, there are no options. 

Notes
• All non-elemental atom labels are converted 

to Carbon labels.

• All bond types are mapped to the closest 
supported bond type.

• Line notation formats do not contain 
coordinates. They will have to be generated 
by the application that reads the ROSDAL 
file.

• Shapes will not be stored.

• ROSDAL shorthands, charges and 
stereochemical bonds are supported.

• Based on the sparse documentation, 
ROSDAL is completely implemented in 
ChemDoodle.

CambridgeSoft ChemDraw 
Files
About
CDX Files

This is a binary format for storing chemical 
figures. Non-chemical objects are supported. 
Most objects and properties that are mutually 
inclusive between ChemDraw and 
ChemDoodle are supported. This is a 
common format for manuscript submission, 
but we recommend that you use CDXML 
instead as CambridgeSoft suggests it.

CDXML Files

ChemDraw XML files are identical to their 
CDX counterparts, except they are XML 
format instead of binary. We recommend that 
you use CDXML for manuscript submission 
if ChemDoodle Documents are not an option.

Version
8+

Extensions
• cdx

• cdxml

Format
CDX is binary while CDXML is XML

Annotations
No annotations are stored.

Document Settings
Most document settings are stored.

Options
Currently, there are no options.

Supported Objects and Properties
• kCDXProp_CreationProgram

• kCDXProp_Name

• kCDXProp_PrintMargins
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• kCDXProp_ChainAngle

• kCDXProp_BondLength

• kCDXProp_BoldWidth

• kCDXProp_LineWidth

• kCDXProp_MarginWidth

• kCDXProp_HashSpacing

• kCDXProp_FractionalWidths

• kCDXProp_InterpretChemically

• kCDXProp_BondSpacing

• kCDXProp_LabelStyle

• kCDXProp_MacPrintInfo

• kCDXProp_ColorTable

• kCDXProp_FontTable

• kCDXObj_Page

• kCDXProp_BoundingBox

• kCDXProp_HeightPages

• kCDXProp_WidthPages

• kCDXObj_Fragment

• kCDXObj_Node

• kCDXProp_2DPosition

• kCDXProp_3DPosition

• kCDXProp_Node_Element

• kCDXProp_Atom_Isotope

• kCDXProp_Atom_Charge

• kCDXProp_Atom_Radical

• kCDXProp_Atom_ShowSter
eo

• kCDXProp_Atom_CIPStere
ochemistry

• kCDXProp_IgnoreWarnings

• kCDXProp_Atom_ShowSter
eo

• kCDXObj_Text

• kCDXProp_Text

• kCDXProp_RotationAng
le

• kCDXObj_Bond

• kCDXProp_Bond_Begin

• kCDXProp_Bond_End

• kCDXProp_Bond_Order

• kCDXProp_Bond_Display

• kCDXProp_Bond_Display2

• kCDXProp_ForegroundColo
r

• kCDXProp_BoldWidth

• kCDXProp_LineWidth

• kCDXProp_HashSpacing

• kCDXProp_BondSpacing

• kCDXProp_Bond_ShowSter
eo

• kCDXProp_Bond_CIPStere
ochemistry

• kCDXObj_Graphic

• kCDXProp_BoundingBox

• kCDXProp_Graphic_Type

• kCDXProp_ForegroundColor

• kCDXProp_LineWidth

• kCDXProp_BoundingBox

• kCDXProp_Arrow_Type
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• kCDXProp_Arrow_HeadSize

• kCDXProp_SupersededBy

• kCDXObj_Arrow

• kCDXProp_ForegroundColo
r

• kCDXProp_ArrowShaftSpac
ing

• kCDXProp_ArrowheadTail

• kCDXProp_ArrowheadHead

• kCDXProp_Arrow_HeadSiz
e

• kCDXProp_Tail3D

• kCDXProp_Head3D

• kCDXProp_Arc_AngularSize

• kCDXProp_CornerRadius

• kCDXProp_Rectangle_Type

• kCDXProp_BoldWidth

• kCDXProp_Center3D

• kCDXProp_MajorAxisEnd3D

• kCDXProp_MinorAxisEnd3D

• kCDXProp_Oval_Type

• kCDXProp_Orbital_Type

• kCDXProp_Bracket_Type

• kCDXObj_BracketedGroup

• kCDXObj_BracketAttachme
nt

• kCDXProp_Bracket_Gra
phicID

• kCDXProp_Symbol_Type

• kCDXObj_Text

• kCDXProp_BoundingBox

• kCDXProp_2DPosition

• kCDXProp_LineStarts

• kCDXProp_Text

• kCDXObj_EmbeddedObject

• kCDXProp_BoundingBox

• kCDXProp_ForegroundColor

• kCDXProp_GIF

• kCDXProp_TIFF

• kCDXProp_PNG

• kCDXProp_JPEG

• kCDXProp_BMP

• kCDXProp_RotationAngle

• kCDXProp_EndObject

Notes
• Most mutually inclusive objects between 

ChemDraw and ChemDoodle are 
supported.

• All bond types are mapped to the closest 
supported bond type.

• ChemDraw formats do not use Unicode 
characters, which has become the standard. 
Upon read, ChemDoodle will convert 
Symbol font characters to their 
corresponding unicode characters, however, 
the reverse is not done. Greek characters 
(and other non-Latin Unicode characters) 
may not be displayed correctly in 
ChemDraw for this reason.
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CHARMM CARD File
About
CHARMM CARD files describe cartesian 
coordinates for molecules. These files are 
typically used with the CHARMM software.

Version
c36b2

Extensions
• .crd

Format
ASCII, plain text

Options
Currently, there are no options.

Annotations
No annotations are stored.

Document Settings
No document settings are stored.

Notes
• All non-elemental atom labels are converted 

to Carbon labels.

• Shapes will not be stored.

• All coordinates are in Ångströms and are 
centered around the origin.

ChemAxon Marvin 
Documents
About
Marvin Documents extend chemical markup 
language with additional objects and 
properties representing the graphical abilities 
of ChemAxon products.

Version
5.3.2

Extensions
• .mrv

Format
XML

Annotations
Inherits CML annotations.

Document Settings
No document settings are stored.

Options
Inherits CML options.

Supported Tags and Attributes
*inherits CML objects and properties

• MDocument

• MChemicalStruct

• MTextBox

• MField

• MPoint

• x

• y

• MEllipse

• thickness

• lineColor

• MPoint
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• x

• y

• MRectangle

• thickness

• lineColor

• MPoint

• x

• y

• MRoundedRectangle

• thickness

• lineColor

• arcWidth

• arcHeight

• MPoint

• x

• y

• Bracket

• thickness

• lineColor

• type

• MPoint

• x

• y

• MPolyline

• thickness

• lineColor

• type

• headLength

• tailLength

• arcAngle

• MPoint

• x

• y

• MTextBox

• MField

• MPoint

• x

• y

Notes
• Most mutually inclusive objects between 

MarvinSketch and ChemDoodle are 
supported.

• All bond types are mapped to the closest 
supported bond type.

• Output is always in arrays.

• Inherits CML notes.
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Chemical Markup Language
About
Chemical Markup Language stores a wide 
range of chemical objects and properties 
utilizing XML protocol. It is only a secondary 
format, most useful for embedding chemical 
content in webpages.

Versions
• 2

• 1 (Read-only)

Extensions
• .cml

Format
XML

Annotations

If provided, annotations are read and written 
with the logically corresponding attributes in 
the metadataList element: dc:creator, dc:date, 
dc:description, dc:rights, dc:title.

Document Settings
No document settings are stored.

Options
• Dimension: Either 2 dimensions can be 

save with coordinates in pixels (for 
drawings), or 3 dimensions can be saved 
with coordinates in Ångströms (for exact 
structural coordinates).

• Arrays: You may store all atoms and bonds 
as arrays to save space. Child objects of 
atoms and bonds will be excluded.

Supported Tags and Attributes
• cml

• list

• metadataList

• metadata

• name

• content

• molecule

• formula

• title

• atomArray

• atom

• id

• elementType

• formalCharge

• isotope

• x2

• y2

• xy2

• x3

• y3

• z3

• xyz3

• bondArray

• bond

• id

• atomRefs2

• order

• bondStereo

Notes
• All non-elemental atom labels are converted 

to Carbon labels. "Du", "Dummy" and "R" 
are allowed.

• All bond types are mapped to the closest 
supported bond type.

183



• Shapes will not be stored.

• All 2D coordinates are in pixels.

• All 3D coordinates are in Ångströms and 
are centered around the origin.

• CML array formats can be read and written.

• The older version 1 format of CML can also 
be read, but it cannot be written.

Daylight SMILES
About
Daylight SMILES is a chemical line notation 
format. SMILES stands for Simplified 
Molecular Input Line Entry Specification.

Version
4.9

Extensions
• .smi

• .smiles

Format
Line Notation, plain text

Options
• Output Aromaticity: If selected, then an 

aromatic model will be imposed on the 
output SMILES string with lower case 
letters, such that a Kekulé structure of 
benzene will be output as c1ccccc1 instead 
of C1=CC=CC=C1.

• Kekulize Input: If selected, input data that 
contains aromatic information will be 
Kekulized and that aromatic information 
will be lost.

Annotations
No annotations are stored.

Document Settings
No document settings are stored.

Notes
• All non-elemental atom labels are converted 

to Carbon labels.

• Isotopes and charges are handled.

• All bond types are mapped to the closest 
supported bond type.

• Line notation formats do not contain 
coordinates. They will have to be generated 

184



by the application that reads the SMILES 
file.

• Shapes will not be stored.

IUPAC InChI
About

IUPAC InChI is a unique and unambiguous 
chemical line notation format. InChI stands 
for International Chemical Identifier. It is 
quickly becoming a standard identifier in 
databases.

Version
1.02

Extensions
• .inchi

Format
Line Notation, plain text

Annotations
No annotations are stored.

Document Settings
No document settings are stored.

Options
• Auxiliary Information: Include the 

auxiliary information with each InChI 
string.

• InChI Key: Include a unique InChI key 
with each InChI string.

Notes
• All non-elemental atom labels are converted 

to Carbon labels.

• All bond types are mapped to the closest 
supported bond type.

• InChI files do not contain coordinates 
unless they are provided in an Auxiliary 
information string. They will have to be 
generated by the application that reads the 
InChI file.

• Shapes will not be stored.
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• ChemDoodle utilizes JNI-InChI, which is a 
wrapper around the official IUPAC source 
for generating InChI files.

IUPAC JCAMP Data
About
JCAMP is primarily for storing spectroscopic 
data, but can also store low resolution 
chemical structure data. The supported 
techniques are mass spectrometry, infrared 
spectroscopy, nuclear magnetic resonance 
spectroscopy and ion mobility spectrometry. 
JCAMP data stands for the Joint Committee 
on Atomic and Molecular Physical data. 
While spectra and chemical structures are 
read, currently only chemical structures are 
written, but support for spectra output will be 
provided in the future.

Versions
• IR - 4.24

• MS - 5.00

• NMR - 5.00

• Chemical Structures - 3.7

Extensions
• .jdx

• .dx

Format
Plain text

Annotations
If provided, annotations are read and written 
from appropriate records. Title, author and 
copyright status are supported.

Document Settings
No document settings are stored.

Options
• Convert Hz to PPM: If enabled and an 

NMR spectrum is read in with Hz as the x-
unit, ChemDoodle will automatically 
convert the domain to ppm.
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Supported Records
• TITLE

• JCAMP-CS

• ORIGIN

• OWNER

• MOLFORM

• ATOMLIST

• BONDLIST

• DATE

• TIME

• CHARGE

• RADICAL

• MAX_RASTER

• XY_RASTER_FACTOR

• XY_RASTER

Notes
• Spectra are read, but not written. Be careful 

not to overwrite your data.

• All non-elemental atom labels are converted 
to Carbon labels.

• All bond types are mapped to the closest 
supported bond type.

• Shapes will not be stored.

• This format is typically for the storage of 
spectra, but chemical structures can be 
included.

MDL ISIS Sketch Files
About
SKC Files

This is the default format for storing chemical 
drawings in ISIS Sketch and Symyx Draw. 
Non-chemical objects are supported. All 
objects and properties that are mutually 
inclusive between ISIS Sketch and 
ChemDoodle are supported. This format was 
designed to be platform dependent (for some 
unknown reason), so SKC files written on 
Windows will not work on Macs and vice 
versa. However, ChemDoodle can recognize 
all SKC files and will correctly read them 
regardless of what platform they were 
generated on. You may choose which SKC 
output format to use if necessary.

TGF Files

ISIS Sketch transportable graphics files are 
identical to their SKC counterparts, except 
they are ASCII format instead of binary. 
Symyx seems to have discontinued support 
for this format, so most applications will 
probably not read them.

Version
4

Extensions
• .skc

• .tgf

Format
SKC is binary, TGF is plain text

Annotations
No annotations are stored.

Document Settings
No document settings are stored.
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Options
• SKC Binary Output Format: ISIS Sketch 

SKC files are platform dependent, as per 
MDL's specification. SKC files written on 
Windows will not work on Macs and vice 
versa. You may modify how the files are 
saved with this setting. Upon read, 
ChemDoodle will determine which format 
is used, and report any problems.

Supported Blocks and Properties
• rect

• Obj_coords

• Pen_width

• Pen_style_token

• Fill_style

• Transparent

• Pen_RGB2Color

• Fill_RGB2Color

• Pen_widthUnit

• RxnAtch

• rounded_rect

• Obj_coords

• Roundrect_curve

• Pen_width

• Pen_style_token

• Fill_style

• Transparent

• Pen_RGB2Color

• Fill_RGB2Color

• Pen_widthUnit

• RxnAtch

• line

• Obj_coords

• Pen_width

• Pen_style_token

• Fill_style

• ArrowDir

• ArrowStyle

• ArrowSize

• Transparent

• Pen_RGB2Color

• Fill_RGB2Color

• Pen_widthUnit

• RxnAtch

• polygon

• Poly_points

• Poly_smoothed

• Pen_width

• Pen_style_token

• Fill_style

• Transparent

• Pen_RGB2Color

• Fill_RGB2Color

• Pen_widthUnit

• RxnAtch

• ellipse

• Obj_coords

• Pen_width

• Pen_style_token
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• Fill_style

• Transparent

• Pen_RGB2Color

• Fill_RGB2Color

• Pen_widthUnit

• RxnAtch

• arc

• Obj_coords

• Arc_endpts

• Pen_width

• Pen_style_token

• Fill_style

• ArrowDir

• ArrowStyle

• ArrowSize

• Transparent

• Pen_RGB2Color

• Fill_RGB2Color

• Pen_widthUnit

• RxnAtch

• spline

• Poly_points

• Poly_smoothed

• Pen_width

• Pen_style_token

• Fill_style

• Transparent

• Pen_RGB2Color

• Fill_RGB2Color

• Pen_widthUnit

• RxnAtch

• text

• MDLEdittext

• Obj_coords

• Pen_width

• Pen_style_token

• Fill_style

• Transparent

• Pen_RGB2Color

• Fill_RGB2Color

• Pen_widthUnit

• RxnAtch

• subsketch

• Begsketch

• Endsketch

• Totobjs

• mol

• Begsketch

• Endsketch

• RxnAtch

• rxnarrow

• Obj_coords

• Pen_width

• Pen_style_token

• Fill_style

• ArrowDir
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• ArrowStyle

• ArrowSize

• Transparent

• Pen_RGB2Color

• Fill_RGB2Color

• Pen_widthUnit

• RxnAtch

• bracket_rect

• Obj_coords

• Roundrect_curve

• Pen_style_token

• Transparent

• Pen_RGB2Color

• Fill_RGB2Color

• Pen_widthUnit

• RxnAtch

• circ_arc

• Obj_coords

• Arc_endpts

• Pen_width

• Pen_style_token

• Fill_style

• ArrowDir

• ArrowStyle

• ArrowSize

• Transparent

• Pen_RGB2Color

• Fill_RGB2Color

• Pen_widthUnit

• RxnAtch

• smooth_spline

• Poly_points

• Pen_width

• Pen_style_token

• Fill_style

• Transparent

• Pen_RGB2Color

• Fill_RGB2Color

• Pen_widthUnit

• RxnAtch

• bond

• Bond_atoms

• Bond_type

• Bond_stereo_type

• Fill_style

• Bond_hash_spacing

• Bond_bond_spacing

• Bond_crossed

• Bond_alt_stereo

• Pen_width

• Pen_RGB2Color

• Pen_widthUnit

• RxnAtch

• atom

• Atom_coords

• Atom_zcoord
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• Atom_type

• Atom_symbol

• Atom_chg

• Atom_rad

• Atom_msdif

• Font

• Pen_RGB2Color

• Atom_margin_width

• RxnAtch

Notes
• All mutually inclusive objects between ISIS 

Sketch and ChemDoodle are supported.

• All bond types are mapped to the closest 
supported bond type.

MDL Connection Table Files
About
MOL Files

MOL files have become one of the most 
popular formats for storing chemical 
information, especially in drawing programs. 
It typically stores only a single molecule. It 
consists of a header followed by an MDL 
connection table. All connection table formats 
follow ASCII standards.

SD Files

A SD (structure-data) file stores any number 
of molecules and other annotations. SD files 
are simply concatenated MOL files with 
additional data records.

RXN Files

RXN file is a very popular format for storing 
a single discrete chemical reaction. If consists 
of connection tables for the reactants and 
products.

RD Files

A RD (reaction-data) file stores any number 
of reactions and molecules and other 
annotations. RD files are simply concatenated 
RXN and MOL files with additional data 
records.

Versions
• v3000

• v2000

• v1000 (Read only)

Extensions
• .mol

• .mdl

• .sdf
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• .sd

• .rxn

• .rdf

• .rd

Format
ASCII, plain text

Annotations
Only a title and the first comment is stored in 
the header if provided (80 characters each 
max). All annotations are stored as data 
records in SD files. Since the data headers are 
not specifically standardized, other programs 
will probably not be able to read them, but 
anyone can view the file in a text editor to see 
the information.

Document Settings
No document settings are stored.

Options
• Bond Length Conversion: Coordinates are 

in bond lengths. When saving, coordinates 
can be converted using the standard bond 
length (30px) or the currently selected bond 
length.

• Force v3000 Connection Tables: v2000 
connection tables are standard and used by 
default; V3000 connection tables must be 
and will be automatically used if a 
connection table contains more than 999 
atoms.

• Output Hydrogen Counts: If this option is 
selected, the query values for Hydrogen 
counts will be provided in both v2000 and 
v3000 connection tables..

Supported Blocks and Properties
v2000

• Atom

• Bond

• Properties

• Atom Alias

• Charge

• Radical

• Isotope

• End of Block

v3000

• CTAB

• COUNTS

• ATOM

• CHG

• RAD

• MASS

• HCOUNT

• BOND

• CFG

• BEGIN REACTANT

• END REACTANT

• BEGIN PRODUCT

• END PRODUCT

Notes
• All non-elemental atom labels are converted 

to Carbon labels in v2000 connection 
tables, but the Alias property is used for 
those programs that read it. All labels are 
retained in v3000 connection tables, with 
blanks as '*'.

• All bond types are mapped to the closest 
supported bond type.

• Shapes will not be stored.

192



• All coordinates are in bond lengths and are 
centered around the origin.

Molinspiration JME String
About
JME Strings are technically a line notation, 
but do not compress connection tables. This 
format is mainly for input and output from 
Molinspiration’s Java Molecular Editor 
(JME).

Version
Unknown

Extensions
• .jme

Format
Line Notation, plain text

Annotations
No annotations are stored.

Document Settings
No document settings are stored.

Options
Currently, there are no options.

Notes
• All non-elemental atom labels are converted 

to Carbon labels.

• All bond types are mapped to the closest 
supported bond type.

• Charges are stored.

• Shapes will not be stored.
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RCSB Protein Data Bank 
Files
About
The Protein Data Bank format is one of the 
most popular formats for storing 3D chemical 
data. A large database of Protein Data Bank 
files is hosted at the RCSB website for public 
use. The RCSB also hosts a large set of 
monomer units which describe the topology 
in PDB files. Since most of the data is based 
on crystallographic information, bond orders 
are vague and only single bonds are 
recognized. PDB files are not recommended 
for the storage of 2D chemical drawings.

Version
• 3.20

• earlier (read only)

Extensions
• .pdb

• .ent

Format
Plain text

Annotations
If provided, the authors, keywords and title 
will be stored.

Document Settings
No document settings are stored.

Options
Currently, there are no options.

Supported Records
• HEADER

• TITLE

• KEYWDS

• AUTHOR

• REVDAT

• ATOM

• HETATM

• CONECT

• MASTER

• END

Notes
• All non-elemental atom labels are converted 

to Carbon labels.

• Shapes will not be stored.

• All coordinates are in Ångströms and are 
centered around the origin.

• When read, the PDB monomer database is 
contacted to determine topology. If there are 
no bonds found, then ChemDoodle will 
attempt to calculate all bonds by covalent 
radii.
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Schrödinger Files
About
MMD Files

The MacroModel format is the primary 
format for the MacroModel application. It is a 
modeling format and contains information on 
atom types.

MAE Files

The Maestro file format is the standard 
exchange format for Schrödinger products. 
Technically, it extends the MMD format.

Versions
• MMD-7.0

• MAE-8.0

Extensions
• .mmd

• .mmod

• .mae

Format
Both MMD and MAE files are plain text

Annotations

No annotations are stored.

Document Settings
No document settings are stored.

Options
Currently, there are no options.

Supported Records
MMD

The Macromodel format is supported fully 
and in accordance with the official 
documentation.

MAE

• root

• m_atom

• m_bond

• p_m_ct

Notes
• All non-elemental atom labels are converted 

to Carbon labels.

• Atom types are mapped as closely as 
possible.

• All bond types are mapped to the closest 
supported bond type.

• Shapes will not be stored.

• All coordinates are in Ångströms and are 
centered around the origin.

• Multiple molecules can be stored as 
compound files or movies.
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Standard Molecular Data
About
Standard Molecular Data is an older ASCII 
format for storing chemical data. It is mainly 
dependent on Fortran Format specification. 
This format is fairly obsolete and most 
programs will not support it.

Version
• 4.3

Extensions
.smd

Format
ASCII, plain text

Annotations
A title is stored with the STRT block if 
provided. Otherwise the filename is used. The 
first comment will be stored in the TEXT 
block if provided.

Document Settings
No document settings are stored.

Options
Currently, there are no options.

Supported Blocks
• >STRT

• >DTCR

• >DTUP

• >CT 

• >CO 

• >LB 

• >FORM

Notes
• All non-elemental atom labels are converted 

to Carbon labels.

• All bond types are mapped to the closest 
supported bond type.

• Shapes will not be stored.

• All coordinates are in pixels.

• Morgan indices are output in the Labels 
block.
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Tripos Mol2
About
A Tripos Mol2 file is a complete, portable 
representation of a SYBYL molecule. This is 
a modeling format.

Version
7.1

Extensions
• .mol2

• .ml2

• .sy2

Format
Plain text

Annotations
If provided, annotations are written as 
comments at the beginning of the file. Title 
and author annotations are read.

Document Settings
No document settings are stored.

Options
Currently, there are no options.

Supported Records
• @<TRIPOS>ATOM

• @<TRIPOS>BOND

• @<TRIPOS>MOLECULE

• @<TRIPOS>SUBSTRUCTURE

Notes
• All non-elemental atom labels are converted 

to Carbon labels.

• Atom types are mapped as closely as 
possible.

• All bond types are mapped to the closest 
supported bond type.

• Shapes will not be stored.

• All coordinates are in Ångströms and are 
centered around the origin.

• This format is typically for the storage of a 
single molecule, but multiple molecules can 
be saved in a single Mol2 file.
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Tripos Sybyl Line Notation
About
SLN is a chemical line notation format. It is 
derived from SMILES but contains additional 
explicit information such as Hydrogen counts.

Version
Unknown

Extensions
• .sln

Format
Line Notation, plain text

Annotations
No annotations are stored.

Document Settings
No document settings are stored.

Options
Currently, there are no options.

Notes
• All non-elemental atom labels are converted 

to Carbon labels.

• All bond types are mapped to the closest 
supported bond type.

• Line notation formats do not contain 
coordinates. They will have to be generated 
by the application that reads the SLN file.

• Shapes will not be stored.

• Macroatoms are read on input.

XYZ
About
The XYZ chemical filetype is a very basic 
data format for storing atom types and 
coordinates. There is no official 
documentation for this format, so other 
applications may define it differently.

Version
Unknown

Extensions
• .xyz

Format
Plain text

Annotations
If a comment is provided, it will be output in 
the second line of the file. The second line of 
the file is also read in as a comment.

Document Settings
No document settings are stored.

Options
• Atom Identifier: The element type can be 

specified with either the element's symbol 
or its atomic number.

• Identifier Buffer: The identifier can be 
buffered to 3 columns so programs that read 
it can expect a certain column width.

Notes
• Only atom symbol and coordinate data are 

stored.

• All non-elemental atom labels are converted 
to Carbon labels.

• Bonds will not be stored.

• Shapes will not be stored.

• All coordinates are in Ångströms and are 
centered around the origin.
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• Single spaces are used to delimit tokens in 
the atom table.

• All coordinates are rounded and recorded to 
the fifth decimal place.
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Appendix C: 
Compatibility with 
3rd Party 
Applications
Overview
ChemDoodle works with many 3rd party 
applications. The most common applications 
are discussed in this section. It is not an 
inclusive list. This section lists:

• Common applications that are used with 
ChemDoodle.

• Which types of data are transferred to 
common 3rd party applications.

• Any solutions to issues involved with the 
3rd party applications.

• Round trip editing compatibility.

Microsoft Office
Word
On Windows and Mac OS X, text, images and 
scalable vector graphics can be transferred. 

For scalable vector graphics, if using Word on 
Windows, Windows Enhanced Metafile must 
be selected in the copy settings. For scalable 
vector graphics, if using Word 2004 on Mac 
OS X, Macintosh Vector PICT must be 
selected in the copy settings; Word 2008 
requires PDF to be selected in the copy 
settings. Make sure all bitmap image types 
are deselected.

Round trip editing is functional on Windows 
with Microsoft Office using ChemDoodle’s 
OLE library. Round trip editing is functional 

on Mac OS X with Microsoft Office 2011 (at 
update 14.0.1 or more recent).

Powerpoint
Same as Word. 

Excel
Same as Word.

Apple iWork
Pages
Text, images and scalable vector graphics can 
be transferred. For scalable vector graphics, 
PDF must be selected in the copy settings. 
Round trip editing is supported via the 
workaround detailed in the Round Trip 
Editing section of Chapter 10.

Keynote
Same as Pages. Round trip editing is 
supported directly supported.

Numbers
Same as Pages. Round trip editing is not 
supported.

OpenOffice
Writer
On all operating systems, text, images and 
scalable vector graphics can be transferred. 
For scalable vector graphics, if using Writer 
on Windows, Windows Enhanced Metafile 
must be selected in the copy settings. For 
scalable vector graphics, if using Writer on 
Mac OS X, Macintosh Vector PICT must be 
selected in the copy settings. For scalable 
vector graphics, if using Writer on Linux, 
OpenDocument Graphics must be selected in 
the copy settings.

Round trip editing is supported on Linux by 
using ChemDoodle UNO plugin.
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Calc
On all platforms, text, images and scalable 
vector graphics can be transferred.

For Mac OS X, first save ChemDoodle 
content as Macintosh Vector PICTs and then 
insert or drag and drop the file into Calc.

Round trip editing is supported on Linux by 
using ChemDoodle UNO plugin.

Impress
Same as Calc.

Adobe Products
Photoshop
Images and scalable vector graphics can be 
transferred. For scalable vector graphics, PDF 
must be selected in the copy settings.

Illustrator
Scalable vector graphics can be transferred. 
First, save content as PDF and then open, 
insert or drag and drop the file into Illustrator. 
For direct pasting, make sure all vector 
graphics are disabled except for  Windows 
Enhanced Metafile on Windows or Macintosh 
Vector Pict on Mac OS X.

Browsers
Most browsers will support image and 
scalable vector graphic output from 
ChemDoodle for display in web pages. The 
best scalable vector graphic formats to use are 
SVG and PDF.

For information of ChemDoodle Web 
Components browser compatibility, visit the 
ChemDoodle Web Components website: 
http://web.chemdoodle.com

Other
ChemDoodle is compatible with any 
application that supports the data 

ChemDoodle places on the system clipboard. 
Because ChemDoodle expertly handles 
Windows Enhanced Metafiles, Macintosh 
Vector PICT 2, PDF and OpenDocument 
Graphics, scalable vector graphics can be 
directly pasted into all native applications.

Round trip editing will be supported with any 
application that supports OLE on Windows, 
or that will preserve PDF comments on Mac 
OS X.
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Appendix D: 
Elemental Data
Overview
ChemDoodle has access to an extensive 
database of elemental data compiled from 
published resources. This section introduces 
the new user to ChemDoodle’s chemical data. 
It covers the following topics:

• The elemental and chemical data provided 
in ChemDoodle.

• How to view the chemical data.

• Where to find references for the data.

• How to use the interactive periodic table.

Elemental Database
The elemental database allows ChemDoodle 
to perform many tasks, from filling the 
dynamic periodic table to deducing covalent 
bonds to calculating a molecular mass. The 
data itself can be viewed by opening various 
data tables in ChemDoodle or by using the 
dynamic periodic table. The data tables are 
found in the View menu. Currently 
ChemDoodle provides 3 data tables:

• Elemental Data - Displays all data in the 
elemental database not contained in other 
tables.

• Ionization Energies - Displays all 
published ionization energies for the 
elements.

• Isotopes - Displays all published isotopes, 
their masses, natural abundances and half-
lives.

Each table is interactive, and you can click on 
a column header to reorder the content by that 
column. By clicking again you can reverse 
the order of that column. By pressing down 
and dragging, you can reorder the columns to 
more easily correlate different columns.

References
All data within ChemDoodle’s databases are 
associated with a unit (if not unit-less) and the 
reference source it originated from so you 
may assess its quality. The entire set of 
references can be viewed at any time by 
selecting the References menu item in the 
Help menu as shown in Figure D.1. Non-data 
related references are also displayed in this 
list, including filetype specifications and 
algorithms.

Figure D.1: ChemDoodleʼs References List

Interactive Periodic Table
ChemDoodle contains an interactive periodic 
table of elements for reference, printing and 
demonstrations. It is viewable by selecting the  
the Interactive Periodic Table menu item in 
the View menu. The window that opens is 
shown in Figure D.2.

Figure D.2: The Interactive Periodic Table
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You may hover over elements and click on 
them for additional information. There may 
also be groups listed in the top region. 
Hovering over a group will desaturate all 
other groups. This is shown in Figure D.3 
when the mouse pointer hovers over the 
Other Non-Metals group.

Figure D.3: Focusing on a group.

The table is customizable and you can choose 
from several format options, including the 
display of Atomic Mass, Names and Electron 
configurations in addition to the element 
Symbol. The block in the bottom-left corner 
of the periodic table will display the current 
format of each element as shown in Figure D.
4.

Figure D.4: Element Format

You can also customize graphical options, 
such as the element border colors and text 
color.

In addition to the traditional classifications 
display, you can also choose to display these 
other features of the elements:

• CPK Colors - Displays each element with 
its CPK (Corey, Pauling, Koltun) color.

• Jmol Colors - Displays each element with 
its Jmol color.

• PyMOL Colors - Displays each element 
with its PyMOL color.

• State of Matter - Each element is colored 
based on its state of matter at the set 
temperature. Solids are black, liquids are 
blue and gases are red. Unknown states are 
grey. A temperature slider will appear in the 
controls to set the temperature which is 
displayed on the top right of the figure.

• Years of Discovery - Each element is 
colored if discovered before the set year of 
discovery. A year slider will appear in the 
controls to set the year of discovery which 
is displayed on the top right of the figure.

Each display format shows off interesting 
properties and makes for great in-class 
demonstrations, such as the State of Matter 
display shown in Figure D.5.
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Figure D.5: States of Matter Display

To print the periodic table, click the Print 
button at the bottom-right of the window. The 
References button will display 
ChemDoodle’s references and the Close 
button will close the Interactive Periodic 
Table window.
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Appendix E: How 
NMR is Simulated
Algorithms
The NMR simulation algorithms are a free 
and experimental feature provided in 
ChemDoodle. The algorithms are 
continuously developed and improved.

Shift Prediction
ChemDoodle estimates chemical shifts for all 
hydrogen or carbon atoms for which 
incremental constants are available. The 
algorithm is an empirical approach and begins 
by identifying key functional groups in a 
structure. The identified functional groups are 
used to determine base values for the 
estimated shifts of the nuclei.  

After determining a base shift, a breadth-first 
algorithm is employed to look at the chemical 
environment surrounding each nucleus. Based 
on the functional groups around it, 
incremental constants are added to the base 
shift to calculate the estimated shift. Other 
contributions may be included such as ring 
strain and other algorithms.

Splitting
Splitting is determined by a table of typical j-
constant magnitudes and the spin of the 
interacting nuclei. Splitting is calculated for 
all spins. Splitting magnitudes are determined 
from Pascal’s triangle.

Roof Effects
The magnitude for roof effects are determined 
by the resolution of the spectrum, set by the 
Pulse Frequency parameter, and the relative 
adjacency of the interacting peaks. The 
simulated roof effects will show a leaning of 

the split peak towards the peak that is 
splitting it. Peaks split by multiple peaks will 
lean towards all of them.

Solvent Peaks
Solvent peaks are simulated using the same 
algorithms. Splitting from deuterium occurs. 
The magnitude ratio for solvent to solute 
peaks is determined by the Dilution 
parameter.

1H Rapid Exchange
If the temperature is above 273K, rapid 
exchange will occur for hydrogen bonded 
protons. These peaks will merge into a single 
broadened peak with a shift calculated at their 
weighted average. The shift will then be 
moved downfield relative to the magnitude of 
the temperature.

1H Anisotropic Effects
If the solvent or solute contain aromatic or 
antiaromatic rings, then 1H nuclei will be 
appropriately shielded or deshielded based on 
the solvent/solute ratio and the types of rings 
involved.

1H Diastereotopic Pairs
If a methylene is adjacent to a stereocenter, 
then the two methylene protons will be 
separated into individual peaks. The peaks 
will be separated by .3 ppm centered around 
the predicted shift for the methylene group. 
The choice of nucleus to be shifted upfield or 
downfield is random.

13C Quaternary Carbon Intensity 
Reductions
To simulate a lack of Overhauser effects, 
quaternary carbons have their peak intensities 
reduced by 33%.

Limitations
ChemDoodle can only predict shifts for 
nuclei where environments are well described 
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in its database. Functional groups that are not 
described well will have poorly calculated 
shifts and may result in values around 0 ppm, 
which should be ignored.

Since incremental constants do not take into 
account structure topography, 3D 
conformations will be poorly analyzed. It is 
essential that you fully scrutinize all NMR 
simulation results from ChemDoodle.

To learn more about the algorithms 
implemented in ChemDoodle and their 
accuracy, obtain the references listed under 
the Algorithms > Spectroscopy > Nuclear 
Magnetic Resonance section of 
ChemDoodle’s reference list. The reference 
list can be viewed by selecting the 
References menu item in the Help menu.
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Appendix F: 
ChemDoodle Web 
Components
Overview
In addition to creating graphics and chemical 
files, ChemDoodle can also create dynamic 
web components. This feature utilizes another 
iChemLabs technology, the ChemDoodle 
Web Components library. This section lists:

• Creating ChemDoodle Web Components in 
ChemDoodle.

• ChemDoodle rendering features that are 
available in the ChemDoodle Web 
Components library.

• Other functions for working with 
ChemDoodle Web Components.

• Learn how generated components work for 
both desktop and mobile browsers.

• Restrictions on using ChemDoodle Web 
Components in your webpages.

Generating ChemDoodle 
Web Components
To generate a ChemDoodle Web Component, 
perform the following steps:

1. In the File menu, select the Generate 
Web Component... menu item. Make 
sure to first have drawn or loaded any 
content you wish to be displayed on the 
Doodle Board.

2. If you had selected a Molecule or 
Spectrum before opening this window, 
then an appropriate viewer will be 

selected. Otherwise, choose the Type of 
component you would like to create.

3. If the Type of component chosen requires 
content, then click on the Select button 
and choose the content to be displayed in 
the component.

4. As is shown in Figure F.1, set the size of 
the component and the component name 
(a random name is generated for you to 
avoid name clashes).

Figure F.1: Generate ChemDoodle Web 
Component Window

5. Define any visual specifications for the 
component. It will inherit compatible 
visual specifications from the current 
document style sheet in ChemDoodle.

6. In the Relevant Startup Parameters 
tree, select any Javascript variables or 
functions you would like to define. 
Placeholders for them will be generated in 
the Javascript code.

7. Press the Preview button to preview your 
ChemDoodle Web Component in your 
main browser as shown with Apple Safari 
in Figure F.2.

Figure F.2: Previewing the Web Component 
(Apple Safari shown)
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8. Make any changes, if necessary.

9. Click the Generate button to generate the 
Javascript for the component.

Paste the generated Javascript directly in 
your webpage (in the <body> tag) in the 
location you prefer the component to appear. 
You must first install the ChemDoodle Web 
Components library for your webpage for 
these components to work. Installation 
instructions are provided on the official 
ChemDoodle Web Components website at 
http://web.chemdoodle.com/installation/
download.

Generating Javascript Data 
Files for Use with 
ChemDoodle Web 
Components
If you are displaying several Web 
Components with the same molecule/
spectrum or are doing advanced development, 
it may be more efficient to generate the data 
first in a Javascript data file to be loaded into 
your webpage. To do this, perform the 
following steps:

1. Draw all structures and spectra to be used 
in your webpage on the Doodle Board.

2. In the File menu, select the Save as... 
menu item.

3. In the file chooser that appears, select the 
location and the name of the file to be 
saved.

4. In the drop down selection for the file 
type, choose iChemLabs ChemDoodle 
Javascript Data.

5. Press the Save button.

All structures and spectra on the Doodle 
Board will be saved to the ChemDoodle Web 
Component JSON format in Javascript. To 
use this file, link it into the HTML page as a 
Javascript resource or copy and paste the 
source of the file into your Javascript code. 
Use the variable names declared in that file to 
use them.

Molecules begin with 'molecule' and spectra 
begin with 'spectrum'. You should rename 
these variables to not clash with other 
declared Javascript variables if necessary. 
These data structures can be used as is, such 
as for immediate loading into Canvases via 
load functions.

Optimizing PDB Files
The ChemDoodle Web Components can 
handle many of the features in PDB files. 
Unfortunately, reading and processing all of 
the data in a PDB file can be very time 
consuming in Javascript. ChemDoodle 
contains a special Optimize PDB to JSON... 
function in the File menu to predigest PDB 
content into the native ChemDoodle Web 
Components JSON format. To do this, 
perform the following steps:

1. In the File menu, select the Optimize 
PDB to JSON... menu item.
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2. A window will appear. Select the Choose 
Input button and locate the PDB file you 
would like to optimize.

3. The output file path will be automatically 
generated for the same containing folder 
and name, but with an extension of .js. 
Click the Choose Location button to 
change the location of the output file. 
ChemDoodle will automatically change 
the extension to .js.

4. When satisfied with the paths, select the 
Optimize button. Depending on the size 
of the PDB file, this function may take 
several seconds to complete.

5. To use the Javascript file with the 
ChemDoodle Web Components, just 
include it in your web project, and import 
it as a URI resource on the HTML page it 
is used. The PDB will be represented as a 
Molecule data structure with the same 
name as the input file, prepended by the 
string “pdb_”. For instance, if you 
optimized the file “1BNA.pdb”, then you 
can load the variable pdb_1BNA directly 
into your component with the 
loadMolecule() function.

Generating Components for 
Mobile Devices
ChemDoodle Web Components will work in 
all browsers including those on mobile 
devices, notably iPhone OS (iPhone, iPod 
Touch, iPad) and Android devices. All 
rendering is supported on the mobile devices 
and touch events and gestures are recognized 
by the components.

There is no difference between generating 
components for desktop browsers versus for 
mobile browsers. The only consideration 
would be the size of the component. The 

ChemDoodle Web Component generator 
contains a drop down selection to the right of 
the dimension panel containing preset sizes 
for mobile devices. Use it to quickly set 
standard sizes if preferable.

Rendering Compatibility
Even though ChemDoodle and the 
ChemDoodle Web Components library are in 
the same family of products, their feature sets 
are not identical. Many graphical features and 
visual specifications provided in 
ChemDoodle are not yet available in 
ChemDoodle Web Components.

Use the ChemDoodle Web Component 
window in ChemDoodle to help guide you 
through the available visual specifications in 
the ChemDoodle Web Components library. 
Use the Preview button to ensure your 
graphics will be correctly represented to your 
satisfaction.

License
The ChemDoodle Web Components library is 
licensed under version 3 of the GNU 
GENERAL PUBLIC LICENSE with the 
following exception:

As a special exception to the GPL, any 
HTML file in a public website or any free 
web service which merely makes function 
calls to this code, and for that purpose 
includes it by reference, shall be deemed a 
separate work for copyright law purposes. If 
you modify this code, you may extend this 
exception to your version of the code, but 
you are not obligated to do so. If you do not 
wish to do so, delete this exception 
statement from your version.

This means that your websites do NOT need 
to be released under GPL if you call the 
ChemDoodle Web Components library, 
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unless that HTML page is part of a 
commercial product or service.

Am I allowed to use this?
The license protects the code if one changes it 
or integrates it with a proprietary product. If 
you are concerned about how the license will 
affect you, then you should contact us. If you 
do not fully understand the GPL license or 
you answer yes to any of the questions listed 
next, then you should contact us before using 
this library.

• Will you be changing this library’s source 
code?

• Will you be integrating this library with 
another product that you will be distributing 
to the public in any form?

• Are you part of a commercial organization?

• Will you need access to iChemLabs cloud 
services (using the 
ChemDoodle.iChemLabs package)?

Attributions
Attributions on webpages for the use of 
ChemDoodle and ChemDoodle Web 
Components are greatly appreciated, but not 
required.

Several ChemDoodle Web Component 
badges are provided for this purpose if you 
choose to use them at http://
web.chemdoodle.com/installation/badges.

Further Information
For further information regarding the 
ChemDoodle Web Components, including 
webpage installation instructions, the most 
recent version and updates, advanced 
programming and use of the API, examples 

and browser compatibility, visit the official 
ChemDoodle Web Components website at 
http://web.chemdoodle.com.
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Appendix G: 
ChemDoodle 
Mobile
Overview
ChemDoodle Mobile is the mobile 
companion to ChemDoodle. ChemDoodle 
Mobile is free for all customers of 
ChemDoodle. This section lists:

• What ChemDoodle Mobile is.

• How to log into ChemDoodle Mobile.

• The features in ChemDoodle Mobile.

• Transferring structure data between 
ChemDoodle and ChemDoodle Mobile.

Supported Platforms
ChemDoodle Mobile is supported on both 
iOS and Android.

iOS
ChemDoodle Mobile can be installed on 
iPhones, iPod Touches and iPads via the 
iTunes AppStore. You can find ChemDoodle 
Mobile for iOS here: ChemDoodle Mobile on 
the iTunes AppStore

Android
ChemDoodle Mobile can be installed on 
phones running the Android operating system 
via the Android Marketplace here: 
ChemDoodle Mobile on Google Play

Logging in to ChemDoodle 
Mobile
All ChemDoodle customers receive free 
accounts to log into ChemDoodle Mobile. 

This is the same account you use to sync with 
your online account in ChemDoodle desktop. 
Your username is the email address your 
activation code is associated with, and your 
password is the last 4 characters of your 
activation code. The password must be either 
in all uppercase or all lowercase.

ChemDoodle Mobile 
Features
ChemDoodle Mobile is a calculator for drawn 
organic structures. There are four main 
windows: Draw, Calculate, Spectra and 
Help. The Draw window shows a typical 
ChemDoodle sketcher, where you can draw 
and store your structures. The Calculate page 
calculates properties and the Spectra page 
simulates NMR spectra. All spectra are 
interactive. The Help page contains a 
thorough help guide.

Calculations
• Molecular Formula

• Molecular Mass

• Monoisotopic Mass

• Degree of Unsaturation

• Hydrogen Bond Acceptors

• Hydrogen Bond Donors

• Average Molecular Polarizability

• Molar Refractivity

• Polar Surface Area

• logP

Spectra
• Mass Parent Peak (Isotopic Distribution)

• 1H NMR

• 13C NMR
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Transferring Data between 
ChemDoodle Desktop and 
ChemDoodle Mobile
Data saved to your online account can be 
accessed from any iChemLabs application 
that uses that account.

To create data in ChemDoodle for use in 
ChemDoodle Mobile, perform the following 
steps:

1. Draw the structure to be loaded into 
ChemDoodle Mobile in a new document 
in ChemDoodle.

2. Log into your online account by using the 
Sync with Online Account... menu item 
in the File menu.

3. Select the Save as Online File... menu 
item in the File menu.

4. Choose a name for your structure and 
save it.

5. Log into ChemDoodle Mobile.

6. Press the Load button in ChemDoodle 
Mobile and then select From Account.

7. Choose the file you just saved from 
ChemDoodle to load it.

In the reverse manner, structures you saved in 
ChemDoodle Mobile can be edited in 
ChemDoodle.

NOTE: ChemDoodle Mobile can only 
handle one molecule a time. If you load a 
large document with many molecules and 
shapes, only the first molecule will be used. 
If you then save that file in ChemDoodle 
Mobile, you will override the original file and 
lose the additional structures and shapes 
present in that file.

212



Appendix ICL-1: 
Technical Support
When to Contact Customer 
Service
While we do our best to debug and test 
ChemDoodle, a few bugs will always slip 
past us. Because of this, you may have 
encountered an issue with ChemDoodle. We 
certainly want your experience with 
iChemLabs software to be as enjoyable and 
hassle free as possible and we will do our best 
to address any issues you bring to our 
attention. In fact, we encourage you to report 
any bugs that you find to help us perfect 
ChemDoodle.

Before contacting us, please do the following:

• Check the system requirements for 
ChemDoodle at the beginning of this user 
guide to ensure that your system is 
supported.

• Search this user guide to see if your issue is 
addressed here.

• Read the Troubleshooting section of this 
appendix and follow the possible resolution 
tactics outlined there.

• Double check that your issue is 
reproducible and outline the exact steps 
performed to cause it.

• Take screenshots of any relevant graphical 
issues or popup errors in their entirety.

• Make note of anything you have tried to 
correct the problem.

How to Contact Customer 
Service
After collecting all relevant information, click 
on the Contact Customer Service menu item 
in the Help menu as shown in Figure 
ICL-1.1. This is the best way to contact 
iChemLabs customer service and to receive 
fast support. We always respond to inquiries 
within one business day, will most likely 
answer your email within a few hours and 
very often respond within an hour.

Figure ICL-1.1: Contact Customer Service Menu 
Item

This function will automatically pre-populate 
fields in our customer service form as shown 
in Figure ICL-1.2. Just fill in your name, your 
email, the subject and your message to 
complete the form. You can also attach a 
supporting file using the Choose File button. 
If you would like to attach multiple files, 
archive them all into a ZIP file and attach that 
(You should also zip any files that the form 
will not allow you to attach). When finished, 
input the CAPTCHA code present in the 
image at the bottom of the form and click the 
Send button. The page will confirm that your 
message has been sent and you will receive a 
confirmation email regarding your inquiry.
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FIgure ICL-1.2: The iChemLabs Customer 
Service Request Form

If you do not want to use email to contact us, 
you can also contact us by the following 
methods:

NOTE: Requesting support with the 
following methods will proceed slower than 
requesting service using our online form. 
Some methods, such as phone support, 
require fees.

Phone: 888-505-2436

Mail: iChemLabs
 200 Centennnial Ave., Suite 200
 Piscataway, NJ, 08854

Feature Requests
We are happy to receive feature requests from 
all users. You can submit a request using the 
customer service form as described in the 
previous section.

Feature requests are made for ChemDoodle 
every day. Some features are beyond the 
scope of ChemDoodle and we will try to 
explain why in a response. For example, a 
widget to perform ab initio calculations is 
beyond the scope of ChemDoodle as its focus 
is on chemical graphics and publishing. 
Otherwise, every requested feature is 
intended for a future update to ChemDoodle, 
and we are serious about implementing the 
features you want. That being said, some may 
wonder why the feature they requested is 
taking so long to implement. The following 
describes how our feature request system 
works and how we prioritize the features that 
we work on.

1. All feature requests (from customers and 
non-customers) are considered and are 
reported to our development tracking 
system.

2. Feature requests are associated with a 
score based on the popularity of the 
request. Each feature begins with a score 
of 0. The score is then incremented by 1 
for each unique customer that requests 
that feature (including the initial request if 
done by a customer). Non-customers that 
request features do not affect feature 
scores.

3. Once a month, we reevaluate the scores 
and plan our development around the 
features with the highest scores.
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4. When a feature is completed, it is 
removed from our development tracking 
system.

Therefore, to get the features you want 
implemented in ChemDoodle as fast as 
possible, do the following two things: (1) 
Please let us know about the feature you 
would like to see implemented by contacting 
us using the method described in the previous 
section and (2) get as many unique 
ChemDoodle customers to request the same 
feature as possible.

Following ChemDoodle 
Development
We are very open about our development and 
you can learn more about what we are doing 
by visiting the iChemLabs homepage at 
http://www.ichemlabs.com. We regularly post 
stories about ChemDoodle, development and 
compatibility checks with new operating 
systems. Make sure you subscribe to the 
iChemLabs newsfeed RSS (http://
www.ichemlabs.com/feed/rss2/) to be 
immediately notified of any new posts.

The iChemLabs newsfeed RSS can also be 
viewed by selecting the iChemLabs 
Newsfeed menu item in the Help menu.

Troubleshooting
Windows
Occasionally when you open ChemDoodle it 
will ask about connections, just select "Keep 
Blocking". ChemDoodle creates a local 
socket to open files that are double-clicked, 
generating this warning. ChemDoodle never 
accesses the internet unless you allow it to.

Sometimes the JRE can corrupt and you may 
see weird behavior when using ChemDoodle. 

Just restart your computer to resolve these 
issues.

Mac OS X
If you updated ChemDoodle and notice that 
the new filetype associations aren't being 
recognized in Finder, just restart your 
computer. The filetypes should now be 
recognized in Finder.

Performance Improvements
Hardware

If you see a severe lag in responsiveness in 
ChemDoodle, then there is likely a scarcity of 
system resources. Try the following solutions.

1. Upgrade to a more powerful CPU.

2. Increase the amount of memory in the 
computer.

Software Options

Apart from the hardware upgrades, a few 
features in ChemDoodle can be disabled to 
improve performance.

1. Disable the application rendering 
decorations in the Preferences window 
under the General tab in the Decorations 
section.

2. Change the rendering parameters to the 
options that favor speed in the Preferences 
window under the Advanced tab in the 
Document Rendering section.

Using Non-official Java Runtime 
Environments

On Linux distributions, one cause of slow 
performance we routinely encounter in our 
tests is the use of non-official Java runtime 
environments. Make sure that you are using 
the official Oracle JRE when running 
ChemDoodle.
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